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஧ாடம்-1 கணினி அறிமுகம் 

஧குதி - ஆ : குறு வி஦ாக்கள் 

11. கணிப்ப஧ாறி ஋ன்஫ால் ஋ன்஦ ? 

 கணிப்ப஧ாறி ஋ன்஧து, பகாடுக்கப்஧ட்ட கட்டள஭கள஭ உள்ளீடாகப் ப஧ற்று, அதிவயகநாகச் 

பெனல்஧ட்டு விரும்பின பயளியீட்ளட யமங்கும் எரு மின்஦ணு ொத஦ம் ஆகும். 

12. தபவு நற்றும் தகயல் வயறு஧டுத்துக. 

தபவு தகயல் 

஧ல்வயறு யளககளிலும் திபட்டப்஧டும் 

அடிப்஧ளட பெய்தித் துணுக்கு தபவு 

஋஦ப்஧டும்.  

தகயல் ஋ன்஧து முடிவுகள஭ ஋டுக்கக் கூடின 

உண்ளநகளின் பதாகுப்஧ாகும்.  

(஋.கா) கவிதா, 16 (஋.கா) கவிதாவின் யனது 16 

13. ளநனச் பென஬கத்தின் (CPU) ஧குதிகள் னாளய? 

 கட்டுப்஧ாட்டகம் 

 கணித ஌பணச் பென஬கம் 

 நிள஦யகம் 

14. கணித ஌பணச் பென஬கத்தின் (ALU) பெனல்஧ாடு னாது? 

 கூட்டல், கழித்தல், ப஧ருக்கல், யகுத்தல் நற்றும் தருக்கச் பெனல்கள் வ஧ான்஫ கணிதச் 

பெனல்஧ாடுகள஭ கணித ஌பணச் பென஬கம் பெய்கி஫து. 

15. கட்டுப்஧ாட்டகத்தின் பெனல்கள஭ ஋ழுதுக? 

 ளநனபென஬கம் நிள஦யகம் நற்றும் உள்ளீடு/பயளியீடு ொத஦ங்களுக்கு இளடவன 

஧ரிநா஫ப்஧டும் தபளயக் கட்டுப்஧ாட்டகம் கட்டுப்஧டுத்துகி஫து. 

 வநலும் எரு கணிப்ப஧ாறியின் முழுச்பெனல்஧ாடுகள஭யும் இது கட்டுப்஧டுத்துகி஫து. 

16. நிள஦யகத்தின் பெனல்஧ாடு னாது? 

 தபவு, தகயல் நற்றும் நிபல்கள஭ தற்காலிகநாக அல்஬து நிபந்தபநாகச் வெமித்து ளயக்க 

நிள஦யகம் உதவுகி஫து. இதுவய நிள஦யகத்தின் பெனல்஧ாடு ஆகும். 

17. உள்ளீட்டகம் நற்றும் பயளியீட்டகம் வயறு஧டுத்துக. 

உள்ளீட்டகம் பயளியீட்டகம் 

அள஦த்து யளகனா஦ தபவுகள஭யும் 

கணிப஧ாறிக்குள் உள்ளிடப் ஧னன்஧டுகி஫து. 

஧ன஦ர்கள் புரிந்து பகாள்஭க்கூடின யளகயில் 

தகயள஬த் பதரிவிக்கும். 

஋டுத்துக்காட்டு: விளெப்஧஬ளக, சுட்டி ஋டுத்துக்காட்டு: திளபனகம், அச்சுப்ப஧ாறி 

18. முதன்ளந நிள஦யகம் நற்றும் இபண்டாம் நிள஬ நிள஦யகம் வயறு஧ாடு னாது? 

முதன்ளந நிள஦யகம் இபண்டாம் நிள஬ நிள஦யகம் 

தபவு நற்றும் நிபல் கட்டள஭கள் நிள஫வயற்஫த் 

தனாபாக இருக்கும் வ஧ாது அதள஦த் 

தற்காலிகநாகச் வெமிக்க ஧னன்஧டுகி஫து. 

வெமிக்கப்஧ட்டுள்஭ அள஦த்து தகயல்களும் 

அழினாநல் இருக்கும். 

 

மின்ொபம் இல்஬ாத வ஧ாது அழிந்துவிடும் மின்ொபம் இல்஬ாத வ஧ாதும் அழினாது. 

஧குதி - இ : சிறு வி஦ாக்கள் 

19. கணிப்ப஧ாறியின் தன்ளநகள் னாளய? 

 கணினிகள் மிகவும் ெக்தியாய்ந்ததாக உ஬க஭வில் உள்஭஦. கணினிகள் ஥ம்஧முடினாத 

வயகத்தில் இனங்குகின்஫஦. 

 வயகம், துல்லினம், ஧ல்துள஫, ஥ம்஧கத்தன்ளந, விடாமுனற்சி, நிள஦யகம் நற்றும் தானினக்கம் 

ஆகினளய முக்கின தன்ளநகள் ஆகும். 

20. கணிப்ப஧ாறியின் ஧னன்஧ாடுகள஭ ஋ழுதுக. 

 கல்வி, ஆபாய்ச்சி, சுற்று஬ா, யானிள஬, முன்஦றிவிப்பு, ெமூக யள஬த஭ம், மின் யணிகம் 

ஆகின துள஫களில் ஧னன்஧டுகி஫து. 

21. உள்ளீட்டு ொத஦ங்கள் ஋ன்஫ால் ஋ன்஦? இபண்டு ஋டுத்துக்காட்டுகள் தருக. 

 உள்ளீட்டு ொத஦ங்கள் அள஦த்து யளகனா஦ தபவுகள஭யும் கணிப஧ாறிக்குள் உள்ளிடப் 

஧னன்஧டுகி஫து. 

 உள்ளிடப்஧ட்ட தபவுகள் பென஬ாக்கத்திற்காக நிள஦யகத்தில் வெமிக்கப்஧டுகின்஫஦. 

 ஋.கா: விளெப்஧஬ளக, சுட்டி, யருடி. 
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22. ஌வதனும் மூன்று பயளியீட்டு ொத஦ங்கள஭ வி஭க்குக? 

    திளபனகம் :   தகயள஬த் திளபயில் காட்டப் ப஧ாதுயாகப் ஧னன்஧டுத்தப்஧டும். 

 யளபவி :   இது தாள்களில் யளபகள஬ பயளியீட்ளட அச்சிட ஧னன்஧டுகி஫து. 

 ஧ல்லூடகப் ஧டவீழ்த்தி  : கணிப்ப஧ாறி திளபனக பயளியீட்ளடப் ப஧ரின திளபயில் திளபயிடும்.  

23. எளியினல் சுட்டி நற்றும் வ஬ெர் சுட்டி வயறு஧டுத்துக 

  எளியினல் சுட்டி வ஬ெர் சுட்டி 

சுட்டியின் இனக்கம் நற்றும் முடுக்கம் 

அ஭விடப்஧டும் 

சுட்டியின் இனக்கம் நற்றும் முடுக்கம் 

அ஭விடப்஧டும் 

சுட்டி ஥கர்யளத தீர்நானிக்கப் ஧ந்துக்குப் ஧தி஬ாக 

எளிப் ஧னன்஧டுத்தப்஧டுகி஫து. 

வ஬ெர் சுட்டி அகச்சியப்பு கதிர்கள஭ப் 

஧னன்஧டுத்துகி஫து. 

குள஫யா஦ உணர்தி஫ன் பகாண்டது மிகுந்த உணர்தி஫ன் பகாண்டது நற்றும் ஋ந்தக் 

கடி஦நா஦ வநற்஧பப்பிலும் பெனல்஧டும். 

24. தட்டல் யளக அச்சுப்ப஧ாறிளனப் ஧ற்றி சிறுகுறிப்பு யளபக. 

 தட்டல் யளக அச்சுப்ப஧ாறியில் - எரு சிறுகம்பி, ளந஥ாடா மீது தட்டி எரு புள்ளிளன 

஌ற்஧டுத்தும்.  

 இனந்திப அழுத்தத்ளதப் ஧னன்஧டுத்தி எவப ெநனத்தில் ஧஬ ஧டிகள் ஋டுக்க யளக பெய்கி஫து. 

 யளககள் :  யரி அச்சுப்ப஧ாறி நற்றும் யரிபுள்ளி அச்சுப்ப஧ாறி. 

25. ஆ஫ாயது தள஬முள஫யின் தன்ளநகள஭ப் ஧ற்றி சுருக்கநாக ஋ழுதுக. 

 பெனற்ளக ஥பம்பினல் யள஬னளநப்பின் அடிப்஧ளடயில் அறிவு ொர்ந்த கணிப்ப஧ாறிகள் ஋஦ 

யளபனறுக்கப்஧டுகி஫து.  

 ஆ஫ாயது தள஬முள஫, கணிப்ப஧ாறிகளின் வினத்தகு நாற்஫ங்களில் என்று ஧பந்த 

யள஬னளநப்பு ய஭ர்ச்சி ஆகும்.  

 இனற்ளக பநாழி பென஬ாக்கம் ஋ன்஧து பெனற்ளக நுண்ணறிவின் எரு அங்கநாகும்.  

26. திளபனகத்தின் குறிப்பிடத்தக்க சி஫ப்பினல்புகள஭ப் ஧ற்றி ஋ழுதுக. 

 தகயள஬த் திளபயில் காட்டப் ப஧ாதுயாகப் ஧னன்஧டுத்தப்஧டும் பயளியீட்டு ொத஦ம் . 

 திளபனகத்தின் ஧டங்கள் பிக்ெல்ஸ் (Pixels)  மூ஬ம் உருயாக்கப்஧டுகின்஫஦. 

 யளககள் I. CRT - Cathode Ray Tube 

 II. LCD - Liquid Crystal Display 

 III. LED - Light Emitting Diode 

஧குதி - ஈ : ப஥டு வி஦ாக்கள் 

27. எரு கணிப்ப஧ாறியின் அடிப்஧ளட ஧ாகங்கள஭த் பதளியா஦ வி஭க்கப்஧டத்துடன் வி஭க்கு. 

 
(i) உள்ளீட்டகம்:  

 அள஦த்து யளகனா஦ தபவுகள஭யும் கணிப்ப஧ாறிக்குள் உள்ளிடப் ஧னன்஧டுகி஫து.  

 உள்ளிடப்஧ட்ட தபவுகள் பென஬ாக்கத்திற்காக நிள஦யகத்தில் வெமிக்கப்஧டுகின்஫஦. 

஋டுத்துக்காட்டு விளெப்஧஬ளக, சுட்டிப் வ஧ான்஫ளய. 

(ii) ளநனச் பென஬கம்:  

 கணிப்ப஧ாறிக்கு யமங்கப்஧டும் கட்டள஭கள஭, கணிப்ப஧ாறி புரிந்துக் பகாள்ளும் யளகயில் 

நாற்றி அதள஦ பென஬ாக்கம் பெய்யும் முதன்ளநனா஦ ஧குதினாகும்.  

 ளநனச் பென஬கத்தில் மூன்று ஧குதிகள் உள்஭஦. அளய கட்டுப்஧ாட்டகம், கணித ஌பணச் 

பென஬கம் நற்றும் நிள஦யகம் ஆகும். 
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(iii) கணித ஌பணச் பென஬கம்:  

 கணித ஌பணச் பென஬கம், ஧஬ கணிப்பீடு பெனல்கள஭த் தபவின் மீது நிகழ்த்துகி஫து. கூட்டல், 

கழித்தல், ப஧ருக்கல், யகுத்தல் நற்றும் சுருக்க பெனல்கள் வ஧ான்஫ கணிதச் பெனல்஧ாடுகள஭ 

கணித ஌பணச் பென஬கம் பெய்கி஫து. 

(iv) கட்டுப்஧ாட்டகம்:  

 ளநன பென஬கம் - நிள஦யகம் நற்றும் உள்ளீடு/பயளியீடு ொத஦ங்களுக்கு இளடவன 

஧ரிநா஫ப்஧டும் தபளயக் கட்டுப்஧ாட்டகம் கட்டுப்஧டுத்துகி஫து. 

(v) பயளியீட்டகம்:  

 ஧ன஦ர்கள் புரிந்து பகாள்஭க்கூடின யளகயில் தகயள஬த் பதரிவிக்கும் ஋ந்தபயாரு 

யன்ப஧ாருளும் பயளியீட்டகம் ஋஦ப்஧டும்.  

 ஋டுத்துக்காட்டு: திளபனகம், அச்சுப்ப஧ாறி வ஧ான்஫ளய. 

(vi) நிள஦யகம்:  

 முதன்ளந நிள஦யகம் நற்றும் இபண்டாம்நிள஬ நிள஦யகம் ஋஦ இருயளக நிள஦யகங்கள் 

உள்஭஦.  

 முதன்ளந நிள஦யகம்: தபவு நற்றும் நிபல்கள஭ தற்காலிகநாகச் வெமிக்க. ஋.கா. :   RAM 

 இபண்டாம்நிள஬ நிள஦யகம்: தபவுகள஭ நிபந்தபநாக வெமித்து ளயக்க. ஋.கா: யன்யட்டு 

28. கணிப்ப஧ாறியின் ஧ல்வயறு தள஬முள஫கள஭ வி஭க்குக. 

   முத஬ாம் தள஬முள஫ (1940-1956) - பயற்றிடக் குமல்கள்  

 அ஭வில் ப஧ரினது 

 அதிக அ஭வு மின்ொபத்ளத ஋டுத்துக்பகாண்டது. 

 அதிக பயப்஧ம் காபணநாக பெனலிமக்கும். 

 இனந்திப பநாழி ஧னன்஧டுத்தப்஧ட்டது. 

   இபண்டாம் தள஬முள஫ (1956-1964) - திரிதளடனங்கள்  

 முதல் தள஬முள஫யுடன் எப்பிடும்வ஧ாது அ஭வில் சிறினது. 

 குள஫ந்த பயப்஧த்ளத பயளிவனற்றினது. 

 குள஫ந்த மின்ொபத்ளத ஋டுத்துக்பகாண்டது. 

 இனந்திப பநாழி நற்றும் அபெம்஧ளி பநாழி ஧னன்஧டுத்தப்஧ட்டது. 

   மூன்஫ாம் தள஬முள஫ (1964-1971) - எருங்கிளணந்த சுற்றுகள் 

 கணிப்ப஧ாறிகள் அ஭வில் சிறினது.  

 விளபயாக பெனல்஧டும் நற்றும் அதிக ஥ம்஧கத் தன்ளநயுளடனது. 

 குள஫ந்த மின்ொபத்ளத ஋டுத்துக் பகாண்டது. 

 உனர் நிள஬ பநாழி ஧னன்஧டுத்தப்஧ட்டது 

   ஥ான்காம் தள஬முள஫ (1971-1980) - நுண் பெனலி 

 சிறினது நற்றும் வயகநா஦து 

 IBM நற்றும் APPLE வ஧ான்஫ நுண் கணிப்ப஧ாறிகள் உருயாக்கப்஧ட்டது 

 ளகனடக்க கணிப்ப஧ாறிகள் அறிமுக஧டுத்தப்஧ட்டது . 

   ஍ந்தாம் தள஬முள஫ (1980 - இன்று யளப) - மீப்ப஧ரு அ஭வி஬ா஦ எருங்கிளணந்த சுற்றுகள் 

 இளண பென஬ாக்கம் 

 கணிப்ப஧ாறியின் அ஭வு மிகவும் கணிெநாகக் குள஫க்கப்஧ட்டது. 

 நிமற்஧டங்கள் நற்றும் யளப஧டங்கள஭ப் புரிந்து பகாள்ளும் தி஫ன். 

 பெனற்ளக நுண்ணறிவு நற்றும் நிபுணர் அளநப்பு அறிமுகம். 

   ஆ஫ாயது தள஬முள஫  ஋திர் கா஬த்தில் 

 இளண நற்றும் ஧கிர்வு கணிப்பீடு 

 கணிப்ப஧ாறிகள் தி஫ளநனாகவும், விளபயாகவும் நற்றும் சிறினதாகவும் இருக்கும். 

 பெனற்ளக நனிதர்கள் உருயாக்குதல். 

 இனற்ளக பநாழி பென஬ாக்கம் 

 குபல் அறிதல் பநன்ப஧ாருள் உருயாக்குதல். 

29. பின்யரு஧யற்ள஫ வி஭க்குங்கள்    

      அ) ளநப்பீச்சு அச்சுப்ப஧ாறி ஆ) ஧ல்லூடகப் ஧டவீழ்த்தி   

       இ) ஧ட்ளடக் குறியீடு / QR குறியீடு ஧டிப்஧ான் 
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  (அ) ளநபீச்சு அச்சுப்ப஧ாறி: 

 ளநப்பீச்சு அச்சுப்ப஧ாறிகள் கருஞ்சியப்பு, நஞ்ெள் நற்றும் சினான் உள்஭டக்கின ளநகுப்பிளனப் 

஧னன்஧டுத்தி யண்ண ொனள஬ உருயாக்குகி஫து.  

 ளநப்பீச்சு அச்சுப்ப஧ாறிகள் எரு காகிதத் தாளில் மின்னூட்டம் ப஧ற்஫ ளநளனத் பதளிப்஧தன் 

மூ஬ம் பெனல்஧டுகி஫து.  

 இதன் அச்சிடும் வயகம் ப஧ாதுயாக எரு நிமிடத்திற்கு 1 முதல் 20 ஧க்கங்கள஭ அச்சிடும் 

(PPM-Page Per Minute).  

  (ஆ) ஧ல்லூடகப் ஧டவீழ்த்தி: 

 ஧ல்லூடகப் ஧டவீழ்த்தி, கணிப்ப஧ாறி திளபனக பயளியீட்ளடப் ப஧ரின திளபயில் திளபயிடப் 

஧னன்஧டுகின்஫து.  

 இளயகள் யகுப்஧ள஫களில் அல்஬து கூட்ட அபங்குகளில் வி஭க்கக் காட்சிகள஭க் 

காட்சிப்஧டுத்தப் ஧னன்஧டுத்தப்஧டுகின்஫஦. 

   (இ) ஧ட்ளடக் குறியீடு/ QR ஧டிப்஧ான்: 

 ஧ட்ளடக் குறியீடு ஋ன்஧து பயவ்வயறு தடிநன் யரிளெயில் அச்சிடப்஧டும் எரு யடியம் ஆகும்.  

 ஧ட்ளட குறியீட்டு ஧டிப்஧ான், ஧ட்ளடக் குறியீட்ளடப் ஧டித்து அயற்ள஫ மின் துடிப்புக஭ாக  

நாற்றி கணிப்ப஧ாறி பென஬கத்திற்கு அனுப்பும் எரு கருவினாகும்.  

QR ஧டிப்஧ான் 

 கணிப்ப஧ாறியில் தகயள஬ விளபயாகவும் பிளமயின்றிப் ஧திவு பெய்னவும் இது ஧னன்஧டுகி஫து. 

கியூ.ஆர் குறியீடா஦து, இரு ஧ரிநாண ஧ட்ளடக் குறியீடாகும்.  

 இது எரு வகநபா மூ஬ம் ஧டிக்கப்஧ட்டுப் ஧டத்ளத உணர்த்துகி஫து. 

 

஧ாடம் - 2   ஋ண் முள஫கள் 

஧குதி – ஆ : குறு வி஦ாக்கள் 

1. தபவு ஋ன்஫ால் ஋ன்஦?  

 Data (தபவு) ஋ன்஫ பொல் Datum ஋ன்஫ பொல்லிலிருந்து யந்தது,  

 அதன் ப஧ாருள் ”பெனல்஧டுத்தப்஧டாத உண்ளந தகயல்” (Raw facts) ஋ன்஧தாகும்.  

 தபவு ஋ன்஧து நக்கள், இடங்கள் அல்஬து ப஧ாருட்களின் உண்ளநத் தகயல்கள஭ பகாண்டது.  

2. 1ன் நிபப்பு முள஫க்கா஦ யழிமுள஫கள஭ ஋ழுதுக.  

 ஧டிநிள஬ 1:  ஧தின்ந ஋ண்ணுக்கு நிகபா஦ இருநிள஬ ஋ண்ணாக நாற்றுக.  

 ஧டிநிள஬ 2:  நாற்஫ப்஧ட்ட இருநிள஬ ஋ண் 8 பிட்டுக஭ாக உள்஭தா ஋ன்஧ளத ெரி஧ார்க்கவும். 8 

பிட்டுக்கும் குள஫யாக இருப்பின் , முன்ப஦ாட்டாக 0 க்கள஭ வெர்த்து  8 பிட்டுக஭ாக 

நாற்஫வும்.  

 ஧டிநிள஬ 3: அள஦த்து பிட்டுக ள஭யும், தள஬கீமாக நாற்஫வும் . (அதாயது 1 ஋ன்஧ளத 0 

஋஦வும், 0 ஋ன்஧ளத 1 ஋஦வும் நாற்றுக) 

3. (46)10 க்கு நிகபா஦ இருநிள஬ ஋ண்ணாக நாற்றுக.                                 

2 46 

2 23  -  0 

2  11   -  1 

2  5   -  1 

2  2   -  1 

2  1    -  0 

 4610 = (101110)2 

4. (28)10 க்கு 1ன் நிபப்பு முள஫யில் விளட காண முடினாது ஌ன் காபணம் கூறு.  

 (2810) ஋ன்஫ ஋ண் வ஥ர்நள஫ ஋ண்ணாகும் . ஆளகனால் 1ன் நிபப்பு முள஫யில் விளட காண 

முடினாது.  

5. ஋ழுத்துருக்கள஭ நிள஦யகத்தில் ளகனாளுயதற்கா஦ குறியீட்டு முள஫கள஭ப் ஧ட்டினலிடுக. 

(i) BCD - Binary Coded Decimal.  

(ii) ASCII - American Standard Code for Information Interchange.  

(iii) EBCDIC - Extended Binary Coded Decimal Interchange Code.  
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(iv) ISCII - Indian Standard Code for Information Interchange.  

(v) Unicode.  

஧குதி - இ : சிறு வி஦ாக்கள் 

1. ஋ண் முள஫யில் அடிநா஦ம் ஋ன்஫ால் ஋ன்஦? ஋டுத்துக்காட்டு தருக.  

 அடிநா஦ம் ஋ன்஧து ஆங்கி஬த்தில்  Radix அல்஬து Base ஋஦ப்஧டும். அடிநா஦ம் எவ்பயாரு 

஋ண்முள஫யிலும் உள்஭ பநாத்த ஋ண் நதிப்பு உருக்களின் ஋ண்ணிக்ளகளன குறிக்கும் . 

஋டுத்துக்காட்டு:  

o ஧தின்ந நிள஬ ஋ண்முள஫ - அடிநா஦ம் (10)  

o இருநிள஬ ஋ண்முள஫ - அடிநா஦ம் (2)  

o ஋ண்ணிள஬ ஋ண்முள஫ - அடிநா஦ம் (8)  

o ஧தி஦ாறு நிள஬ ஋ண்முள஫ - அடிநா஦ம் (16)  

 2. இருநிள஬ ஋ண் முள஫ குறிப்பு யளபக  

 இருநிள஬ ஋ண் முள஫யில் 0 நற்றும் 1 ஋ன்஫ இபண்டு ஋ண் உருக்கள் நட்டுவந உள்஭து.  

 இந்த முள஫, “2 - ன் அடுக்கு நிள஬ நிள஫ முள஫” யில் 2ளன அடிநா஦நாக பகாண்டுள்஭து.  

 எரு இருநிள஬ ஋ண் பதாடரின் இடது ஏப பிட் , அதிக நிள஬ நிள஫ நதிப்ள஧ 

பகாண்டுள்஭தால், அது மிகு "நதிப்பு பிட்” (MSB) ஋஦வும்,  

 ய஬து ஏப பிட் குள஫ந்த நதிப்ள஧ ப஧றுயதால் , அது “குள஫ நதிப்பு பிட் ” (LSB) ஋஦ 

அளமக்கப்஧டுகின்஫து.  

 3. (150)10 க்கு நிகபா஦ இருநிள஬ ஋ண்ணாக நாற்றி, அதள஦ ஋ண்ணிள஬ ஋ண்ணாக நாற்றுக. 

2 150 

2   75  -  0 

2   37  -  1 

2   18   -  1 

2     9   -  0 

2     4   -  1 

2     2   -  0 

              1    -  0 

15010 = 100101102 

010     010    110 

2       2       6 

 100101102 = 2268 

 4. ISCII குறிப்பு யளபக.  

 இந்தின பநாழிகளின் ஧ல்வயறு ஋ழுத்துருக்கள஭ நட்டும் ளகனாளும் வ஥ாக்கில் 

யடியளநக்கப்஧ட்ட ஏர் முள஫ ISCII ஆகும்.  

 8 பிட் குறியீட்டு முள஫னாகும் . ஋஦வய, இந்த முள஫யில்  256 ஋ழுத்துருக்கள஭ ளகனா஭ 

முடியும்.  

 இந்தின அபசின் மின்஦ணு துள஫யின்  கீழ் அளநக்கப்஧ட்ட தபநிர்ணனக் குழுயால்  1986-88 

ஆண்டுயாக்கில் இந்த முள஫ உருயாக்கப்஧ட்டு,  

 இந்தின தபநிர்ணனக் குழுநத்தால் (BIS) ஌ற்றுக்பகாள்஭ப்஧ட்டுள்஭து. தற்வ஧ாது இந்த குறியீட்டு 

முள஫ ' யுனிவகாட்’ குறியீட்டு முள஫யில் இளணந்துவிட்டது.  

 5. கூட்டு: (அ) – 2210+ 1510 (ஆ) 2010+ 2510  

 (அ) -2210 + 1510  

஧டிநிள஬ 1 : 

 
2210 = இருநிள஬ ஋ண்கள் = 101102 1510= இருநிள஬ ஋ண்கள் = 11112  
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஧டிநிள஬ 2 : 

22 10 -ன் 8 பிட் யடியம் 0 0 0 1 0 1 1 0 

1-ன் நிபப்பி 1 1 1 0 1 0 0 1 

            + 1        1 

2-ன் நிபப்பி 1 1 1 0 1 0 1 1 

஧டிநிள஬ 3 :  -22  நற்றும் 15  -ன் இருநிள஬ கூட்டல்  

 
-2210+ 1510 = 111110012 

(ஆ) 2010 + 2510 

 
2010 = இருநிள஬ ஋ண்கள் = 101002 

2510= இருநிள஬ ஋ண்கள் = 110012  

22 நற்றும் 25 -ன் இருநிள஬ கூட்டல்  

 
2010 + 2510 = 001011012 

஧குதி - ஈ : ப஥டு வி஦ாக்கள் 

1. (அ) மிதப்புப்புள்஭ ஧தின்ந ஋ண்ளண, இருநிள஬ ஋ண்ணாக நாற்றுயதற்கா஦ யழிமுள஫கள஭  

          வியரி.   

    (ஆ) (98.46)10 க்கு நிகபா஦ இரு நிள஬ ஋ண்ணாக நாற்றுக. 

(அ) மிதப்புப்புள்ளி ஧தின்ந ஋ண்ளண இருநிள஬ ஋ண்ணாக நாற்றுதல்:  

 “2ன் பதாடர் ப஧ருக்கல் முள஫ ” ளன ஧னன்஧டுத்தி பகாடுக்கப்஧ட்ட மிதப்புப் பு ள்ளி ஧தின்ந 

஋ண்ளண இருநிள஬ ஋ண்ணாக நாற்஫஬ாம்.  

 ஧டிநிள஬ 1:  

மிதப்புப் புள்ளி ஧தின்ந ஋ண்ளண  2ஆல் ப஧ருக்கி யரும் விளட நதிப்பின் முழு ஋ண் ஧குதி  

0 அல்஬து 1 தனினாக குறித்து ளயக்க வயண்டும்.  

 ஧டிநிள஬ 2:  

஧டிநிள஬ 1ல் கிளடக்கப்ப஧ற்஫ விளட நதிப்பின் முழு ஋ண் ஧குதிளன , பகாடுக்கப்஧ட்ட 

மிதப்புப் புள்ளி ஋ண்ணிலிருந்து கழித்து விடவும்.  

மீதமுள்஭ மிதப்புப்புள்ளி நதிப்புகள஭ மீண்டும் 2ஆல் ப஧ருக்கி, அதன் விளட நதிப்பின் முழு 

஋ண் ஧குதிளன தனினாக குறித்து ளயக்கவும். 

஧டிநிள஬ 1 நற்றும் 2ளன, இறுதி நதிப்பு  0 ஋஦ யரும் யளபவனா அல்஬து பதாடர்ந்து சி ஬ 

இ஬க்கங்கள் யளபவனா மீண்டும், மீண்டும் பின்஧ற்றுக. 

 ஧டிநிள஬ 3:  

஧டிநிள஬ 1 நற்றும் 2ன் ஧டி தனிவன ஋ழுதி ளயக்கப்஧ட்டுள்஭ அள஦த்து  0 நற்றும் 1-கள஭ 

வநலிருந்து கீமாக ஋ழுதவயண்டும்.  

இதுவய, பகாடுக்கப்஧ட்ட மிதப்புப் புள்ளி ஋ண்ணுக்கு நிகபா஦ இருநிள஬ ஋ண் ஆகும். 

(ஆ) (98.46)10 க்கு நிகபா஦ இரு நிள஬ ஋ண்ணாக நாற்றுதல். 
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 2. பின்யரும் ஧தின்ந ஋ண்களுக்கு 1ன் நிபப்பி நற்றும் 2ன் நிபப்பிகள஭ காண்க.  

அ) - 98 ஆ) -135  

(அ) - 98 

 
(ஆ) - 135 

 
 3. (அ) கூட்டுக: 11010102+1011012  

    (ஆ) கழிக்க: 11010112-1110102 

 
஧ாடம் - 3 கணினி அளநப்பு 

஧குதி - ஆ : குறு வி஦ாக்கள் 

1. எரு நுண்பெனலின் ஧ண்புகள஭க் குறிக்கும் காபணிகள் னாளய?  

(i) கடிகாப வயகம் (Clock Speed)  

(ii) கட்டள஭ பதாகுப்பு (Instruction Set)  

(iii) வயர்டு அ஭வு (Word Size) 

 2. அறிவுறுத்தல் ஋ன்஫ால் ஋ன்஦?  

 கணிப்ப஧ாறியில் தபளய பெனற்஧டுத்த பகாடுக்கும் கட்டள஭வன அறிவுறுத்தல் ஋஦ப்஧டும். 

 3. நிபல் கவுண்ட்டர் ஋ன்஫ால் ஋ன்஦?  

 நிபலின் அடுத்து பெனற்஧டுத்த வயண்டின கட்டள஭யின் முகயரிளன ளநனச் பென஬கத்தில் 

வெமித்து ளயக்கும் எரு சி஫ப்பு ஧திவயடு தான் நிபல் ஧திவயடு ஆகும்.  
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4. உனர் யளபனள஫ ஧ல்லூடக இளடமுகம் (HDMI) ஋ன்஫ால் ஋ன்஦?  

 உனர் யளபனள஫ ஧ல்லூடக இளடமுகம் எலி / எளி இளடமுகம் சுருக்கப்஧டாத எலி நற்றும் 

எளி தபவுகள஭ கணிப்ப஧ாறி திளபனகத்திற்கு , LCD புபபாஜக்டர், டிஜிட்டல் 

பதாள஬க்காட்சிக்கு பகாடுக்கப் ஧னன்஧டுகின்஫து.  

5. EPROM- உள்஭ தபளய ஋வ்யாறு அழிப்஧ாய்?  

 EPROM உள்஭ தபளய பு஫ ஊதா எளி மூ஬ம் அழிக்கப்஧டுகி஫து. 

஧குதி - இ : சிறு வி஦ாக்கள் 

1. கணிப்ப஧ாறி அளநப்பு, கணிப்ப஧ாறி கட்டளநப்பு வயறு஧டுத்துக.  

   கணிப்ப஧ாறி அளநப்பு 

 கணிப்ப஧ாறி அளநப்பு ஋ன்஧து கணினியின் யன்ப஧ாருள் கூறுகள஭ உள்஭டக்கினது.  

 எரு கணினியின் அள஦த்து யன்ொத஦ங்களும் ஋வ்யாறு வயள஬ பெய்கி ஫து ஋ன்஧து 

஧ற்றியும், வநலும் ஧ல்வயறு ஧ாகங்களின் இளணப்பு ஧ற்றியும் வி஭க்குகி஫து.  

     கணினியின் கட்டளநப்பு 

 கணினியின் கட்டளநப்பு ஋ன்஧தும்  கணிப்ப஧ாறிளன யடியளநப்஧தில் ஈடு஧ட்டிருக்கும் 

ப஧ாறியினல் கருதுவகாளுடன் கணினி கட்டளநப்பு உள்஭டக்கினது. 

 2. தபவின் அக஬த்ளத ப஧ாருத்து நுண்பெனலிளன யளகப்஧டுத்துக.  

(i) 8- பிட் நுண்பெனலி  

(ii) 16-பிட் நுண்பெனலி  

(iii) 32-பிட் நுண்பெனலி   

(iv) 64-பிட் நுண்பெனலி 

  3. கட்டள஭யின் பதாகுதியின் அடிப்஧ளடயில் நுண்பெனலியின் யளககள஭ ஋ழுதுக.  

 குள஫க்கப்஧ட்ட கட்டள஭ பதாகுதி கணினிகள் (RISC)  

 சிக்க஬ா஦ கட்டள஭ அளநக்கப்஧ட்ட கணினிகள் (CISC)  

 4. PROM நற்றும் EPROM வயறு஧டுத்துக. 

PROM EPROM 

நிப஬ாக்கு ஧டிக்க நட்டும் நிள஦யகம். அழிக்கக் கூடின நிப஬ாக்கு ஧டிக்க நட்டும் 

நிள஦யகம். 

பு஫ ஊதா எளிளன பெலுத்தி PROMன் 

உள்஭டக்கத்ளத அழித்தும், மீண்டும் 

வயறு நிபல்கள஭ நறு஧டியும் ஋ழுத஬ாம்.  

EPROM-ல் தகயல்கள் பு஫ஊதா 

எளிபெலுத்தும் யளப தகயல்கள஭ வெமித்து 

ளயக்கப்஧டுகின்஫து 

நலியா஦து. PROM உடன் எப்பிடும்வ஧ாது விள஬ அதிகம். 

5. கணிப்ப஧ாறியில் ஧னன்஧டுத்தப்஧டும் இளடமுகம் நற்றும் பதாடர்பு முகங்கள஭ ஋ழுதுக.  

(i) பதாடர் பதாடர்புமுகம்  (v) ஆடிவனா பி஭க்ஸ்   

(ii) இளணனா஦ பதாடர்புமுகம்   (vi) PS/2 Port  

(iii) USB பதாடர்பு முகம்  (vii) உனர் யளபனள஦ ஧ல்லூடக இளடமுகம் (HDMI)  

(iv) VGA இளணப்஧ான்   (viii) SCSI Port.  

 6. CD நற்றும் DVD வயறு஧டுத்துக. 

CD DVD 

CD-ன் விரியாக்கம் Compact Disc   DVD-ன் விரியாக்கம் Digital Versatile Disc 

எரு ொதாபண CD-ன் பகாள்஭஭வு 700 MB எரு DVD-ன் பகாள்஭஭வு 4.7 GB  

CD- பயள்ளி நி஫ம் பகாண்டது. DVD-தங்கம் நற்றும் பயள்ளி நி஫ம் 

பகாண்டது. 

7. ஃபி஭ாஷ் நிள஦யகம் நற்஫ம் EEPROM ஋வ்யாறு வயறு஧டுத்துயாய்? 

ஃபி஭ாஷ் நிள஦யகம் EEPROM நிள஦யகம் 

இது வயகநாக அணுகல் வ஥பத்ளத யமங்குகி஫து. 

  

இது பநதுயா஦ அணுகல் வ஥பத்ளத 

யமங்குகி஫து. 

இதில் பி஭ாக் அடிப்஧ளடயில் தபவுகள் 

அழிக்கப்஧டும். 

இதில் ள஧ட் அடிப்஧ளடயில் தபவுகள் 

அழிக்கப்஧டும். 

இதன் பகாள்஭஭வு 1GB- யிலிருந்து 2 

படபாள஧ட்ஸ் யளபயில் கிளடக்கும். 

இதன் பகாள்஭஭வு 1KB- யிலிருந்து சி஬ MB 

யளபயில் கிளடக்கும். 



கணினி ஧னன்஧ாடுகள்                                                     9                                                                              முத஬ாம் ஆண்டு 

 

 ஧குதி - இ : ப஥டு வி஦ாக்கள் 

1. நுண்பெனலியின் ஧ண்பு கூறுகள஭ வி஭க்குக.  

(i) கடிகாப வயகம் (Clock Speed):  

 எவ்பயாரு நுண்பெனலிலும் உள்வ஭ எரு கடிகாபம் உள்஭து . கணிப்ப஧ாறியின் எவ்பயாரு 

கட்டள஭யும் நிள஫வயற்றுதலின் வயகத்ளத இந்த கடிகாபம்  கட்டுப்஧டுத்துகி஫து. இதுவய 

கடிகாபத்தின் வயகம் ஋஦ப்஧டும்.  

 கணிப்ப஧ாறியின் வயகத்ளத பநகா பெர்ட்ஸ் (Mega Hertz) நற்றும் ஜிகா பெர்ட்ஸ்  (Giga 

Hertz) அ஭வில் அ஭க்கப்஧டுகி஫து.  

(ii) கட்டள஭பதாகுப்பு (Instruction Set):  

 எரு தபவின் மீது பெனல்஧ாடுகள஭ச் பெனல்஧டுத்துயதற்காக, கணிப்ப஧ாறிக்கு பகாடுக்கப்஧டும் 

கட்டள஭கவ஭ அறிவுறுத்தல் ஋஦ப்஧டும்.  

 நுண்பெனலிளனச் பெனல்஧டுத்துயதற்காக யடியளநக்கப்஧ட்ட அடிப்஧ளட இனந்திப நிள஬ 

அறிவுறுத்தல் பதாகுதிகள஭க் கட்டள஭த் பதாகுப்பு ஋ன்கிவ஫ாம். 

 இந்த கட்டள஭களின் பதாகுதி பின்யரும் பெனல்கள஭ பெனல்஧டுத்துகி஫து.  

1. தபவு நாற்஫ம்  

2. ஋ண் கணித பெனல்முள஫கள்   

3. தருக்க பெனல்முள஫கள்   

4. கட்டுப்஧ாட்டு ஥கர்வு 

5. உள்ளீடு / பயளியீடு  

(iii) வயர்டு அ஭வு (Word Size):  

 வயர்டின் அ஭வு ஋ன்஧து எருதடளய பெனலி பெனற்஧டுத்தும் பிட்டுகளின் அ஭யாகும்.  

 எருவயர்டு அ஭வு ஋ன்஧து கணிப்ப஧ாறியின்  முதன்ளந நிள஦யகம்  (RAM) பெனற்஧டுத்தும் 

கட்டள஭யின் அ஭ளயயும் , நுண்பெனலியில் உள்஭ ஊசிகளின்  ஋ண்ணிக்ளகளன 

ப஧ாருத்ததாகும்.  

 2. ஧டித்தல் / ஋ழுதுதல் (READ / WRITE) பெனல்கள஭ பெனலி ஋வ்யாறு பெய்கி஫து? வி஭க்குக.  

 RAMல் உள்஭ வயர்டின் அ஭வும் நிள஦யக தபவு ஧திவயட்டின் அ஭வும் என்஫ாகும். 

 நிள஦யக தபவு ஧திவயடின் அ஭வு  8 பிட்டாக இருந்தால் நிள஦யகத்தில் இளத 8-பிட் 

அ஭வி஬ா஦ எரு வயர்டுடன் இளணக்க஬ாம்.  

 READ பெனல்஧ாடு தபவு  (பிட்டுகள஭) வயர்டில் இருந்து நிள஦யக தபவு ஧திவயடுகளுக்கு 

அனுப்பும்.  

 WRITE பெனல்஧ாடு தபவு (பிட்டுகள஭) நிள஦யக தபவு ஧தி வயகளில் இருந்து வயர்டிற்கு 

அனுப்பும்.  

3. இனக்க வ஥பத்தின் அடிப்஧ளடயில் நிள஦யக ொத஦ங்கள஭ ஌றுயரிளெயில் அளநக்கவும்.  

 ஧஬ யளகனாக நிள஦யகச் ொத஦ங்கள் , அதன் பகாள்஭஭வு , வயகம் நற்றும் விள஬யின் 

அடிப்஧ளடயில் யரிளெப்஧டுத்தப்஧ட்டுள்஭து. 

 
 4. ROM ன் யளககள஭ ஧ற்றி வி஭க்கநாக ஋ழுதுக. 

஧டிக்க நட்டும் நிள஦யகம் (ROM) :  

 கணிப்ப஧ாறியின் எரு சி஫ப்பு நிள஦யகம் . இது உருயாக்கப்஧டும் வ஧ாவத , தபவுகள் ஧திவு 

பெய்னப்஧ட்டு விடுயதால் அதில் நாற்஫ம் பெய்ன முடினாது.  

 இதில் வெமிக்கப்஧டும் நிபல்கள் கணினிளனத் துயக்கவும் நற்றும் பதாடங்கும் வ஧ாது பெய்ன 

வயண்டின பெனல்கள் வ஧ான்஫ளய இத்தளகன நிள஦யகங்களில் ளயக்கப்஧டுகின்஫஦.  
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 ROM ன் உள்஭டக்கம் மின்ொபம் நிறுத்தப்஧ட்டாலும் அழியதில்ள஬. இத஦ால் ROM ளன அழினா 

நிள஦யகம் ஋ன்று அளமக்கப்஧டுகி஫து.  

நிப஬ாக்கு ஧டிக்க நட்டும் நிள஦யகம் (PROM):  

 நிப஬ாக்கு ஧டிக்க நட்டும் நிள஦யகம் , எரு அழினா நிள஦யகம் ஆகும் . இதில் தபவுகள் எரு 

முள஫நட்டும் ஋ழுத முடியும் . PROM - ல் எரு முள஫ நிபல்கள஭ ஋ழுதிவிட்டால் 

஋ப்ப஧ாழுதும் அழினாநலிருக்கும்.  

 முதன்ளந நிள஦யகம் வ஧ான்று அல்஬ாநல் கணினியின் பெனல்஧ாடு நிறுத்தப்஧ட்டாலும் . 

PROM -ன் உள்஭டக்கம் அழினாநல் இருக்கும்.  

 PROM Burner ஋ன்஫ பநன்ப஧ாருள஭ ஧னன்஧டுத்தி  PROM சிப்பில் தபவுகள் ஋ழுதப்஧டுகின்஫து . 

இந்த யளகனா஦ PROM-ன் நிப஬ாக்கம் PROM-ல் ஋ழுதுதல் ஋ன்஫ளமக்கப்஧டும்.  

அழிக்கக்கூடின நிப஬ாக்கு ஧டிக்க நட்டும் நிள஦யகம் (EPROM):  

 அழிக்கக் கூடின நிப஬ாக்கு ஧டிக்க நட்டும் நிள஦யகம் , எரு PROM யளகனா஦ சி஫ப்பு 

நிள஦யகம் ஆகும். ஆ஦ால் அதில் பு஫ ஊதா எளி மூ஬ம் தகயல்கள் அழிக்கப்஧டுகி஫து.  

 EPROM-ல் தகயல்கள் பு஫ ஊதா எளி பெலுத்தும் யளப தகயல்கள஭ச் வெமித்து ளயக்கும். பு஫ 

ஊதா எளிளன பெலுத்தி  PROM-ன் உள்஭டக்கத்ளத அழித்தும் , மீண்டும் வயறு நிபல்கள஭ 

நறு஧டியும் ஋ழுத஬ாம்.  

மின்ொபத்தால் அழிக்கும் நற்றும் நிப஬ாக்கு ஧டிக்க நட்டும் நிள஦யகம் (EEPROM):  

 EEROM எரு சி஫ப்பு  PROM யளகளனச் ொர்ந்த நிள஦யகம் ஆகும் . இதில் உள்஭ தபவுகள஭ 

மின்ொபத்ளதச் பெலுத்திவன அழிக்க஬ாம்.  

 நற்஫ PROM யளகளனப் வ஧ா஬வய மின்ொபம் நிறுத்தப்஧ட்டாலும் தபவுகள் அழினாது. நற்஫ ROM 

யளககள஭ எப்பிட்டால், EEPROM எரு பநதுயாக இனங்கும் நிள஦யகம் ஆகும். 

 

஧ாடம் - 4  இனக்க அளநப்பின் வகாட்஧ாட்டு கருத்துக்கள் 

஧குதி – ஆ : குறு வி஦ா 

1) நிள஦யக வந஬ாண்ளநயின் ஥ன்ளநகள் ஌வதனும் இபண்ளட கூறு ? 

 ளநனச் பென஬கத்தின் ஧னன்஧ாட்ளட வநம்஧டுத்துயது. 

 முதன்ளந நிள஦யகத்தின் யழினாக கணிப்ப஧ாறியின் வயகத்ளதயும் அதிகப்஧டுத்துயது. 

2) ஧஬ ஧ன஦ர் இனக்க அளநப்பு ஋ன்஫ால் ஋ன்஦ ? 

 எவப வ஥பத்தில் என்றுக்கும் வநற்஧ட்ட ஧ன஦ர்கள், எவப நாதிரினா஦ தபவுகள஭யும் 

஧னன்஧ாடுகள஭யும் கணிப்ப஧ாறியில் ஧னன்஧டுத்த அனுநதிக்கும் இனக்க அளநப்பு “஧஬ ஧ன஦ர் 

இனக்க அளநப்பு” ஋஦ப்஧டும். 

3) GUI ஋ன்஫ால் ஋ன்஦ ? 

 ஧ன஦ர் கணிப்ப஧ாறியுடன் ஊடாட யளபகள஬ ஧ன஦ர் இளடமுகம் சி஫ந்த யழிமுள஫னாகும். 

 உள்ளீடு / பயளியீடுகள஭ ளகனாள்யதற்கும், ஧ட்டிகளிலிருந்து வதர்வு பெய்யதற்கும் 

வதளயனா஦ சுட்டும் கருவிகள஭க்  பகாண்டாது. 

4) ஧ாதுகாப்பு வந஬ாண்ளநயின் ஥ன்ளநகள் னாளய ? 

 இனக்க அளநப்பு ஧ன஦ருக்கு மூன்று நிள஬ப் ஧ாதுகாப்ள஧ யமங்குகி஫து. 

1. வகாப்பு நிள஬ 

2. அளநப்பு நிள஬ 

3. யள஬ நிள஬ 

5) ஧ல் ஧ணினாக்கம் ஋ன்஫ால் ஋ன்஦ ? 

 எவப வ஥பத்தில் என்றுக்கும் வநற்஧ட்ட ஧னன்஧ாடுகள஭ கணிப்ப஧ாறியில் இனக்குயது ஧ல் 

஧ணினாக்கம் ஋஦ப்஧டும். 

6) கணிப்ப஧ாறியில் ஧னன்஧டுத்தப்஧டும் பயவ்வயறு இனக்க அளநப்புகள் னாளய ? 

 விண்வடாஸ் , லி஦க்ஸ் , யூனிக்ஸ், Mac OS 

஧குதி - இ : சிறு வி஦ா 

1) வ஥பம் ஧கிர்தல் இனக்க அளநப்பின் ஥ன்ளநகள் நற்றும் தீளநகள் ஋ன்஦ ? 

   ஥ன்ளநகள்  

 விளபயா஦ பெனல்கள். 

 பநன்ப஧ாருளின் பிபதிகள஭த் தவிர்க்கி஫து. 

 CPUன் பென஬ற்஫ வ஥பத்ளத குள஫க்கி஫து. 
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   தீளநகள்  

 ஥ம்஧கத்தன்ளந இன்ளந. 

 ஧னன்஧ாடுகள் நற்றும் தபவுகளின் ஧ாதுகாப்பு பிபச்ெள஦ 

 தபவு பதாடர்பு பிபச்ெள஦. 

2) இனக்க அளநப்பின் முக்கின சி஫ப்பினல்புகள஭ ஧ட்டினலிடுக. 

 ஧ன஦ர் இளடமுகம் 

 வகாப்பு வந஬ாண்ளந 

 பெனல் வந஬ாண்ளந 

 ஧ாதுகாப்பு வந஬ாண்ளந 

 நிள஦யக வந஬ாண்ளந  

 பிளம ப஧ாறுத்தல்  

3) ஧஬ பென஬ாக்க இனக்க அளநப்பு சிறு குறிப்பு யளபக 

 ஧஬ பென஬ாக்க பெனல்முள஫ இபண்டு அல்஬து அதற்கு வநற்஧ட்ட பெனலிகள஭க் 

பகாண்டுள்஭து. பென஬ாக்கம் இளணனாக பெனல்஧டுயதால் இது இளணனாக்க பெனலி 

ஆகும்.  

 ஧஬ பெனல்கள் இளணனாக நிள஫வயற்஫ப்஧டுயதால், இந்த அம்ெநா஦து அதிக஧ட்ெ 

இனக்கத்திற்கு ஧னன்஧டுத்தப்஧டுகி஫து.  

 இது கணினிப்஧ணியின் தி஫ள஦ வநம்஧டுத்துகி஫து. 

஧குதி - ஈ : ப஥டு வி஦ா 

1) ஧பயல் இனக்க அளநப்பின் கருத்துரு ஧ற்றி வி஭க்குக வநலும் அதன் ஧னன்஧ாடுகள் னாளய ? 

 டிஜிட்டல் இளண னம் (இளணனத஭ம் / உள்யள஬) யழினாக உ஬பகங்கிலும் ஧஬ இடங்களில் 

வெமிக்கப்஧ட்டு பென஬ாக்கப்஧ட்ட தபவுகள் நற்றும் ஧னன்஧ாட்டுகள஭ இந்த அம்ெம் கயனித்து 

பகாள்கி஫து. 

 ஧பயல் இனக்க அளநப்பின் ஥ன்ளநகள் பின்யருநாறு: 

o எவப இடத்தில் உள்஭ எரு ஧ன஦ர், யள஬னளநப்பின் மூ஬ம் நற்ப஫ாரு இடத்திலுள்஭ 

஋ல்஬ா ய஭ங்கள஭யும் ஧னன்஧டுத்த஬ாம். 

o ஧஬ கணினி ய஭ங்கள஭ யள஬னளநப்பில் ஋ளிதாக இளணக்க முடியும் 

o யாடிக்ளகனா஭ர்களுடன் உள்஭ பதாடர்புகள஭ வநம்஧டுத்துகி஫து 

o புபய஬ன்/புபய஬ர் (Host) கணினியில் உள்஭ சுளநளனக் குள஫க்கி஫து 

2) எரு இனக்க முள஫ளநக்கா஦ ஧ன஦ர் இளடமுகத்ளத உருயாக்கும்வ஧ாது கய஦த்தில் பகாள்஭  

    முக்கின கருத்துக்கள஭ ஧ட்டினலிடுக. 

 ஧ன஦ர் இளடமுகநா஦து  நீண்ட கா஬த்திற்கு ஧னன்஧ாட்டில் இருக்க வயண்டும். 

 இளடமுகம் ஧ன஦ரின் வதளயகள஭த் திருப்தி பெய்ன வயண்டும். 

 ஧ன஦ர் இளடமுகநா஦து, ஧ன஦ரின் விள஬நதிப்஧ற்஫ வ஥பத்ளத வெமிக்கி஫து. யளபகள஬ 

கூறுக஭ா஦ ஧ட்டிகள், ென்஦ல் திளபகள், தத்தத்தல், ஧ணிக் குறிகள் நற்றும் தட்டச்சு பெய்யும் 

வயள஬ளனக் குள஫த்தல் வ஧ான்஫ளய இனக்க அளநப்பின் கூடுதல் ஧ன஦ாகும். 

 ஧ன஦ர் இளடமுகம் யாடிக்ளகனா஭ளபத் திருப்திப்஧டுத்துநாறு யடியளநக்க வயண்டும் 

 ஧ன஦ர் பெய்யும் தயறுகள஭ இளடமுகம் குள஫க்க வயண்டும். 

3) இனக்க அளநப்பின் பெனல் வந஬ாண்ளந ப஥றிமுள஫கள஭ வி஭க்குக. 

    (i) முதலில் யந்தது முதலில் பெல்லும் (FIFO):  

 முதலில் யந்தது முதலில் பெல்லும் ப஥றிமுள஫ ஋ன்஧து யரிளெ நுட்஧த்ளத (Queuing 

Technique) அடிப்஧ளடனாகக் பகாண்டது.  

 எரு வெளயளனப் ப஧஫ ஥ாம் யரிளெயில் நிற்கிவ஫ாம். முதலில் யந்தயர் முதலில் வெளயளனப் 

ப஧றுகி஫ார்.  

 நதிப்ப஧ண் ஧ட்டினள஬ ஆசிரினர் யமங்குயதற்காக நாணயர்கள் யரிளெயில் நிற்஧து எரு 

஋டுத்துக்காட்டு ஆகும். 

    (ii) சிறினது முதலில் (Shortest Job First) :  

 இந்த ப஥றிமுள஫, ளநனச் பென஬கத்தால் இனக்கப்஧டும் எரு வயள஬யின் அ஭ளய 

அடிப்஧ளடனாகக் பகாண்டது.  

 A நற்றும் B ஋஦ இபண்டு வயள஬கள஭ ஋டுத்துக்பகாள்வயாம்.  
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 இந்தந்த இபண்டு வயள஬களில், A வயள஬யின் அ஭வு, B வயள஬ளன விட குள஫யாக 

இருப்஧தால், முதலில் A வயள஬ இனக்கப்஧டும்.  

    (iii) யட்ட யரிளெ (Round Robin) :  

 யட்ட யரிளெ திட்டமிடல் வ஥பப் ஧கிர்வு அளநப்பு-களுக்கு (Time Sharing System) சி஫ப்஧ாக 

யடியளநக்கப்஧ட்ட ப஥றிமுள஫ ஆகும்.  

 சுமற்சி முள஫யில், எவ்பயாரு ஧ணிக்கும், எரு குறிப்பிட்ட வ஥பம் எதுக்கப்஧டும்.  

 ஋டுத்துக்காட்டாக, A, B, C ஋஦ மூன்று வயள஬கள் இருப்஧தாக ஋டுத்துக்பகாள்வயாம்.  

    (iv) முன்னுரிளநக்கு ஌ற்஧ (Based on Priority):  

 பகாடுக்கப்஧ட்ட வயள஬ முன்னுரிளந அடிப்஧ளடயில் எதுக்கப்஧ட்டுள்஭து.  

 நற்஫ வயள஬கள஭ விட அதிக முன்னுரிளந பகாண்டிருக்கும் வயள஬ மிகவும் 

முக்கினநா஦து. 

஧ாடம்-5 விண்வடாஸ்-ல் வயள஬ பெய்தல் 

஧குதி – ஆ : குறுவி஦ாக்கள் 

1. ஧ல்஧ணினாக்கம் ஋ன்஫ால் ஋ன்஦? 

 எவப வ஥பத்தில் என்றுக்கும் வநற்஧ட்ட ஧னன்஧ாடுகள஭ கணிப்ப஧ாறியில் இனக்க முடியும் 

இதற்கு ஧ல் ஧ணினாக்கம் ஋ன்று ப஧னர். 

2. பெந்தப஧ணிக்குறி ஋ன்஫ால் ஋ன்஦? 

 விண்வடாஸ் இனக்க அளநப்பு நிறுயப்஧டும் வ஧ாது உருயாக்கப்஧டும் பகாடாநிள஬ 

஧ணிக்குறிகள்  பெந்தப஧ணிக்குறி ஋஦ப்஧டும். 

3. வகாப்பிற்கும் வகாப்புள஫க்கும் உள்஭ வயறு஧ாடு னாது? 

 கணிப்ப஧ாறியினல் உள்஭ அள஦த்து தகயல்களும் வகாப்புக஭ாக வெமிக்கப்஧டுகின்஫து. 

 வகாப்புகள் நீட்டிப்புடன் வெமிக்கப்஧டும் 

 வகாப்புகள஭ எருங்களநக்க வகாப்புள஫கள் ஧னன்஧டுகி஫து 

 வகாப்புள஫களில் நீட்டிப்பு இல்ள஬ 

4. Save நற்றும் Save As-க்கு உள்஭ வயறு஧ாடு னாது? 

Save Save As 

Save கட்டள஭ எரு வகாப்ள஧ முதன் முதலில் 

கணிப்ப஧ாறியில் வெமிக்க ஧னன்஧டுகி஫து.  

Save As கட்டள஭ வெமிக்கப்஧ட்ட வகாப்ள஧ 

வயப஫ாரு ப஧னரில் வெமிக்க ஧னன்஧டுகி஫து 

Ctrl+S Ctrl+Shift+S 

5. எரு வகாப்ள஧ ஋வ்யாறு நறுப஧னரிடுவீர்கள்? 

 ஧ட்டி அல்஬து இடது சுட்டிப் ப஧ாத்தான் அல்஬து ய஬து சுட்டிப் ப஧ாத்தாள஦ப் ஧னன்஧டுத்தி 

வகாப்ள஧ நறுப஧னரிட஬ாம். 

  முள஫கள் 

 File->Rename 

 ய஬து சுட்டிப் ப஧ாத்தான் கிளிக் பெய்து ->Rename 

 F2 ப஧ாத்தாள஦ கிளிக் பெய்தல் 

 பி஫கு புதின ப஧னளபத் தட்டச்சு பெய்க 

஧குதி – இ : சிறுவி஦ாக்கள் 

1. விண்வடாஸ் இனக்க அளநப்பின் பெனல்஧ாடுகள் னாளய ? 

 ஧னன்஧ான்வ஧ாடுகள஭ இனக்குயதற்கு. 

 புதின ஧னன்஧ான்வ஧ாடுகள஭ நிறுவுயதற்கு. 

 யன்ப஧ாருள்கள஭ வந஬ாண்ளந பெய்யதற்கு. 

 வகாப்பு வந஬ாண்ளந பெனல்஧ாடுகள஭ பெய்யதற்கு. 

 கணிப்ப஧ாறியின் திளபயிள஦ நாற்றி அளநக்க. 

2. நறுசுமற்சி ப஧ட்டிளன ஧ற்றி எரு குறிப்பு யளபக. 

 நறுசுமற்சி பதாட்டி ஋ன்஧து, ஧ன஦பால் நீக்கப்஧ட்ட வகாப்பு அல்஬து வகாப்புள஫கள், 

தற்காலிகநாக  வெமிக்கப்஧டும் சி஫ப்பு வகாப்புள஫னாகும்.  

 அழிக்கப்஧ட்ட வகாப்புகள஭ மீட்படடுக்க இது மீண்டும் எரு யாய்ப்ள஧ யமங்குகி஫து.  

 நறுசுமற்சித் பதாட்டியிலுள்஭ வகாப்புகள் நட்டும் வகாப்புள஫கள஭  மீட்படடுக்காநல் இனக்க 

முடினாது. 
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 நறுசுமற்சி பதாட்டியிலுள்஭ அள஦த்ளதயும் மீட்படடுக்க , Restore all ஋ன்஫ ஧ணிக் குறிளனக் 

கிளிக் பெய்னவும். 

 நறுசுமற்சி பதாட்டியிலுள்஭ அள஦த்ளதயும் நிபந்தபநாக அழிக்க, “Empty Recycle bin” ஋ன்஫ 

஧ணிக் குறிளனக் கிளிக் பெய்னவும். 

3. விண்வடாஸ் ென்஦ல் திளபக் கூறுகள஭ப் ஧ற்றி குறிப்பு யளபக. 

 தள஬ப்புப்஧ட்ளட: தி஫ந்துள்஭ ஆயணத்தின் ப஧னரும், ஧னன்஧ாட்டின் ப஧னரும் வதான்றும் 

 ஧ட்டிப்஧ட்ளட: தள஬ப்பு ஧ட்ளடயின் கீழ் பு஫ம் ஧ட்டிப்஧ட்ளட காணப்஧டும் 

 ஧ணித்த஭ம்:  உளபளனத் தட்டச்சு பெய்யும் ஧குதி ஧ணித்த஭ம் ஆகும் 

 உரு஭ல் ஧ட்ளட: பெங்குத்தாகவும், கிளடநட்டநாகவும் உரு஭ பெய்னப் ஧னன்஧டுகி஫து. 

 மூள஬கள் நற்றும் ஋ல்ள஬கள்: விண்வடாஸில் அ஭ளய நாற்றி அளநக்க. 

4. எரு வகாப்புளபளன உருயாக்கும் இபண்டு யழிமுள஫கள஭ ஋ழுதுக. 

    முள஫-1 

1. கம்ப்யூட்டர் குறும்஧டத்ளத தி஫க்கவும். 

2. விரும்பும் இனக்கிளன தி஫க்கவும். 

3. File - > New -> Folder கிளிக் பெய்க. 

4. New Folder ஋஦ புதின வகாப்புள஫ தா஦ளநயாக உருயாகும். 

5. வகாப்புள஫யின் ப஧னளபத் தட்டச்சு பெய்து, Enter ப஧ாத்தாள஦ அழுத்தவும் 

   முள஫-2 

1.திளபமுகப்பில் சுட்டியின் ய஬து ப஧ாத்தாள஦க் கிளிக் பெய்து New->Folder-ளன கிளிக் 

பெய்க 

2. ப஧னரிடப்஧டாத எரு New Folder வகாப்புள஫ வதான்றும். 

3. வகாப்புள஫யின் ப஧னளபத் தட்டச்சு பெய்து, Enter ப஧ாத்தாள஦ அழுத்தவும் 

5. பயட்டுதல் நற்றும் ஥கப஬டுத்தல்- க்குப் உள்஭ வயறு஧ாடுகள் னாளய ? 

பயட்டுதல் ஥கப஬டுத்தல் 

வகாப்பு அல்஬து வகாப்புள஫கள஭ மூ஬ 

இடத்திலிருந்து புதின இடத்திற்கு ஥கர்த்தப்஧டும் 

வகாப்பு அல்஬து வகாப்புள஫களிம் பிபதிளன புதின 

இடத்திற்கு ஥கப஬டுக்கப்஧டும் 

Edit->Cut       Ctrl+X 

ய஬து சுட்டி ப஧ாத்தாள஦ அழுத்தி -> Cut 

Edit->Copy     Ctrl+C 

ய஬து சுட்டி ப஧ாத்தாள஦ அழுத்தி -> Copy 

஧குதி – ஈ : ப஥டுவி஦ாக்கள் 

1. விண்வடாஸ் இனக்க அளநப்பின் ஧஬யளகனா஦ ஧திப்புகள஭ வியரி. 

  விண்வடாஸ் 1.x (1985) 

 16 பிட்டுகளில் GUI நற்றும் சுட்டி அறிமுகம் பெய்னப்஧ட்டது. 

  விண்வடாஸ் 2.x  (1987) 

 ென்஦ல் திளப சிறிதக்குதல், அல்஬து ப஧ரிதக்குதல் யெதி நற்றும் கட்டுப்஧ாட்டு ஧஬கம் 

உருயாக்கப்஧ட்டது, 

  விண்வடாஸ் 3.x (1992) 

 விண்வடாஸ்-ல் “஧ல்஧ணி கருத்துரு” அறிமுகம். 

 256 யண்ணங்கள஭ ஆதரித்து அதி஥வீ஦ வதாற்஫ம் அளிக்கி஫து. 

  விண்வடாஸ் 95 (1995) 

 பதாடக்க ப஧ாத்தன், ஧ணிப்஧ட்ளட, விண்வடாஸ் ஋க்ஸ்ப்வ஭ாபர் நற்றும் பதாடக்கப்஧ட்டி 

அறிமுகம் 

 32 பிட் பெனலி அறிமுகம் 

  விண்வடாஸ் 98 (1998) 

 இனக்க அளநப்புடன் எருங்கிளணந்த இளணன உ஬வி அறிமுகம். 

 விண்வடாஸில் விள஭னாட்டுகள் வநம்஧டுத்தப்஧ட்டது 

 Plug and Play அறிமுகம் 

  விண்வடாஸ் NT 

 யள஬னளநப்பில் வெளயனகம் வ஧ால் யடியளநக்கப்஧ட்டது 

  விண்வடாஸ் Me (2000) 

 தானினங்கு கணிப்ப஧ாறி ஧ரிவொதித்தல் நற்றும் மீட்புக் கருவிகள் அறிமுகப்஧டுத்தப்஧ட்ட஦. 
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  விண்வடாஸ் 2000 (2000) 

 யணிகவநளெக் கணினி நற்றும் நடிக் கணினிகளில் இனக்க அளநப்஧ாக வெளயனாற்றினது. 

  விண்வடாஸ் XP 2001 

 64 பிட் பெனலி அறிமுகம் 

 விண்வடாஸ் வதாற்஫ம் நற்றும் ஧ணித்த஭ம் வநம்஧டுத்தப்஧ட்டது.  

  விண்வடாஸ் Vista 2006  

 விண்வடாஸ் வதாற்஫ம் வநம்஧டுத்தப்஧ட்டது.  

  விண்வடாஸ் 7 2009 

 கணிப்ப஧ாறி பதாடங்குதல் வ஥பம் வநம்஧டுத்தப்஧ட்டது.  

  விண்வடாஸ் 8 2012 

 வயகநா஦ பெனல்஧ாடு 

 பதாடக்க ப஧ாத்தான் நீக்கப்஧ட்டது 

 ஧ல் அடுக்கு பெனலி, திட நிள஬ இனக்கிகள், பதாடுதிளப அறிமுகம் 

  விண்வடாஸ் 10 2015 

 பதாடக்க ப஧ாத்தான் வெர்க்கப்஧ட்டது 

 என்றுக்கும் வநற்஧ட்ட திளப முகப்பு 

2. எரு வகாப்பு அல்஬து வகாப்புளபளன வதடிக் கண்டுபிடிக்கும் ஧ல்வயறு யழிமுள஫கள஭ வி஭க்குக. 

  வகாப்பு அல்஬து வகாப்புள஫ளனக் கண்டுபிடிக்க 

1. Start ப஧ாத்தாள஦ கிளிக் பெய்னவும், பதாடக்க ஧ட்டியின் களடசியில் Search ப஧ட்டி 

காணப்஧டும். 

2. வதர்ந்பதடுக்கப்஧ட வயண்டின வகாப்பு அல்஬து வகாப்புள஫யின் ப஧னளப Search ப஧ட்டி - ல் 

தட்டச்சு பெய்க.  

3. குறிப்பிடப்஧ட்ட ப஧னரிலுள்஭ வகாப்பு அல்஬து வகாப்புள஫கள் திளபயில் வதான்றும்.   

4. வகாப்பு அல்஬து வகாப்புள஫ளன கிளிக் பெய்து தி஫க்க஬ாம். 

5. Search ப஧ட்டிக்கு வநவ஬ “See more results” ஋ன்஫ வதர்ளயக் கிளிக் பெய்து, Search Results 

உளபனாடல் ப஧ட்டியின் மூ஬ம், வகாப்பு அல்஬து வகாப்புள஫கள஭ வதடித் தி஫க்க஬ாம். 

   வகாப்பு அல்஬து வகாப்புள஫ளன கம்ப்யூட்டர் ஧ணிக்குறி மூ஬ம் வதடுதல். 

1. கம்ப்யூட்டர் ஧ணிக்குறிளன திளப முகப்பில் வதர்வு பெய்க அல்஬து Start ஧ட்டி மூ஬ம் வதர்வு  

பெய்க. 

2. கம்ப்யூட்டர் யட்டு இனக்கி(Disk Drive) ஋ன்஫ திளப, வநல் ய஬து மூள஬யில் வதான்றும்.அதில் 

Search  box வதர்வு உள்஭து.  

3. அதில் வகாப்பு அல்஬து வகாப்புள஫யின் ப஧னளப தட்டச்சு பெய்க.  

4. குறிப்பிட்ட ப஧னரில் வதாடங்கும் அள஦த்து வகாப்பு அல்஬து வகாப்புள஫கள஭க் காட்டும். 

5. வகாப்பு அல்஬து வகாப்புள஫ளன தி஫க்க அதள஦ கிளிக் பெய்னவும். 

3. விண்வடாஸ் இனக்க அளநப்பில் குருக்கு யழி ஧ணிக்குறிகள஭ உருயாக்கும் பெனல் முள஫ளன  

     வி஭க்குக. 

 வயள஬ளனத் தானினங்கினாக நாற்றுயதற்கு அடிக்கடி ஧னன்஧டும் வகாப்புகள் நற்றும் 

வகாப்புள஫களின் குறுக்கு யழி ஧ணிக்குறிகள஭ உருயாக்கி, அளத முகப்புத் திளபயில் 

ளயக்க஬ாம். 

 திளப முகப்பில் வகாப்பு அல்஬து வகாப்புள஫யின் குறுக்கு யழிளனத் வதர்ந்வதடுக்கவும்.  

 ய஬து கிளிக் பெய்னவும். எரு வநல்மீட்புப் ஧ட்டி வதான்றும். அதிலிருந்து Send to ->Desktop 

(Create Shortcut) ஋ன்஫ வதர்ளய கிளிக் பெய்க. 

 விண்வடாஸ் திளபமுகப்பில், வகாப்பு அல்஬து வகாப்புள஫யின் குறுக்குயழி ஧ணிக்குறி 

வதான்றும். 

஧ாடம் - 6  பொற்பெனலி 

஧குதி – ஆ : குறுவி஦ாக்கள் 

1. உங்கள் ஆயணத்தில் ஧டங்கள஭ ஋வ்யாறு வெர்ப்஧ாய்?  

 ஧டம் வெர்க்க வயண்டி இடத்தில் பெருகும் புள்ளிளனக் ளயக்கவும். 

 Insert → Picture → From file  கட்டள஭ளனத் வதர்வு பெய்னவும். உளபனாடல் ப஧ட்டி வதான்றும்.  

 வதளயனா஦ ஧டத்ளத வதர்வு பெய்து open ப஧ாத்தாள஦ கிளிக் பெய்னவும்.  

 வதர்வு பெய்னப்஧ட்ட ஧டம் ஆயணத்தில் வெர்க்கப்஧ட்டிருக்கும். 
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2. ஏ஧ன் ஆஃபிஸ் ளபட்டரில் உள்஭ ஧ல்வயறு பதாகுப்புகள் னாளய? 

 ஏ஧ன் ஆஃபீஸ் ளபட்டர் 

 ஏ஧ன் ஆஃபிஸ் வ஧ஸ் 

 ஏ஧ன் ஆஃபீஸ் கால்க் 

 ஏ஧ன் ஆஃபிஸ் இம்ப்பபஸ் 

 ஏ஧ன் ஆஃபீஸ் ட்பா 

 ஏ஧ன் ஆஃபீஸ் ஧ார்மு஬ா 

3. ளபட்டரில் தானினங்கு உளப (Auto Text) ஋ன்஫ால் ஋ன்஦?  

 Auto text -ல் ொவி அல்஬து ொவிச் வெர்நா஦த்ளதப் ஧னன்஧டுத்தி உளப அட்டயளண, 

யளப஧டம் வ஧ான்஫யற்ள஫ உருயாக்க஬ாம்.  

 ஋டுத்துக்காட்டு:  

o 'TamiNadu' ஋ன்஫ யார்த்ளதளன எவ்பயாரு முள஫யும் தட்டச்சு பெய்யதற்கு ஧தி஬ாக "tn" 

நற்றும் F3 அழுத்தி஦ால் "Tamilnadu" ஋ன்று திளபயில் வதான்றும், 

4. அட்டயளணயில் சிற்஫ள஫கள஭ ஋வ்யாறு இளணப்஧ாய்?  

 என்஫ாக இளணக்கப்஧ட வயண்டின சிற்஫ளபகள஭த் வதர்வு பெய்ன ய஬து கிளிக் பெய்து      

cell → merge வதர்வு பெய்ன஬ாம்.  

 அல்஬து ஧ட்டி ஧ட்ளடயிலுள்஭ Table → Merge cells ஋ன்஫ கட்டள஭ளனத் வதர்ந்பதடுக்க஬ாம். 

5. தனியுரிநம் ப஧ற்஫ பநன்ப஧ாருள் நற்றும் தி஫ந்த மூ஬ பநன்ப஧ாருள் ஧ற்றின வயறு஧ாடுகள஭  

    ஋ழுதுக. 

தனியுரின பநன்ப஧ாருள் தி஫ந்த மூ஬ பநன்ப஧ாருள் 

தனாரிப்பு நிறுய஦த்தின் அனுநதி இல்஬ாநல் 

஥கப஬டுக்கவயா, ஧கிபவயா முடினாது.  

வதளயக்வகற்஧ ஧னன்஧டுத்து஧யர்கள் 

வதளயனா஦ நாற்஫ங்கள஭ச் பெய்ன஬ாம். 

஧ணம் பெலுத்தி ஧னன்஧டுத்த வயண்டும்.  இ஬யெநாக கிளடக்கும்.  

஋.கா : Windows, Adobe photoshop  ஋.கா : Linux, Open office   

஧குதி – இ : சிறுவி஦ாக்கள் 

1. ஥கர்த்தல் நற்றும் ஥கப஬டுத்தல் ஧ற்றின வயறு஧ாடுகள஭ ஋ழுதுக. 

஥கர்த்தல் ஥கப஬டுத்தல் 

மூ஬ உளபளன இ஬க்கில் ஥கர்த்தும் மூ஬ உளபளன இ஬க்கு நிர்ணயிக்கப்஧ட்ட 

இடத்தில் ஧டிபனடுக்கும். 

஥கர்த்தலுக்குப்பின், நட்டுவந உளப இருக்கும். இ஬க்கில் ஥கப஬டுத்தபின், மூ஬ இடத்திலும், 

இ஬க்கிலும் உளப காணப்஧டும். 

2. ஧க்க அளநவுகள் ஋த்தள஦ யளகப்஧டும்? 

 ஧க்க அளநவு இபண்டு யளகப்஧டும், அளய 

i) ஧க்கயாக்கு யடியம்  

ii) நீ஭யாக்கு யடியம் 

3. அட்டயளணயில் யரிளெகள் நற்றும் ப஥டுயரிளெகள஭ ஋வ்யாறு வெர்க்க஬ாம்? 

 யரிளெ நற்றும் ப஥டுயரிளெகள஭ உருயாக்க அட்டயள஭யில் வதளயனா஦ இடத்தில் ய஬து 

கிளிக் பெய்னவும்.  

 யரிளெளன உருயாக்க Row → Insert ளனக் கிளிக் பெய்னயும் அல்஬து ப஥டுயரிளெளன 

உருயாக்க Column → Insert ளனக் கிளிக் பெய்னயும்.  

 எரு உளபனாடல் ப஧ட்டி வதான்றும்,    

 OK ப஧ாத்தாள஦க் கிளிக் பெய்வும். 

4. ஆயணத்ளத வெமிக்கக் கூடின ஧ல்வயறு யழிகள் னாளய? 

ஆயணத்ளதச் வெமித்தல் 

 File → Save (அல்஬து) File → Save As (அல்஬து) Ctrl +S 

 ஆயணத்ளத வெமிக்கும் இடத்ளத வதர்வு பெய்ன வயண்டும்.  

 அள஦த்து ஆயணங்களும் தா஦ளநயாகவய விண்வடாஸில் உள்஭ Documents 

வகாப்புள஫யில் வெமிக்கப்஧டும்.  

 ஆயணத்தின் ப஧னளப Filename உளபப் ப஧ட்டியில் தட்டச்சு பெய்ன வயண்டும்.  

கடவுச் பொல்லுடன் ஆயணத்ளத வெமிப்஧து: 
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 கடவுச் பொல்ள஬க் பகாண்டு  வெமிக்க “save with password" ஋ன்று கிளிக் பெய்தபின் 

"save" ப஧ாத்தாள஦ அழுத்தவும்.  

 "set password" ப஧ட்டி உடவ஦ வதான்றும்.   

 கடவுச் பொல்ள஬ தட்டச்சு பெய்னவும், உறுதிப்஧டுத்த "confirm password" ஋ன்஫ ப஧ட்டியில் 

மீண்டும் கடவுச் பொல்ள஬ தட்டச்சு பெய்னவும். OK ப஧ாத்தாள஦ கிளிக் பெய்னவும். 

5. உளபயில் யரி இளடபயளிளன நாற்றும் யழிகள் ஧ற்றி ஋ழுதுக,  

 யரி இளடபயளி ஋ன்஧து, எரு ஧த்தியின் எரு யரிக்கும் நற்ப஫ாரு யரிக்கும் இளடவன உள்஭ 

அ஭ளய தீர்நானிக்கும் ப஥டுக்ளக இளடபயளினாகும். 

    யழி 1: 

 Edit → Select All கட்டள஭ளனப் ஧னன்஧டுத்தி முழு ஆயணத்ளதயும் வதர்வு பெய்க.  

 Format → Paragraph 

    யழி 2:  

 யரி இளடபயளி அளநக்க, அந்த ஧த்தியின் யரி, யார்த்ளத அல்஬து பொற்ப஫ாடளப வதர்வு 

பெய்னவும். 

 single, 1.5 அல்஬து Double வ஧ான்஫ ஌வதனும் யரி இளடபயளிளனத் வதர்வு பெய்ன஬ாம்.  

    யழி 3:  

 Indents & Spacing பதாகுதிளனக் கிளிக் பெய்னவும். 

 Line Spacing யளகயிழு ஧ட்டியில் வதளயனா஦ யரி இளடபயளிளனத் வதர்வு பெய்து Ok 

ப஧ாத்தாள஦க் கிளிக் பெய்க, 

஧குதி – ஈ : ப஥டுவி஦ாக்கள் 

1. ளபட்டரில் ஧க்க ஏபங்கள஭ நாற்றும் யழிகள஭ப் ஧ற்றி ஋ழுதுக.  

 ஧க்கத்தின் ஏபங்கள஭ நாற்஫ அல்஬து அளநக்க ஏ஧ன் ஆபிஸ் ளபட்டரில் இரு யழிகள் 

உள்஭஦. 

i) ரூ஬ரின் (Ruler) மூ஬ம் 

ii) Page Style உளபனாடல் ப஧ட்டி மூ஬ம் 

   1) ரூ஬ரின் உதவியுடன் ஧க்கத்தின் ஏபங்கள஭ நாற்஫ 

 ரூ஬ரின் நங்க஬ாக உள்஭ ஧குதிகவ஭ ஏபங்க஭ாகும்.  

 சுட்டியின் சுட்டிளனச் ொம்஧ல் நி஫ப்஧குதிக்கும் பயள்ள஭ நி஫ ஧குதிக்கும் இளடவன ளயக்க 

வயண்டும். 

 சுட்டினா஦து இரு தள஬ பகாண்ட அம்புக்குறினாக நாறும். 

 சுட்படலியின் இடது பு஫ ப஧ாத்தாள஦ அழுத்திக் பகாண்வட ஏபங்கள் மீது ஥கர்த்தி, 

வதளயனா஦ இடத்தில் அழுத்துதள஬ விடுவிக்க வயண்டும். 

 புதின ஏபங்கள் அளநயும். 

    2) Page Style உளபனாடல் ப஧ட்டியின் மூ஬ம் ஏபங்கள஭ நாற்஫  

 ஧க்கத்தில் ஌வதனும் ஏரிடத்தில் சுட்படலியின் ய஬து ப஧ாத்தாள஦ கிளிக் பெய்தால் வநல் 

மீட்புப் ஧ட்டி வதான்றும் அதில் Page பதாகுதிளனத் வதர்வு பெய்னவும்.  

 Margins ப஧ட்டியில் இடது, ய஬து, வநல் நற்றும் கீழ் ஏபங்களுக்கு உரின நதிப்ள஧ தட்டச்சு 

பெய்னவும். 

 Ok ப஧ாத்தாள஦ கிளிக் பெய்னவும். 

2. தள஬ப்பு நற்றும் அடிக்குறிப்பு ஋ன்஫ால் ஋ன்஦? இயற்றில் ஋வ்யாறு ஧க்க ஋ண்கள஭ வெர்ப்஧ாய்?. 

தள஬ப்பு: 

 தள஬ப்பு ஋ன்஧து எரு ஧க்கத்தின் வநல் ஧குதிளனக் குறிக்கும் 

அடிக்குறிப்பு: 

 அடிக்குறிப்பு ஋ன்஧து ஧க்கத்தின் கீழ் ஧குதிளனக் குறிக்கும். 

஧க்க ஋ண்கள஭ புகுத்த பின்யரும் யழிமுள஫கள் :  

 பெருகும் புள்ளிளன அடிக்குறிப்பில் பகாண்டு ளயக்கவும். 

 Insert → Fields → Page Number வதர்ந்பதடுக்கவும். 

 ொம்஧ல் நி஫ பின்பு஬த்தில் ஧க்க ஋ண்கள் வதான்றும். 

 ொதாபணநாக, ஧க்க ஋ண்கள் 1,2,3... ஋஦த் வதான்றும் ஋ண் ஧ாணிளன நாற்஫ ஧டிகளின் 

யரிளெளனச் பெய்ன முடியும். 

 ஧க்க ஋ண்கள் வதான்஫ பெருகும் புள்ளிளன ளயக்கவும்,  
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 Format → Page ஋ன்஫ கட்டள஭ளன வதர்வு பெய்தால் Page style உளபனாடல் ப஧ட்டி வதான்றும், 

 Page பதாகுதிளனத் வதர்ந்பதடுக்கவும், 

 Format கீழி஫ங்கு ஧ட்டிப்ப஧ட்டிளனத் வதர்ந்பதடுக்கவும்.  

 விரும்பின ஧ாணிளனத் வதர்ந்பதடுத்து, Ok ப஧ாத்தாள஦க் கிளிக் பெய்னவும். 

3. ஏ஧ன் ஆஃபீஸ் ளபட்டரில் எரு பொல்ள஬ வதடி நற்ப஫ாரு பொல்஬ாக நாற்றும் யழிகள஭ப் ஧ற்றி 

஋ழுதுக.  

 Edit →    Find →    Replace அல்஬து Ctrl + F கிளிக் பெய்னவும். 

 Find & Replace உளபனாடல் ப஧ட்டி வதான்றும்,  

வயண்டின பொல் அல்஬து உளபளனத் வதடி நாற்றுயதற்கா஦ யழிகள்: 

1. Search for ப஧ட்டியில் வதட வயண்டின பொல்ள஬ தட்டச்சு பெய்னயும், 

2. Find ப஧ாத்தாள஦ கிளிக் பெய்தவுடன், வதடல் பதாடங்கி யார்த்ளதயின் முதல் இருப்பிடத்தில் 

உனர்த்திக் காட்டப்஧டும். 

3. உனர்த்திக் காட்டப்஧ட்ட பொல்ள஬ நட்டும் நாற்றியிடுயதற்கு Replace ப஧ாத்தாள஦ கிளிக் 

பெய்னவும். 

4. Find All கிளிக் பெய்தால், ஆயணத்தில் பொல்஬ா஦து அளணத்து இடத்திலும் காட்டப்஧டும்.  

5. Replace All ப஧ாத்தாள஦ கிளிக் பெய்தால் யார்த்ளத நாற்஫ப்஧ட்டிருக்கும். 

6. உளபனாடல் ப஧ட்டியில் உள்஭ Match case வதர்வு பெய்தால் ப஧ரின நற்றும் சிறின யடிவி஬ா஦ 

஋ழுத்துக்கள஭ தனித்தனினாக வயறு஧டுத்த முடியும். 

7. Whole Words Only ஍ வதர்வு பெய்தால் அந்த யார்த்ளதளன நட்டும் வதடும்.  

8. Close ப஧ாத்தாள஦ கிளிக் பெய்னவும். 

4. ளபட்டரில் ஧க்க யடிவூட்டல் ஧ற்றி விரியாக ஋ழுதுக. 

 பொற்பெனலியின் எரு முக்கின ஧ணி ஧க்க யடிவூட்ட஬ாகும். 

 ஧க்க யடிவூட்டல் ஋ன்஧து ஧க்கத்தின் ஏபம், ஧க்க ஋ண், ஧க்க அளநப்பு, தள஬ப்பு நற்றும் 

அடிக்குறிப்பு வ஧ான்஫ ஧க்கத்தின் ஧ண்புகள஭ யடிவூட்டல் பெய்யதாகும். 

 ஧க்க அ஭ளய நாற்஫ 

 ளபட்டரில் எரு ஧க்க அ஭வு A4 அச்சிடும் தாளின் அ஭யா஦ 8.5 ×11" பகாடாநிள஬னாக 

இருக்கும். 

 ஧க்க அ஭ளய நாற்றுயதற்கா஦ ஧க்கத்ளத வதர்வு பெய்ன வயண்டும். 

 Format →    Page ஋ன்஫ கட்டள஭ளனத் வதர்வு பெய்னவும். 

 Page பதாகுதிளனக் கிளிக் பெய்னயும்.  

 Paper format குழுவில் A4, Legal வ஧ான்஫ யடியூட்டல் வதர்வுகளிலிருந்வதா அல்஬து Width 

நற்றும் Height ஋ன்஫ விருப்஧த்ளத ஧னன்஧டுத்தி ஧க்க அ஭ளய நாற்஫஬ாம். 

இபண்டு யளகனா஦ ஧க்க அளநவுகள் உள்஭஦: 

i) ஧க்கயாக்கு யடியம் 

 ஆயணத்தின் அக஬ம் அதன் நீ஭த்ளத விட ப஧ரிதாக இருந்தால் ஧க்கயாக்கு யடியம் 

஋஦ப்஧டும்.  

 பதாழில்முள஫ புளகப்஧டங்கள், அளமப்பிதழ்கள் வ஧ான்஫யற்றிற்கு இந்த அளநவு மிகவும் 

஧னனுள்஭தாக உள்஭து. 

ii) நீ஭யாக்கு யடிவும் 

 பகாடாநிள஬னாக எரு ஆயணத்தின் ஧க்களந஬ா஦து நீ஭யாக்கில் இருக்கும்.  

 இந்த அளநவில் ஆயணத்தின் நீ஭ம் அதன் அக஬த்ளத விட ப஧ரிதாக இருக்கும்.  

 புத்தகங்கள் பெய்தித்தாள்கள் ப஧ாதுயாக இந்த யடியத்தில் அச்சிடப்஧டும். 

 

஧ாடம் - 7  ஏ஧ன் ஆஃபீஸ் கால்க்-ல் வயள஬ பெய்தல் 

஧குதி – ஆ : குறுவி஦ாக்கள் 

1. ஏ஧ன் ஆஃபீஸ் கால்க் ல் ஋த்தள஦ யளகனா஦ கருவிப்஧ட்ளடகள் உள்஭து?  

 ஏ஧ன் ஆஃபீஸ் கால்க்-ல் மூன்று கருவிப் ஧ட்ளடகள் உள்஭஦. அளய, 

o பெந்தபக் கருவிப்஧ட்ளட  

o யடிவூட்டல் கருவிப்஧ட்ளட 

o யாய்஧ாட்டு ஧ட்ளட 
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2. நுண்ணள஫ச் சுட்டி ஋ன்஫ால் ஋ன்? 

 அட்டயளணத்தாள் முழுயதும் ஥கர்த்தக் கூடின பெவ்யக யடிவி஬ா஦ ப஧ட்டி வ஧ான்஫ 

அளநப்பு "நுண்ணள஫ சுட்டி" ஋ன்று அளமக்கப்஧டுகி஫து. 

3. ஏ஧ன் ஆஃபிஸ் கால்க் - ள் உளப பெனற்குறிளனப் ஧ற்றி குறிப்பு யளபக. 

 ஏ஧ன் ஆஃபீஸ் கால்கில் & ஋ன்஫ குறியீடு உளப பெனற்குறினாகும்.  

 இபண்டு அல்஬து அதற்கு வநற்஧ட்ட உளபகள஭ என்஫ாக வெர்க்க இந்த பெனற்குறி 

஧னன்஧டுகி஫து.  

 இபண்டு உளபகள஭ என்஫ாக வெர்த்தல் "உளப இளணத்தல்" ஋஦ப்஧டும். 

 கட்டள஭ அளநப்பு :  

o முதல் உளப உள்஭ நுண்ணள஫ & இபண்டாம் உளப உள்஭ நுண்ணள஫. 

4. கால்கில் எரு யாய்஧ாட்ளட உருயாக்குயதற்கா஦ ப஧ாது கட்டள஭ அளநப்ள஧ ஋ழுதுக. 

 = நுண்ணள஫ முகயரி-1 <பெனற்குறி> நுண்ணள஫ முகயரி-2 

5. ஥கப஬டுத்தல், பயட்டுதல் நற்றும் எட்டுயதற்கா஦ குறுக்கு யழி ொவி வெர்நா஦ங்கள் னாளய? 

 குருக்குயழி ொவி  ஧னன் 

Ctrl+C   - ஥கப஬டுத்தல் 

Ctrl+X   - பயட்டுதல் 

Ctrl+V   - எட்டுயதல் 

6. எரு நுண்ணள஫யிலுள்஭ தபவுகள஭ ஧திப்஧ாய்வு பெய்ன முடியுநா? ஆம் ஋னில் ஋வ்யாறு?  

 ஆம், ஥ாம் நுண்ணள஫யிலுள்஭ தபவுகள஭ ஧திப்஧ாய்வு பெய்ன஬ாம். 

 விளெப்஧஬ளகளனப் ஧னன்஧டுத்தி, நுண்ணள஫ளனத் வதர்ந்பதடுக்கவும். 

 F2 ப஧ாத்தாள஦ அழுத்தவும், நற்றும் சுட்டிளன நுண்ணாள஫யின் இறுதியில் ளயக்கவும். 

 விளெப்஧஬ளகயிலுள்஭ அம்புக்குறி ப஧ாத்தாள஦ ஧னன்஧டுத்துயதன் மூ஬ம் 

நுண்ணள஫யிலுள்஭  உளபக்கு ஥கர்த்த஬ாம். 

7. Insert cells உளபனாடல் ப஧ட்டியிலுள்஭ வதர்வுகள் னாளய?  

 Insert cells உளபனாடல் ப஧ட்டியில் ஥ான்கு விருப்஧த் வதர்வுகள் உள்஭஦. அளய, 

o Shift cells down  

o Shift cells right 

o Entire row  

o Entire column 

8. ப஧ாருத்துக: 

 அ பயட்டுதல், ஥கப஬டுத்தல் நற்றும் எட்டுதல் 1    தனித்த நுண்ணள஫ 

 ஆ நுண்ணள஫ச் சுட்டி    2   நிள஬ளநப்஧ட்ளட 

 இ வதர்ந்பதடுப்பு நிள஬    3   பெந்தாக் கருவிப்஧ட்ளட 

 ஈ $A$5      4   இனங்குகா஬ம் 

 

 விளட: அ → 3, ஆ→  4,இ → 2,ஈ→1 

9. யளபயுறுக்க 

   i) உளப பெனற்குறி 

   ii) அட்டயளண பெனலியில் யரிளெ நற்றும் ப஥டுயரிளெ  

  உளப பெனற்குறி: 

 ஏ஧ன் ஆஃபீஸ் கால்கில் & ஋ன்஫ குறியீடு உளப பெனற்குறினாகும். 

 இபண்டு அல்஬து அதற்கு வநற்஧ட்ட உளபகள஭ என்஫ாக வெர்க்க இந்த பெனற்குறி 

஧னன்஧டுகி஫து. 

 இபண்டு உளபகள஭ என்஫ாக வெர்த்தல் "உளப இளணத்தல்" ஋஦ப்஧டும்.  

 கட்டள஭ அளநப்பு: முதல் உளப உள்஭ நுண்ணள஫ & இபண்டாம் உளப உள்஭ நுண்ணள஫. 

  அட்டயளண பெனலியில் யரிளெ நற்றும் ப஥டுயரிளெ: 

 அட்டயளணத் தாள், எரு குறிப்பிட்ட ஋ண்ணிக்ளகயி஬ா஦ யரிளெகள஭யும் 

ப஥டுயரிளெகள஭யும்  பகாண்டிருக்கும்.  

 எவ்பயாரு ப஥டுயரிளெயும் A, B, C, D.....AA, AB AC,.... ஋ன்஫ யளகயில் ப஧னரிடப்஧ட்டிருக்கும்  

 யரிளெகள் எவ்பயான்றுக்கும் 1,2,3, ஋஦ ஋ண்ணிடப்஧ட்டிருக்கும்.. 
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10. ஥கப஬டுத்து எட்டுதல் நற்றும் பயட்டி எட்டுதல் வயறு஧டுத்துக 

஥கப஬டுத்து எட்டுதல் பயட்டி எட்டுதல் 

எரு நுண்ணள஫யில் உள்஭ தபவு நற்ப஫ாரு  

நுண்ணள஫க்கு ஥கப஬டுத்து 

அனுப்஧ப்஧டுகி஫து. 

எரு நுண்ணள஫யில் உள்஭ தபவு நற்ப஫ாரு 

நுண்ணள஫க்கு பயட்டி அனுப்஧ப்஧டுகி஫து. 

 

தபவு இரு நுண்ணள஫களிலும் இருக்கும்.  தபவு எரு நுண்ணள஫யில் நட்டும் ஧ார்க்க முடியும்.  

குறுக்கு யழி: Ctrl + C குறுக்கு யழி: Ctrl + X 

஧குதி – இ : சிறுவி஦ாக்கள் 

1. ஏ஧ன் ஆஃபீஸ் கால்க் - குறிப்பு யளபக. 

 ஏ஧ன் ஆஃபிஸ் கால்க் எரு பிப஧஬நா஦ தி஫ந்த மூ஬ அட்டயளணச் பெனலி ஆகும். இதள஦  

தற்வ஧ாது அ஧ாச்சி நிறுய஦ம் ஧பாநரித்து யருகி஫து. 

 கால்க் ஋ன்஧து ஏ஧ன் ஆஃபிஸ் பதாகுப்பில் உள்஭ அட்டயளண பெனலினாகும்.  

 அட்டயளண பெனலில் ஋ந்த விதநா஦ தபவுகள஭யும் உள்ளீடாகக் பகாடுத்து பென஬ாக்கம் 

பெய்து, பயளியீட்ளடப் ப஧஫ முடியும்.  

 வநலும் "஋ன்஦ ஋னில் ஧குப்஧ாய்வு" முள஫யின் மூ஬ம் ஌வதனும் எரு தபளய மீண்டும் தட்டச்சு 

பெய்னாநல், நாற்஫ம் நட்டும் பெய்தால் அயற்றின் பயளியீடுகள் ஋வ்யாறு நாறுகி஫து ஋ன்஧ளத 

஋ளிதாக ஧ார்க்க முடியும்.  

2. கால்க்-ல் ப஥டுயரிளெ நற்றும் நுண்ணள஫கள஭ வெர்த்தல் ஧ற்றி ஋ழுதுக. 

ப஥டுயரிளெகள஭ வெர்த்தல்:  

 எரு புதின ப஥டுயரிளெளன வெர்க்கும் வ஧ாது, வெர்க்கப்஧டும் ப஥டுயரிளெ ஥டப்பு 

ப஥டுயரிளெக்கு இடது ஧க்கத்தில் வெரிக்கப்஧டும். 

 ஥டப்பு ப஥டுயரிளெ ஋ன்஧து ஋ந்த ப஥டுயரிளெயில், நுண்ணள஫ச் சுட்டி உள்஭வதா, அந்த  

ப஥டுயரிளெளனக் குறிக்கும். 

கால்க்-ல் அட்டயளணத்தாளில், ஋ங்கு வயண்டுநா஦ாலும் எரு புதின ப஥டுயரிளெளன வெர்க்க 

முடியும்.  

 ஧டிநிள஬ 1: ஋ந்த ப஥டுயரிளெயில் எரு புதின ப஥டுயரிள஦ வெர்க்கப்஧ட வயண்டுவநா, 

அந்த ப஥டுயரிளெயின் ப஧னரில் கிளிக் பெய்து, அதள஦ வதர்ந்பதடுத்துக் பகாள்஭வும். 

 ஧டிநிள஬ 2: வதர்ந்பதடுக்கப்஧ட்ட ப஥டுயரிளெயின் ப஧னரில் சுட்டிளன ளயத்து, ய஬து 

கிளிக் பெய்னவும். இப்வ஧ாது எரு வநல்மீட்பு ஧ட்டிப் ஧ட்ளட வதான்றும். 

 ஧டிநிள஬ 3: வதான்றும் வநல்மீட்பு ஧ட்டிப்஧ட்ளடயிலிருந்து "Insert columns" ஋ன்஫ 

கட்டள஭ளன வதர்வு பெய்னவும். இப்வ஧ாது எரு புதின ப஥டுயரிளெ ஥டப்பு ப஥டுயரிளெக்கு 

இடது ஧க்கத்தில் வெர்க்கப்஧ட்டிருக்கும். 

நுண்ணள஫கள஭ வெர்த்தல்: 

 ஌ற்க஦வய உள்஭ நுண்ணள஫களுக்கு இளடவன எரு புதின நுண்ணள஫ளன வெர்க்க, 

நுண்ணள஫யின் வநல் ய஬து கிளிக் பெய்னயும்.   

 இப்வ஧ாது வதான்றும் வநல் மீட்பு ஧ட்டியிலிருந்து "Insert" கட்டள஭ளன கிளிக் பெய்னவும். 

 இப்வ஧ாது "Insert cells" உளபனாடல் ப஧ட்டி வதான்றும்.  

3. Backspace நற்றும் Delete ப஧ாத்தான்கள஭ ஧னன்஧டுத்தி தபவுகள஭ அழித்தள஬  வயறு஧டுத்துக 

Backspace Delete 

Backspace ப஧ாத்தான் பெருகும் புள்ளிக்கு 

இடதுபு஫நாக உள்஭ ஋ழுத்ளத நீக்கும். 

Delete ப஧ாத்தான் பெருகும் புள்ளிக்கு 

ய஬துபு஫நாக உள்஭ ஋ழுத்ளத நீக்கும். 

4. ஌வதனும் மூன்று யடிவூட்டல் வதர்வுகள஭ ஋ழுதுக.  

 தடிந஦ாக்குதல் (Ctrl + B)  

 ொய்பயழுத்தாக்குதல் (Ctrl+I)  

 அடிக்வகாடிடுதல் (Ctrl+ U)  

5. நுண்ணள஫ A1, A2 நற்றும் A3-யில் முள஫வன 34, 65 நற்றும் 89.ஆகினளய உள்஭து. அதன்  

  ெபாெரிளன காணும் யாய்஧ாட்ளட ஋ழுதுக.  

அ) AVERAGE (A1:A3) (அல்஬து) 

ஆ) (A1+ A2+ A3)/3 
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஧குதி – ஈ : ப஥டுவி஦ாக்கள் 

1. கால்க் - ல் ப஥டுயரிளெயின் அக஬த்ளத ஋வ்யாறு நாற்஫஬ாம் ஋ன்஧ளத வி஭க்குக.  

 யழிமுள஫ 1: Alt + → அல்஬து alt + → ஋ன்஫ ொவிக் வெர்நா஦ம் மூ஬ம் ப஥டுயரிளெ 

அக஬த்ளதக் கூட்ட஬ாம் அல்஬து குள஫க்க஬ாம். இந்த முள஫ளன ப஥டுயரிளெயின் 

அக஬த்தின் நதிப்பு முன்஦வப பதரினவில்ள஬ ஋னில் ஧னன்஧டுத்த஬ாம். 

 யழிமுள஫ 2: ப஥டுயரிளெயின் அக஬த்தின் நதிப்பு முன்஦வப ெரினாகத் பதரிந்தால்,  

format → column → widths கட்டள஭ளனப் ஧னன்஧டுத்தி நாற்஫஬ாம். Columnwidth ஋ன்஫ 

உளபனாடல் ப஧ட்டியில் width ப஧ட்டியின் அ஭விள஦ உள்ளிட்டு நாற்஫ம் பெய்ன வயண்டும். 

2. 5, 10, 20,. 2560 ஋ன்஫ ஋ண் யரிளெளன உருயாக்கும் யழிமுள஫ளன வி஭க்குக. 

஧டிநிள஬ 1: A1 : A10 ஋ன்஫ ஧பப்ள஧ வதர்வு பெய்னவும். 

஧டிநிள஬ 2: Edit → Fill → Series ஋ன்஫ கட்டள஭ளனத் வதர்வு பெய்னவும். 

஧டிநிள஬ 3: Growth ஋ன்஫ Series type ஍ வதர்வு பெய்னவும்.  

஧டிநிள஬ 4: Start value ப஧ட்டியில் 5 Stop value ப஧ட்டியில் 2560 நற்றும் Increment    

                    ப஧ட்டியில் உள்ளிட்டு ok ப஧ாத்தாள஦ அழுத்தி஦ால் 5, 10, 20,.... ஋ன்஫  

                    ஋ண் யரிளெளன உருயாக்க஬ாம். 

3. பின்யரும் அட்டயளணளன உற்று வ஥ாக்கவும். 

 

 
விளட:  

1. SUM (B5:E5) 

2. SUM (E2:E6) 

3. SUM (C5:D6) = (C5 +C6 + D5 + D6) 

4. AVERAGE (B2:B6) 

5. = (B6-E6) 

஧ாடம் - 8  நிகழ்த்துதல் 

஧குதி – ஆ : குறுவி஦ாக்கள் 

1. எரு சில்லு நற்றும் Slide Show க்கு உள்஭ வித்தினாெம் ஋ன்஦?  

 சில்லு: நிகழ்த்துதலில் எவப எரு ஧க்கத்ளதக் குறிப்஧து சில்லு ஆகும். 

 Slide Show: Slide Show ஋ன்஧து பதாடர் சில்லுகள஭ ஧னன்஧டுத்தி ஧ல்லூடக ப஧ாருட்கள஭ 

உருயாக்கப் ஧னன்஧டுகி஫து.  

2. ஋த்தள஦ உள்஭ளநந்த சில்லு த஭யளநப்புகள் Impress-ல் அடங்கியுள்஭஦? 

 12 உள்஭ளநந்த சில்லு த஭யளநப்புகள் Impress-ல் அடங்கியுள்஭஦.  

3. நிகழ்த்துதள஬ ஋ன்஦பயன்று புரிந்து பகாண்டீர்கள்? 

 நிகழ்த்துதல் ஋ன்஧து ஥ாம் நிள஦க்கும் குறிக்வகாள஭ நற்஫யர்கள் அள஦யரும் ஋ளிளநனா஦ 

முள஫யில் புரிந்து பகாள்஭வும்.  
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 ப஧ரும்஧ான்ளநனா஦ நிகழ்த்துதல் பநன்ப஧ாருட்கள் பதாடர் சில்லுகள஭ப் ஧னன்஧டுத்தி 

஧ல்லூடக ப஧ாருட்கள஭ உருயாக்கப்  ஧னன்஧டுகி஫து. 

4. Impressல் யார்ப்புரு - யளபனறு. 

 Template புதின யடியளநப்பு நற்றும் ஧ரிந்துளபக்கா஦, முன்஦வப யடியளநக்கப்஧ட்டயற்ள஫ 

அறிமுகப்஧டுத்தும். அதன் மூ஬ம் ஋ளிதாக  நிகழ்த்துதள஬ உருயாக்க஬ாம். 

5. சில்லுவின் அளநப்஧ால் ஋ன்஦ புரிந்து பகாள்கிறீர்கள்?  

 ஸ்ள஬டு த஭யளநப்புகள், எரு ஸ்ள஬டில் வதான்றும் அளணத்து உள்஭஧ங்கங்களுக்கும் 

யடியளநத்தல், ப஧ாருத்துதல் நற்றும் எதுக்கிட ப஧ட்டிகள஭க் பகாண்டுள்஭஦. 

 எதுக்கீடு ப஧ட்டிகள் தள஬ப்புகள் உளப, அட்டயளணகள், யளப஧டங்கள், Smart Art,கிபாபிக்ஸ், 

஧டங்கள், ஆர்ட், வீடிவனாக்கள், நற்றும் எலிகள் வ஧ான்஫ உள்஭டக்கத்ளத பகாண்டுள்஭து. 

஧குதி – இ : சிறுவி஦ாக்கள் 

1. Impress-ல் ஧ன஦ர்கள஭ ஈர்க்கும் யளகயில் ஋த்தள஦ யளகனா஦ காட்சிகள் யமங்கப்஧டுகின்஫஦?  

 Impress ல் ஧ன஦ர்கள஭ ஈர்க்கும் யளகயில் ஍ந்து யளகனா஦ காட்சிகள் யமங்கப்஧டுகின்஫஦. 

அளய, 

o Normal view  

o Outline view 

o Handout view  

o Slide Sorter view 

o Notes view 

2. நிகழ்த்தல் பநன்ப஧ாருள஭ னார் ஧னன்஧டுத்துகி஫ார்கள்? ஌ன்?  

 நற்஫யர்களுக்கு தங்க஭து கருத்ளத ஋ளின முள஫யில் பகாண்டு வெர்க்க விரும்புகி஫யர்கள் 

நிகழ்த்துதல் ஧னன்஧டுத்துகி஫ார்கள்.  

 விற்஧ள஦ பிபதிநிதிகள், யாடிக்ளகனா஭ர்களுக்கு தங்கள் ப஧ாருள஭ப் ஧ற்றி ஋டுத்துளபக்க 

஧னன்஧டுத்த஬ாம்.  

 ஆசிரினர்கள் தங்கள் நாணயர்களுக்கு ஧ல்லூடக ப஧ாருட்கள் மூ஬ம் ஧ாடத்ளத ஋ளிதில் 

கற்பிக்க஬ாம்.  

 ப஧ாதுயாக கூட்டத்தி஦ர் நத்தியில் சி஫ப்஧ாக உளபனாற்஫ ஧னன்஧டுத்த஬ாம். 

3. Slide Sorter காட்சி நற்றும் அதன் முக்கினத்துயத்ளத யளபனறுக்கவும்.  

 Slide Sorter காட்சி ஋ல்஬ா சில்லுகள஭யும் சிறின யடியத்தில் ஧ார்க்க உதவுகி஫து. 

 சில்லு காட்சியின் வ஥பத்ளத குறிப்பிடவும், இபண்டு சில்லுகளுக்கு இளடவனனா஦ 

஧ரிநாற்஫த்ளத வெர்க்கவும் ஧னன்஧டுகி஫து. 

 இளதப் ஧னன்஧டுத்தி ஋ல்஬ா வயள஬யும் சில்லுவின் பதாகுப்பிவ஬ா அல்஬து தனி சில்லுவிவ஬ா 

பெய்ன஬ாம்.  

 எரு யரிளெயில் சில்லுவின் ஋ண்ணிக்ளகயில் நாற்஫ம் பெய்ன஬ாம். 

4. Normal view ஋ன்஫ால் ஋ன்஦? 

 தனித்தனி சில்லுளய உருயாக்கவும் ஧திப்பிக்கவும் உதவுகி஫து. 

 சில்லுளய யடினளநக்க வெர்க்க யளபகள஬ ஧டம் நற்றும் அளெவு ஧டங்கள஭ வெர்க்கப் 

஧னன்஧டுகி஫து. 

 Normal View வில் சில்லுளய யடியளநக்கும் ஧குதியில் சில்லுளய வெர்க்கும் யெதி உள்஭து. 

 உ஭வி ஧ட்டிளன ஧னன்஧டுத்திவனா அல்஬து யழிகாட்டி ஧ட்டிளன ஧னன்஧டுத்திவனா கிளிக் 

பெய்து பகாண்டுயரும் யெதி உள்஭து. 

5. Impress - ல் தி஫ம்஧ட வி஭க்கத்ளத உருயாக்குயது ஋ப்஧டி சில்லு நாற்று விள஭வுகளுக்கு  

    உதவுகி஫து?. 

 Transition effect நிகழ்த்துதலில் சி஫ப்பு விள஭வுகள஭ ஌ற்஧டுத்த உதவுகி஫து. 

 சில்லு நுளமயும் வ஧ாவதா அல்஬து பயளிவனறும் வ஧ாவதா சி஫ப்பு விள஭வுகள஭ ஌ற்஧டுத்தி 

஧ார்ளயனா஭ர்கள஭ கயப஬ாம். 

 இது சில்லுவிள஦ வநம்஧டுத்த உதவுகி஫து 
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஧குதி – ஈ : ப஥டுவி஦ாக்கள் 

 
விளட: 

அ) ஸ்ளடல் ஧னன்஧டுத்தி வதளயனா஦ யடியளநப்ள஧ முதன்ளந சில்லுவில் பெய்ன   

    வயண்டும். இது அள஦த்து சில்லுகளுக்கும் பதாடரும். வதளயப்஧ட்டால், குறிப்பிட்ட   

    சில்லுவின் அளநப்ள஧ நட்டும் நாற்றிக் பகாள்஭஬ாம். 

ஆ) வி஭க்கக் காட்சியின் எரு பிபத்திவனக ஥கள஬ Handout மூ஬ம் அச்சிட்டு  

    ஧ார்ளயனா஭ர்களுக்கு யமங்க஬ாம். 

இ) ஧டம் பெருக வயண்டின இடத்தில் சுட்டிளன ளயத்து Insert → Picture → From file வதர்வு  

   பெய்னவும். 

ஈ) முழு ென்஦வில் நிகழ்த்தள஬ பதாடங்கி ஧ார்ளயனா஭ர்களுக்கு யமங்கி஦ால்   

   வி஭க்கத்ளதக் காண்பிப்஧தற்கு மிகவும் ப஧ாருத்தநா஦தாக இருக்கும் ஋ன்று  

   கருதுகிவ஫ன்.  

உ) சில்லுவிற்கு சி஫ப்பு விள஭வுகளும், சில்லுவிலுள்஭ வதளயனா஦ ப஧ாருட்களுக்கு சி஫ப்பு  

   விள஭வுகள஭ ஌ற்஧டுத்தி சி஫ப்஧ாக நிகழ்த்தள஬ யமங்க஬ாம். 

2. விற்஧ள஦னா஭ர் த஦து தனாரிப்புகள஭ வநம்஧டுத்துயதற்கு எரு வி஭க்கக்காட்சிளன ஋ப்஧டி  

     வி஭க்க஬ாம் ஋ன்஧ளத வி஭க்கவும்.  

 யாடிக்ளகனா஭ர்களுக்கு தங்கள் ப஧ாருள஭ப் ஧ற்றி ஋டுத்துளபக்க ஧னன்஧டுத்த஬ாம். 

 ப஧ாருள஭ ஧ற்றின கூடுதல் தகயல்கள஭ ஧ல்லூடக ப஧ாருட்கள் மூ஬ம் அதன் 

பெனல்஧ாடுகள஭ யாடிக்ளகனா஭ர்களுக்கு ஋ளிதாக வியரிக்க முடியும். 

 ஧ல்லூடக ப஧ாருட்கள் மூ஬ம் தகயல்கள஭ யமங்கும்வ஧ாது யாடிக்ளகனா஭ர்கள் 

திருப்தினளடந்து ப஧ாருள஭ யாங்க யழியகுக்கும். 

3. சிய஧ா஬ன் த஦து ஧ள்ளியின் யருடாந்திப விமாவில் எரு வி஭க்கக் காட்சிளன உருயாக்கி஦ார்.  

    வி஭க்கக் காட்சிக்கா஦ 5 நிமிடங்களுக்கு முன், அயர் ஧ள்ளியின் ப஧னர் தயறு ஋ன்஧ளத  

     கயனித்தார். அந்த காட்சி 30 சில்லுகளில் வதான்றுகி஫து. எவப எரு ஧டத்தில் உள்஭ இந்த தயள஫  

     அள஦த்து சில்லுகளிலும் அயர் ஋வ்யாறு நறு஧ரிசீ஬ள஦ பெய்ன முடியும்? 

 முதன்ளந சில்லுவில் நாற்஫ம் பெய்தால் அளய அள஦த்து சில்லுகளுக்கும் நாற்஫ம் 

ப஧ற்றுவிடும்.  

 ஧ள்ளியின் ப஧னளப முதன்ளந சில்லுவில் நாற்஫ம் பெய்யதன் மூ஬ம் அயற்ள஫ அள஦த்து 

சில்லுயிலும் நாற்஫ம் பெய்ன இனலும். 

4. யார்ப்புருக்கள் ஧னன்஧டுத்தலில் சி஬ ஥ன்ளநகள் ஧ட்டினலிடு,  

 புதின நிகழ்த்தள஬ ஋ளிதாக உருயாக்க஬ாம். வ஥பம் மிச்ெநாகும். 

 யார்ப்புரு பின்஦ணி, ஋ழுத்துயளக, அ஭வு, யண்ணங்கள், அவதவ஧ான்று யார்ப்புருவிற்கு 

ப஧ாருத்தநா஦ புல்஬ட் குறியீடுகள் வ஧ான்஫யற்ள஫ யளபனறுக்கும். 

 நிகழ்த்தள஬ சி஫ந்த வதாற்஫த்தில் உருயாக்க உதவும். 
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஧ாடம் - 9 : இளணனத஭ம் நற்றும் மின்஦ஞ்ெல் - ஏர் அறிமுகம் 

஧குதி - ஆ : குறுவி஦ா  

1. இளணனத்தில் உள்஭ இபண்டு முக்கினநா஦ ப஥றிமுள஫களின் ப஧னளபக் கூறு.  

 TCP - Transmission Control Protocol  

 IP - Internet Protocol  

2. யள஬னளநப்பு ஋ன்஫ால் ஋ன்஦? 

 யள஬னளநப்பு ஋ன்஧து என்வ஫ாபடான்று இளணக்கப்஧ட்ட ொத஦ங்களின் பதாகுப்஧ாகும். 

3. ICANN அளநப்பின் ஧ணி னாது? 

 ICANN ஋ன்஫ அளநப்பு இளணனத஭ முகயரிப் ஧திளய நிர்யகிக்கின்஫து.  

 ஌ற்க஦வய ஧திவு பெய்னப்஧ட்ட ப஧னர் மீண்டும் ஧திவு பெய்னப்஧டாநல் இருக்க உதவுகி஫து. 

4. வதடு ப஧ாறி ஋ன்஫ால் ஋ன்஦?  

 வதடு ப஧ாறிகள் ஋ன்஧து வதளயனா஦ தகயள஬ உ஬க஭ாவின யள஬யிலிருந்து (www) வதடி 

தருயதற்காக யடியளநக்கப்஧ட்டுள்஭ பநன்ப஧ாரு஭ாகும். ஋.கா:Yahoo,Google, Hotbot 

5. யள஬ உ஬ாவி ஋ன்஫ால் ஋ன்஦? 

 யள஬ உ஬வினா஦து யள஬த்த஭த்ளதவனா, யள஬ப்஧க்கத்ளதவனா அணுகப் ஧னன்஧டுகி஫து. 

 ஋.கா: Chrome, Firefox, Safari etc., 

6. URL - முகயரியில் உள்஭ கூறுகள் னாளய ? 

 
7. யள஬த்த஭ம் ஋ன்஫ால் ஋ன்஦? 

 யள஬த்த஭ம் ஋ன்஧து யள஬ப்஧க்கங்களின் பதாகுப்஧ாகும். 

 இளணனத஭நா஦து முதப்புப்஧க்கம், நிறுய஦ம் ஧ற்றின தகயல்கள், பதாடர்புபகாள்஭, 

வெளயகள் நற்றும் ஧஬ யள஬ப்஧க்கங்கள஭க் பகாண்டிருக்கும். 

 இவ்யா஫ா஦ ஧க்கங்கள் இளணந்தது யள஬த஭ம் ஋஦ப்஧டும். 

8. மின்஦ஞ்ெலில் உள்஭ CC நற்றும் BCC ஋ன்஫ால் ஋ன்஦? 

 CC (Carbon Copy) பு஬நா஦து வ஥படி அணுகல் இல்஬ாத ப஧று஥ர்கள஭ குறிப்பிட உதவுகின்஫ 

எரு விருப்஧த் வதர்வு ஆகும்.  

 BCC (Blind Carbon Copy) இதுவும் CC வ஧ான்஫வத ஆகும். இதில் ப஧று஥ர்கள் ஧ட்டினல் 

இபகசினநாக ளயக்கப்஧டும்.  ஋஦வய, இப்பு஬த்தில் மின்஦ஞ்ெல் ப஧று஧யர், வயறு 

னாருக்பகல்஬ாம் இது அனுப்஧ப்஧ட்டுள்஭து ஋ன்஧ளத காண முடினாது.  

9. நிள஬னா஦ யள஬ப்஧க்கம் ஋ன்஫ால் ஋ன்஦? 

 ஥ாம் ஧ார்ளயயிடும் வ஧ாபதல்஬ாம் யள஬த஭நா஦து அவத நிள஬யிவ஬வன பதாடர்ந்து 

இருக்கும். இவ்யளக யள஬த஭ங்கள் நிள஬னா஦ யள஬த஭ங்கள் ஋஦ப்஧டும். 

 ஋.கா: எரு சிறின யணிக நிறுய஦த்தின் யள஬த஭ம், ஧ள்ளியினுளடன யள஬த஭ம். 

10. நா஫க்கூடின யள஬ப்஧க்கம் ஋ன்஫ால் ஋ன்஦?  

 ப஧ாதுத்வதர்வு முடிவுகள், நுளமவுத் வதர்வு முடிவுகள் வ஧ான்஫யற்ள஫ பயளியிடும் 

யள஬த்த஭நா஦து ஧ன஦ர் உள்ளிடும் ஧திபயண்ணிற்கு நாறும்.  

 இது வ஧ான்஫ யள஬த்த஭ங்கள் நா஫க்கூடினளய ஋஦ப்஧டும். 

 ஋.கா: அபசினுளடன யள஬த்த஭ம், நுளமவுத் வதர்வு முடிவுகள஭ பயளியிடும் யள஬த்த஭ம். 

11. மின்-அபொண்ளநயின் ஥ன்ளநகள் னாளய? 

 ஊமள஬க் குள஫த்தது. 

 அதிக பயளிப்஧ளடத்தன்ளந.  

 அதிகரித்த யெதி. 

 எட்டுபநாத்த பெ஬வில் குள஫ப்பு. 

 அபொங்கத்தின் விரியாக்கம். 
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12. ஃபிஷிங் (Phishing) ஋ன்஫ால் ஋ன்஦? 

 தனினார் ஧ற்றின தகயல்கள஭ப் ப஧஫ ளெ஧ர் குற்஫யாளிகள் வநாெடி முனற்சிகள் ஆகும்.  

 இளய மின்஦ஞ்ெல் வ஧ான்று யடியளநக்கப்஧ட்டிருக்கும்.  

 வநலும் ெட்டப்பூர்யநா஦ இடத்தில் இருந்து யந்தது வ஧ா஬ முகப்பில் வதாற்஫நளிக்கும். 

஧குதி - இ : ப஧ருவி஦ா  

1. TCP / IP ஋ன்஫ால் ஋ன்஦? 

 உ஬க஭ாவின யள஬ இளணனம், TCP/IP Transmission Control Protocol / Internet Protocol 

ப஥றிமுள஫ளனப் ஧னன்஧டுத்தி ஧ல்வயறு ஊடகங்கள் யழினாக தபவு ஧ரிநாற்஫த்ளத பெய்கி஫து.  

 IP எவ்பயாரு கணிப்ப஧ாறிக்கும் எரு முகயரிளன யமங்குகின்஫து. தனித்து அளடனா஭ம் 

காண உதவுகின்஫து. 

2. ஧கபள஬ (Hotspot) இளணன வெளய ஧ற்றி சிறுகுறிப்பு யளபக.  

 கம்பியில்஬ா குறும்஧பப்பு யள஬னளநப்ள஧ப் வ஧ான்று இளணன யெதிளன அணுக 

ொட்ஸ்஧ாட்ஸ் ஧னன்஧டுகி஫து. 

 Hotspots ொத஦நா஦து பவுட்டர் வ஧ால் பெனல்஧ட்டு இளணன வெளய யமங்கு஧யருடன் 

இளணப்ள஧ ஌ற்஧டுத்துகி஫து. 

 அது கம்பி இல்஬ா இளணப்பு முள஦ளனப் ஧னன்஧டுத்துகி஫து. மின்஦ணு ொத஦ங்கள் 

இளணனத்துடன் பதாடர்பு பகாள்஭ அல்஬து தகயல்கள஭ ஧ரிநாறிக்பகாள்஭ வபடிவனா 

அள஬கள஭ப் ஧னன்஧டுத்துகி஫து.  

 ொட்ஸ்஧ாட் இளணப்஧ா஦து ளகப்வ஧சி அடிப்஧ளடயிவ஬ா, யணிக அடிப்஧ளடயிவ஬ா 

இருக்க஬ாம் அல்஬து ப஧ாதுநக்களுக்கு இ஬யெநாகவயா கிளடக்க஬ாம்.  

3. வடப்டாகார்டு (Data Card) நற்றும் டாங்கில்ஸ் (Dongles) வயறு஧டுத்துக. 

வடட்டாகார்டு டாங்கில்ஸ் 

இது தபவுகள஭ வெமித்து ளயக்க ஧னன்஧டும். 

இது நீக்கக்கூடின மின்஦ணு அட்ளட ஆகும். 

கூடுதல் ஧ாதுகாப்ள஧ யமங்கும் 

நீக்கக்கூடின கூறுகள஭க் குறிக்கி஫து. 

வடட்டாகார்டு-ன் யளககள் 

Expansion card 

card or flash card 

Identification card 

யு.஋ஸ்.பி. டாங்கிளின் யளககள் 

Wifi டாங்கிள் 

Blue tooth 

Memory டாங்கிள் 

4. இளணனத்தில் இளணயதற்குப் ஧னன்஧டும் இபண்டு அணுகுமுள஫கள஭ கூறுக.  

   1) நள஫முக அணுகல் 

 வீடு நற்றும் அலுய஬கங்களில் ப஧ரும்஧ாலும் ஧னன்஧டும் யள஬னளநப்஧ாகும். 

 ஋.கா; கணிப்ப஧ாறினா஦து ஈதர்ப஥ட் அல்஬து ளயஃள஧ மூ஬நாக யள஬னளநப்புடன் 

இளணக்கப்஧ட்டு அந்த யள஬னளநப்஧ா஦து ADSL மூ஬நாக இளணனத்துடன் 

இளணக்கப்஧ட்டு இருக்கும். 

   2) வ஥படி அணுகல் 

 ஧னணத்தின் வ஧ாது இம்முள஫னா஦து ப஧ரும்஧ாலும் ஧னன்஧டும். 

 ஋.கா; அள஬வ஧சினா஦து அள஬வ஧சி 3G/4G யள஬னளநப்பு மூ஬நாக ப஧ாது ளயஃள஧ 

மூ஬நாக இளணனத்தில் இளணதல்.  

5. யள஬ உ஬ாவி நற்றும் வதடு ப஧ாறிகள் வயறு஧டுத்துக. 

யள஬ உ஬ாவி வதடு ப஧ாறிகள் 

யள஬ உ஬வினா஦து யள஬ த஭த்ளதவனா, 

யள஬ப் ஧க்கத்ளதவனா அணுக ஧னன்஧டுகி஫து.  

வதடுப஧ாறிகள் எரு குறிப்பிட்ட தகயள஬ வதட 

஧னன்஧டுகி஫து.  

இளணனத்ளத அணுகுயதற்கு யள஬ 

உ஬ாவினா஦து ஧னன்஧டுகி஫து.  

வதடுப஧ாறிகள஭ தி஫க்க யள஬ உ஬ாவி 

வதளயப்஧டுகி஫து. 

Internet Explorer, Chrome, Firefox நற்றும் Safari  Google நற்றும் Yahoo  

6. யள஬த்த஭ம், யள஬ப்஧க்கம் வயறு஧டுத்துக: 

யள஬த஭ம் யள஬ப்஧க்கம் 

஧஬ யள஬ ஆயணங்கள஭க் பகாண்டு யள஬ 

உ஬ாவினால் பயளிக்காட்டப்஧டும். 

எரு ஆயணத்ளதக் பகாண்டு யள஬ 

உ஬ாவினால் பயளிக் காட்டப்஧டுயது ஆகும். 

தனித்துயநா஦ க஭ப்ப஧னளபக் பகாண்டது. தனிப்஧ட்ட க஭ப் ப஧னருடன் ஧கிபப்஧டும் 
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என்று அல்஬து ஧஬ யள஬ப்஧க்கங்கள஭ 

பகாண்டது 

யள஬த்த஭த்ளத உருயாக்க உதவுகி஫து. 

 

7. நிள஬னா஦ யள஬ப்஧க்கத்திற்கும், நாறும் யள஬ப்஧க்கத்திற்கும் உள்஭ வயறு஧ாடு னாது? 

நிள஬னா஦ யள஬ப்஧க்கம் நாறும் யள஬ப்஧க்கம் 

யள஬ப்஧க்கத்தின் ப஧ாரு஭டக்கமும் வதாற்஫மும் 

நிள஬னா஦தாக இருக்கும். 

ப஧ாரு஭டக்கமும், வதாற்஫மும் இனக்க வ஥பத்தின் 

வ஧ாது நாறும்.  

நிள஬னா஦ யள஬ப் ஧க்கநா஦து தபவுத் த஭த்ளத 

உ஧வனாகிக்காது 

 

வி஦யல்க஭ால் நா஫க் கூடின ப஧ாரு஭டக்கத்ளத 

பகாண்ட யள஬ப் ஧க்கத்ளத தபவுத் த஭த்ளத 

஧னன்஧டுத்தி உருயாக்கும். 

நிள஬னா஦ யள஬ப் ஧க்கநா஦து 

வெளயனகத்தின் ஋ந்த ஧னன்஧ாட்டின் 

துளணயுமின்றி வ஥படினாக யள஬ உ஬ாவியில் 

இனங்கும். 

நா஫க்கூடின யள஬ப் ஧க்கநா஦து 

வெளயனகத்தின் ஧னன்஧ாட்டு நிபள஬க் பகாண்டு 

முடிளய பயளியிடுயதன் மூ஬ம் இனங்கும். 

நிள஬னா஦ யள஬ப் ஧க்கத்ளத உருயாக்குயது 

஋ளிது. 

நா஫க்கூடின யள஬ப் ஧க்கத்ளத உருயாக்க 

நிபயாக்கத்தி஫ன் வதளய. 

8. மின்஦ஞ்ெலின் ஥ன்ளநகள் னாளய? 

 இ஬யெ விநிவனாகம் 

 உ஬க஭ாவின விநிவனாகம் 

 உட஦டி விநிவனாகம் 

 வகாப்புகள஭ இளணத்தல் 

 நீண்ட கா஬ வெமிப்பு 

 சுற்றுச் சூமள஬ ஧ாதுகாத்தல் 

஧குதி -ஈ : ப஥டுவி஦ா 

1. ஌வதனும் 5 இளணன வெளயகள் ஧ற்றி வியரி.  

  1) ளகப்வ஧சி (Mobile) 

 ஧஬ ளகப்வ஧சி நற்றும் ஸ்நார்ட் வ஧ான் தனாரிப்பு நிறுய஦ங்கள் குபல் யழி அளமப்பு யெதியுடன் 

கூடின இளணன வெளயகள஭ யமங்குகின்஫஦.  

  2) DSL - DSL Digital Subscriber Line 

 இது இபண்டு தாமிபக்கம்பிக஭ால் ஆ஦ பதாள஬வ஧சி யடங்கள஭ இளணன இளணப்பிற்கு 

஧னன்஧டுத்துயதால் தளபயழி பதாள஬வ஧சி வ஧ா஬ பெனல்஧டுகி஫து.  

   3) பெனற்ளகக் வகாள் (Satellite) 

 பிபாட்வ஧ண்ட் இளணன இளணப்஧ா஦து யமங்கப்஧டாத சி஬ ஧குதிகளில் இளணன 

இளணப்ள஧யமங்க பெனற்ளகக் வகா஭ா஦து ஧னன்஧டுகின்஫து. 

   4) கம்பி இல்஬ா இளணப்பு (Wireless) 

 பதாள஬வ஧சி அல்஬து கம்பி யடம் இளணப்புகளுக்கு ஧தி஬ாக வபடிவனா அள஬கள் 

஧னன்஧டுகின்஫஦. 

 யள஬னளநப்பு விரிந்துள்஭ இடத்திற்குள் இளணன இளணப்ள஧ ஋ந்த இடத்திலிருந்தும், 

஋ப்வ஧ாதும் அணுகமுடியும், 

 வநாடத்தின் உதவியின் மூ஬மும் கம்பியில்஬ா இளணப்ள஧ அளநக்க முடியும். 

   5) யடம் (Cable) 

 யடங்கள் யழினாக வநற்பகாள்஭ப்஧டும் இளணன இளணப்஧ா஦து பிபாட்வ஧ண்ட் அளநப்ள஧ப் 

வ஧ான்஫து. 

 கம்பி யழி வநாடநா஦து இளணனத்ளத அதிவயகநாக அணுகுயதற்கு உதவுகி஫து. 

2) ஌வதனும் 5 இளணன ஧னன்஧ாடுகள் ஧ற்றி தகுந்த ஋டுத்துக்காட்டுடன் வியரி, 

    1) இளணன பதாள஬வ஧சி 

 இளணனம் மூ஬ம் யமங்கப்஧டும் வெளயகளுள் இளணனயழி பதாள஬வ஧சி ஋ன்஧து 

ப஧ாதுயா஦ வெளயனாகும். ஋.கா: Skype  

   2) வயள஬ வதடல் 

 இளணனத்தின் மூ஬ம் வயள஬ வதடும் வ஧ாது விளபயாகவும், ஧ல்வயறு துள஫களில் உள்஭ 

ப஧ரும் ஋ண்ணிக்ளகயி஬ா஦ காலிப்஧ணியிட வி஧பங்கள஭யும் ப஧஫ முடியும். ஋.கா: naukri.com. 
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   3) ஧ங்குச்ெந்ளத ஧ற்றின தகயல்கள஭ப் ப஧றுதல் 

 இளணனத்தின் மூ஬ம் வீட்டில் இருந்த஧டிவன நிறுய஦ங்களின் ஧ங்குகள஭ யாங்கவயா, 

விற்கவயா முடியும்.  ஋.கா; ndtvprofit.com 

   4) ஧னணங்கள் 

 சுற்று஬ா த஭ங்கள் ஧ற்றின வி஧பங்கள஭ எருயர் இளணனத்தின் மூ஬ம் வெகரிக்க முடியும்.  

 விடுமுள஫க்கா஬ சுற்று஬ாக்கள஭ முன் கூட்டிவன ஧திவு பெய்யது, ஋.கா: goibibo.com 

   5) ஆபாய்ச்சி 

 இ஬க்கின ஆய்வு ஧ற்றி இதழ்கள் இளணனத்தில் யமங்கப்஧டுகின்஫஦. 

3. ஧ாடப்புத்தகத்தில் தபப்஧ட்டுள்஭ யள஬ உ஬ாவிகள் தவிப ஌வதனும் 5 யள஬ உ஬ாவிகள் ஧ற்றி  

    வியரி. 

   1) கூகுள் குவபாம் 

 Google Chrome ஋ன்஧து Google உருயாக்கின குறுக்கு வநளட யள஬ உ஬ாவி.  

 உ஬ாவிக்கு Chrome OS ஋ன்஧து முக்கின அங்கநாகும். இது யள஬ ஧னன்஧ாடுகளுக்கு த஭நாக 

பெனல்஧டுகி஫து. 

   2) ஏவ஧பா 

 எவ஧பா ஋ன்஧து ஥ார்வய நிறுய஦நா஦ ஏவ஧பா பநன்ப஧ாரு஭ால் உருயாக்கப்஧ட்ட விண்வடாஸ், 

 Mac OS நற்றும் வி஦க்ஸ் இனக்க முள஫ளநகளுக்கா஦ எரு யள஬ உ஬ாவினாகும். 

   3) UC உ஬ாவி  

 இது எரு சீ஦ ளகவ஧சி கம்ப஧னியின் ஧ளடப்பு ஆகும். 

 UC Browser-ன் UC Web ஋ன்஧து Alibaba group - க்கு பொந்தநா஦து. 

   4) Mosaic 

 www நற்றும் இளணனத்தில் மிகவும் பிபசித்தி ப஧ற்஫ எரு யள஬ உ஬ாவினாகும்.  

 இது FTP நற்றும் NNTP நற்றும் Gopher ஋ன்஫ இளணன ப஥றிமுள஫கள஭க் பகாண்டது. 

   5) Dillo 

 இது எரு சிறின யள஬ உ஬ாவி, குறிப்஧ாக ஧ளமன அல்஬து பநதுயா஦ கணினி நற்றும் 

உட்ப஧ாதிக்கப்஧ட்ட அளநப்புகளுக்கு வ஥ாக்கம் பகாண்டது.  

 இது ஋ளின HTML/XHTML நற்றும் HTTP யழினாக ஧டங்கள஭ நட்டுவந ஆதரிக்கி஫து. 

4. இளணன உ஬ாவுதலில் பெய்ன வயண்டினளயயும், பெய்னக் கூடாததும் ஧ற்றி வியரி.  

 உங்கள் தனிப்஧ட்ட தகயள஬ பகாடுக்க வயண்டாம்.  

 தனிநள஫ அளநப்புகள஭ப் ஧னன்஧டுத்தி தாங்கள் ஧திவிடும் புளகப்஧டங்கள் நற்றும் 

பெய்திகள஭ ஥ண்஧ர்கள் நற்றும் உ஫வி஦ர்கள் நட்டுவந ஧ார்க்குநாறு பெய்ன வயண்டும்.  

 ஧ாதுகாப்பு நற்றும் தனிநள஫ அளநப்ள஧ ெரி஧ார்த்துக் பகாள்ளுதல் 

 உங்களுளடன கடவுச் பொல்ள஬ னாரிடமும் ஧கிபக் கூடாது.  

 அள஬ப் வ஧சியிள஦ ஧ாதுகாப்஧ாக ளயத்து இருத்தல் 

 அந்நினர்களுடன் ஆன்ள஬னிவ஬ா அல்஬து ஆஃப்ள஬னிவ஬ா பதாடர்பு பகாள்஭ வயண்டாம்.  

 ப஧ரினயர்களின் வ஧ச்ளெக் வகளுங்கள்: 

 ஧ாதுகாப்஧ற்஫ அல்஬து பதரிந்திருக்காத யள஬த் த஭ங்களில் கய஦முடன் இருங்கள் 

 நீங்கள் கிளிக் பெய்யும் இளணப்புகளில் கய஦நாக இருக்கவயண்டும்.  

 

஧ாடம் - 10 HTML - கட்டளநப்பு எத்துகள்

஧குதி - ஆ : குறுவி஦ா  

1. ெந்தினா எரு யள஬ப்஧க்கத்ளத உருயாக்கிக்பகாண்டிருக்கின்஫ாள். அயள் த஦து கணினியில்    

   HTML குறிமுள஫ளன உள்ளிட்டுக்பகாண்டிருக்கி஫ாள். இளடயிளடவன இளணன உ஬ாவியில்  

   REFRESH /RELOAD ப஧ாத்தாள஦ அழுத்திக்பகாள்கி஫ாள். காபணத்ளத வி஭க்குக. 

 HTML குறிமுள஫யில் பெய்யும் நாற்஫ங்கள஭, இளணன உ஬ாவியில் ஧ார்ளயயிட REFRESH 

/RELOAD ப஧ாத்தாள஦ அழுத்திக்பகாள்கி஫ாள். 

2. அளடவு எட்டுகளுக்கும், காலி எட்டுகளுக்கும் இளடவனனா஦ வயறு஧ாட்ளட எரு தகுந்த  

    ஋டுத்துக்காட்டுடன் வி஭க்குக. 

  அளடவு எட்டுகள் 

 பதாடக்க நற்றும் முடிவு எட்டுகள஭க் பகாண்டுள்஭ எட்டுகள். 

 ஋.கா: <html><body><title><p> 
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   காலி எட்டுகள் 

 பதாடக்க எட்டுகள஭ நட்டும் பகாண்டுள்஭ எட்டுகள். 

 ஋.கா: <br> <img> <hr> 

3. பின்யரும் HTML குறிமுள஫யில் உள்஭ பிளமனாது? 

<html> 

<my web page> 

<title> Welcome to my web page 

</head> 

</title> 

      விளட: 

<html> 

<head> 

 <title> My web page </title> 

</head> 

<body> 

 Welcome to my web page 

</body> 

</html> 

4. HTML நிபலில் குறிப்புகள஭(comments) ஋வ்யாறு யளபனறுப்஧ாய்? வி஭க்குக 

 யள஬ப்஧க்கத்ளதப் ஧ற்றி குறிப்புளபகள் யமங்கவும் அல்஬து யள஬ப்஧க்கத்தின் நிள஬ளனப் 

஧ற்றி சி஬ யளகனாக அளடனா஭ங்கள஭க் குறிப்஧தற்கும் comments எட்டா஦து ஧னன்஧டுகி஫து. 

 ப஧ாது யடியம்: <! வி஭க்க உளப> 

5. இளணன உ஬ாவியின் பின்பு஫ம் எரு உருயப்஧டத்ளத உள்ளிடும் யழிமுள஫ னாது? 

 யள஬ உ஬ாவியின் பின்஦ணினாகப் ஧டத்ளத அளநக்கப் ஧னன்஧டும் பதாடரினல், 

<body background="image name"> 

 உருயப்஧டநா஦து வயறு இடத்தில் வெமிக்கப்஧ட்டிருத்தால் முழுப் ஧ாளத ப஧னருடன் 

குறிப்பிடப்஧டல் வயண்டும். 

 ஋.கா: <body background="E:\Images\flower.gif"> 

஧குதி - இ : ப஧ருவி஦ா  

1. உடற்஧குதி எட்டினுள் ( Body) உள்஭ ஧ண்புக்கூறுகள் னாளய ? 

bgcolor  யள஬ உ஬ாவியின் பின்஦ணி நி஫த்ளத நாற்றினளநக்க. 

text உடற்஧குதியில் உள்஭ உளபயின் யண்ணத்ளத நாற்஫ 

background யள஬ உ஬ாவியின் பின்஦ணினாக உருயப்஧டம் அல்஬து நிமற்஧டம் அளநக்க 

leftmargin 

topmargin 

யள஬ உ஬ாவியின் வநல்஧க்கம் அல்஬து இடது ஧க்கம் ஏபத்திற்கு இளடபயளி 

அளநக்க. 

2. HTML எட்டினுள் உள்஭ ஧ண்புக் கூறுகள் னாளய ? 

 <html> எட்டா஦து இபண்டு ஧ண்புக் கூறுகள஭க் பகாண்டுள்஭து.  அளய dir நற்றும் lang. 

 dir - ஆயணத்தின் உளப திளெளனத் தீர்நானிக்க ஧னன்஧டுகி஫து. 

நதிப்புகள்: 

ltr இடமிருந்து ய஬ம் 

rtl ய஬மிருந்து இடம் 

 lang ஧ண்புக்கூ஫ா஦து மீவுளப ஆயணத்தில் ஧னன்஧டுத்தப்஧டும் பநாழிளன குறிக்கும்.  

நதிப்புகள்: 

ஆங்கி஬ம் – en 

தமிழ் – ta 

இந்தி – hi  

3. மூ஬க் குறிமுள஫ளன ஋வ்யாறு ஧ார்ளயயிடுயாய்? 

 ஧டி 1 : யள஬ உ஬ாவியில் சுட்டிளன ளயத்து ய஬து Click பெய்னவும். 

 ஧டி 2 : View Page Source / View Source ஋஦ வதர்வு பெய்னவும் அல்஬து Ctrl + U  ஋ன்று 

அழுத்தவும்.  



கணினி ஧னன்஧ாடுகள்                                                     28                                                                              முத஬ாம் ஆண்டு 

 

4. HTMLல் வகாப்புகள஭ வெமிக்கும் யழிமுள஫கள் னாளய? 

 ஧டி 1 : உளபப் ஧திப்஧ாள஦ தி஫க்கவும் 

 Windows7 : Start → All Programs →Accessories → Notepad 

 Linux : Applications → Accessories → Text Editor 

 ஧டி 2 : HTML குறிமுள஫ளன தட்டச்சு பெய்னவும். 

 ஧டி 3 : File → Save ஋ன்஫ யரிளெயில் சுட்டிளன இனக்குக அல்஬து CTRL + S ஋ன்஫ 

 ொவிச்வெர்நா஦த்ளத அழுத்துக. 

 ஧டி 4 : SaveAs உளபனாடல் ப஧ட்டினா஦து திளபயில் வதான்றும். File Name ஋ன்஫ 

 உளபப்ப஧ட்டியில் வகாப்பின் ப஧னருடன் .htm or .html ஋஦ பகாடுக்கவும். 

 SAVE ப஧ாத்தாள஦ Click பெய்னவும். 

 

஧ாடம்-11 : HTML உளப யடிவூட்டல், அட்டயளண உருயாக்குதல், ஧ட்டினல்கள் நற்றும் இளணப்புகள் 

஧குதி-ஆ : குறுவி஦ா  

1. (i) <strong> (ii) <em> எட்டுகள் ஧ற்றி குறிப்பு யளபக 

        (i) <strong> :   

 உளபளன தடித்த ஋ழுத்துக்களில் பயளிப்஧டுத்தும்.  

 ஋.கா. <strong> Welcome</strong> 

        (ii) <em> :  

 உளபளன ொய்ந்த ஋ழுத்துக்களில் பயளிப்஧டுத்தும்.  

 ஋.கா. <em> Welcome</em> 

2. <mark> எட்டின் ஧னன் னாது? 

 உளபளன உனர்த்திக் காட்டுயதற்கு ஧னன்஧டுகின்஫து. 

 ஋.கா: Welcome to <mark>My Page</mark> 

3. கீழ்காணும் ெநன்஧ாட்ளட HTML குறிமுள஫யில் ஋ழுதுக:   Pd = 25 – Q2 

<html> 

<head> 

<title>Equation</title> 

</head> 

<body> 

Pd=25-Q2 

</body> 

</html> 

4. font எட்டின் ஌வதனும் இபண்டு ஧ண்புக் கூறுகள஭ ஧ற்றி ஋ழுதுக. 

 face : ஋ழுத்துருக்கள஭ அளநக்கப் ஧னன்஧டுகி஫து. 

 size : ஋ழுத்து அ஭வுகள஭ அளநக்கப் ஧னன்஧டுகி஫து. 

 color: உளபக்கு யண்ணத்ளத அளநக்கப் ஧னன்஧டுகி஫து. 

5. கருப்ப஧ாருள் இளடபயளி ஋ன்஫ால் ஋ன்஦ ? 

 <hr> எட்டு கருப்ப஧ாருள் இளடபயளி ஋஦ப்஧டும். 

 இது காலி எட்டாகும். 

 யள஬ உ஬ாவியின் அக஬த்திற்கு இளணனாக எரு கிளடநட்ட யரிளன உருயாக்குகி஫து. 

6. புள்ளிகள் ஋ன்஫ால் ஋ன்஦ ? 

 புள்ளிகள் (Pixels) ஋ன்஧து கணிப்ப஧ாறி திளபயில் காட்சிகள஭த் வதாற்றுவிக்கும் புள்ளிகளுள் 

எரு சிறின புள்ளினாகும். 

7. HTML-ல் உள்஭ ஧ட்டினலின் யளககள் னாளய ? 

 யரிளெப்஧டுத்தப்஧ட்ட ஧ட்டினல்கள் 

 யரிளெப்஧டுத்தப்஧டாத ஧ட்டினல்கள் 

 யளபனள஫ ஧ட்டினல்கள் 

8. யரிளெப்஧டுத்தப்஧ட்ட ஧ட்டினள஬ ஋வ்யாறு உருயாக்குயாய் ? 

 ஋ண் அல்஬து அகப யரிளெப்஧ட்டினல் <OL> . . . </OL> ஋ன்஫ இளண எட்டுக஭ால் 

உருயாக்கப்஧டும், 

 <LI> . . . <LI/> எட்டா஦து ஧ட்டினலில் உருப்஧டிகள஭ வெர்க்க ஧னன்஧டுகி஫து. 
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 ஋.கா: 

<OL> 

<LI>Tamil</LI> 

<LI>English</LI> 

</OL> 

஧குதி-இ : ப஧ருவி஦ா 

1. கீழ்காணும் உளபளன அது பகாடுக்கப்஧ட்டுள்஭து வ஧ா஬வய யள஬ உ஬ாவியில் பயளிப்஧டுத்த  

   HTML குறிமுள஫ I am studying Computer Science Application. 

<html> 

<head> 

<title>My Page</title> 

</head> 

<body> 

I am studying Computer Science Application. 

</body> 

</html> 

2. <hr> எட்டின் ஧ண்புக் கூறுகள஭ ஧ற்றி வி஭க்கநாக ஋ழுதுக. 

 size - அ஭ளய அளநக்க 

 width - அக஬த்ளத அளநக்க 

 noshade - முப்஧ரிநாணத் வதாற்஫த் அளநக்க 

 color - யண்ணத்ளத அளநக்க 

3. அட்டயளணளன உருயாக்க ஧னன்஧டும் இளண எட்டுகள் னாளய ? 

 <table> - அட்டயளணளன உருயாக்க 

 <tr> - யரிளெளன யளபனறுக்க 

 <th> - ப஥டுயரிளெளன யளபனறுக்க 

 <caption> - தள஬ப்ள஧ யளபனறுக்க 

 <td> - சிற்஫ள஫யில் தபவிள஦க் குறிப்பிட 

4. https://www.w3schools.com ஋ன்஫ யள஬ த஭த்திற்கு HTML குறிமுள஫ மூ஬ம்  மீத்பதாத்க்வதாடுப்ள஧        

     உருயாக்குக. 

<html> 

<head> 

<title>My Page</title> 

</head> 

<body> 

<a href=" https://www.w3schools.com "> W3schools </a> 

</body> 

</html> 

5. <UL> நற்றும் <OL> எட்டுகள஭ வயறு஧டுத்துக. 

<UL> எட்டு <OL> எட்டு 

யரிளெப்஧டுத்தப்஧டாத ஧ட்டினல் (அல்஬து) 

புல்஬ட் ஧ட்டினல்கள஭ யளபனறுக்க. 

யரிளெப்஧டுத்தப்஧ட்ட ஧ட்டினல் (அல்஬து) ஋ண் 

யரிளெப் ஧ட்டினல்கள஭ யளபனறுக்க 

எட்டுடன் type ஧ண்புக்கூறு ஧னன்஧டுகி஫து எட்டுடன் type நற்றும் start ஧ண்புக்கூறு ஧னன்஧டுகி஫து 

உருப்஧டிகள் புல்஬ட் குறியீடுகள஭ 

முன்஦தாகக் பகாண்டிருக்கும் 

உருப்஧டிகள் ஋ண் அல்஬து அகப யரிளெப்஧டி 

஧ட்டினலிட்டுக் காட்டும். 

6. கீழ்காணும் அட்டயளணளன உருயாக்க HTML நிபல் ஋ழுதுக. 

 
<html> 

<head> 
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<title>My Table</title> 

</head> 

<body> 

<table> 

<tr> 

<td rowspan=2> A</td> 

<td> B </td> 

</tr> 

<tr> 

<td>C</td> 

</tr> 

</table> 

</body> 

</html> 

஧குதி -ஈ : ப஥டுவி஦ா 

1. கீழ்காணும் உளபளன பயளிப்஧டுத்த HTML நிபல் ஋ழுதுக. 

 
<html> 

<head> 

<title> Modern Atomic Theory</title> 

</head> 

<body bgcolor="yellow"> 

<h2>MODERN ATOMIC THEORY </h2> 

<b>The findings of modern atomic theory are given as follows:</b> <br> 

<ul> 

<li>An atom is the smallest particle which takes part in chemical reaction.</li> 

<li>An atom is considered to be a divisible particle.</li> 

<li>The atoms of the same element may not be similar in all respects. eg: 

Isotopes (<sub>17</sub>Cl<sup>35</sup>, 

<sub>17</sub>Cl<sup>37</sup>)</li> 

<li>The atoms of different elements may be similar in some respects. eg. Isobars 

(<sub>18</sub>Ar<sup>40</sup>, 

<sub>20</sub>Ca<sup>40</sup>)</li> 

</ul> 

</body> 

</html> 

2. அட்டயளணளன <table>எட்டுடன் ஧னன்஧டும் ஧ண்புக் கூறுகள஭ ஧ற்றி வி஭க்குக. 

     1. Cellspacing 

 சிற்஫ள஫களுக்கு இளடவன இளடபயளிளன அளநக்கப் ஧னன்஧டுகின்஫து.  

     2. Cellpadding 

 ப஧ாரு஭டக்கத்திற்கும் சிற்஫ள஫யின் ஋ல்ள஬களுக்கும் இளடவன இளடபயளிளன 

அளநக்கப் ஧னன்஧டுகி஫து.  

     3. Border: 

 ஋ல்ள஬ வகாடுகளின் தடிந஦஭ளய குறிக்க ஧னன்஧டுகின்஫து. நதிப்஧ா஦து பூஜ்னம் அல்஬ாத 

நதிப்஧ாக புள்ளிகளில் பகாடுக்கப்஧ட வயண்டும்.  
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     4. Bordercolor: 

 ஋ல்ள஬க் வகாடுகளுக்கு யண்ணத்திள஦ அளநக்கப் ஧னன்஧டுகின்஫து. 

     5. Align: 

 யள஬ உ஬ாவியின் ஜன்஦ல் திளபயில் அட்டயளணளன எழுங்குப்஧டுத்துகி஫து. 

     6. Bgcolor 

 பின்பு஫ யண்ணத்ளத அளநக்கப் ஧னன்஧டுகி஫து. 

     7. Height and Width 

 உனபத்ளதயும் , அக஬த்ளதயும் குறிக்க ஧னன்஧டுகி஫து.  

    ஋.கா: 

<table cellspacing=5 cellpadding=15 border=4 bordercolor=blue align=center bgcolor=yellow> 

3. தகுந்த HTML நிபலுடன் ஧ட்டினலின் யளககள஭ ஧ற்றி வி஭க்குக. 

 HTML-ல் மூன்று யளகனா஦ப் ஧ட்டினல்கள் உள்஭஦. 

1. யரிளெப்஧டுத்தப்஧ட்ட ஧ட்டினல்கள் 

2. யரிளெப்஧டுத்தப்஧டாத ஧ட்டினல்கள் 

3. யளபனள஫ ஧ட்டினல்கள் 

   1. யரிளெப்஧டுத்தப்஧ட்ட ஧ட்டினல்: 

 ஋ண் அல்஬து அகப யரிளெப்஧ட்டின஬ா஦து <OL> . . . </OL> ஋ன்஫ இளண எட்டுக஭ால் 

உருயாக்கப்஧டுகின்஫஦, 

 <LI> . . . <LI/> எட்டா஦து ஧ட்டினலில் உருப்஧டிகள஭ வெர்க்க ஧னன்஧டுகி஫து. 

      <OL> ஏட்டுடன் ஧னன்஧டுத்தப்஧டும் இபண்டு ஧ண்புக்கூறுகள்: 

1. Type - ஋ண்யரிளெயின் யளகயிள஦ நாற்றுயதற்கு  

2. Start - ஧ட்டின஬ா஦து ஋ந்த ஋ண்ணிலிருந்து அல்஬து ஋ழுத்திலிருந்து துயங்க வயண்டும்    

           ஋ன்஧ளதக் குறிக்க. 

<OL type=i start=5> 

<LI> Commerce </LI> 

<LI> Accountancy </LI> 

<LI> Economics </LI> 

<LI> Computer Application </LI> 

</OL> 

     2. யரிளெப்஧டுத்தப்஧டாத ஧ட்டினல் : 

 யரிளெப்஧டுத்தப்஧டாத ஧ட்டின஬ா஦து புல்஬ட் ஧ட்டினல்கள் ஋஦வும் அளமக்கப்஧டுகி஫து. 

 ஋ண்களுக்குப் ஧தி஬ாக சி஫ப்பு புல்஬ட் குறியீடுகள஭ முன்஦தாகக் பகாண்டிருக்கும். 

 யரிளெப்஧டுத்தப் ஧டாத ஧ட்டினல் ஆ஦து <UL>.......</UL>஋ன்஫ இளண எட்டுகளுக்குள் 

யளபனறுக்கப் ஧ட்டிருக்கும். 

 ஧ட்டினலில் உள்஭ எவ்பயாரு உருப்஧டியும் <LI> எட்டின் மூ஬ம் அறிவிக்கப்டும், 

     <UL> எட்டுடன் ஧னன்஧டுத்தப்஧டும் ஧ண்புக்கூறு:  

 type புல்஬ட் குறியீடுகளின் யளகளனக் குறிக்க உதவுகி஫து. Disc, square or circle ஋ன்஫ 

நதிப்ள஧ ஌ற்கும். 

<UL type= square> 

<LI> Tamil </LI> 

<LI> English </LI> 

<LI> Computer Application </LI> 

</UL> 

    3. யளபனள஫ப் ஧ட்டினல் : 

 ஧ட்டினல் உருப்஧டிக்கு முன்஦ால் குறியீவடா அல்஬து ஋ண் யரிளெக் குறியீவடா 

இல்஬ாநல் உருயாக்கப்஧டும் ஧ட்டினல்.  

 இம்முள஫யில் ஧ட்டினல் உறுப்புகள் இபண்டு ஧குதிகள஭க் பகாண்டுள்஭து. 

1. யளபனள஫த் தள஬ப்பு 

2. யளபனள஫ வி஭க்கம் 

 யளபனள஫ப் ஧ட்டின஬ா஦து <DL>.......</DL> ஋ன்஫ இளண எட்டுகளுக்குள் யளபனறுக்கப் 

஧ட்டிருக்கும் 
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 யளபனள஫த் தள஬ப்஧ா஦து <DT>.......</DT> எட்டுகளுக்குள் தபப்஧டல் வயண்டும் 

 யளபனள஫த் தள஬ப்பின் வி஭க்கநா஦து <DD>......</DD> எட்டுகளுக்குள் தபப்஧டல் 

வயண்டும். 

 ஋.கா : 

<DL> 

<DT> HTML:</DT> 

<DD> Hyper Text Mark up Language</DD> 

<DT>SGML:</DT> 

<DD>Standard Generalized Markup Language</DD> 

</DL> 

4. இளணப்பு ஋ன்஫ால் ஋ன்஦ ? இளணப்புகளின் யளககள஭ வி஭க்குக. 

 யள஬ ய஭ங்கள஭ இளணக்கப் ஧னன்஧டும் இளணப்பு HTML-ல் எரு முக்கின அம்ெநாகும்.  

 யள஬ ஆயணங்களுக்கு மீத்பதாடுப்புகள஭ உருயாக்க இளணப்பு ஧னன்஧டுகி஫து.  

 இளணப்பு இரு யளகப்஧டும். 

1. உள் இளணப்பு  

2. பயளி இளணப்பு . 

 HTML-ல் இளணப்புகள஭ உருயாக்குயதற்கு இபண்டு முக்கினக் கூறுகள் வதளய. 

 இளணக்கப்஧ட வயண்டின வகாப்பினுளடன ப஧னர் அல்஬து URL முகயரி. 

 இளணப்பிள஦ Click பெய்ன஧னன்஧டும் உளப இளணப்புகள஭ உருயாக்க ஥ங்கூப எட்டுடன் 

<A> அதன் HREF ஧ண்புக்கூள஫ப் ஧னன்஧டுத்த வயண்டும்.   

 HREF ஋ன்஧து "Hypertext Reference" ஋ன்஧தன் குறுக்கநாகும். 

    <A> ஏட்டின் பதாடரினல்: 

  <A href = "Web content path/URL"> Text - clickable link</A> 

    1. உள் இளணப்பு : 

 எவப ஆயணத்தில் இடம்ப஧ற்றுள்஭ குறிப்பிட்ட ஧குதிக்கு இளணப்புகள஭ உருயாக்குயது. 

 உள் இளணப்புகள஭ உருயாக்குயதற்கு <A> ஥ங்கூப ஏட்டுடன் Name ஧ண்புக்கூ஫ா஦து 

஧னன்஧டுகி஫து. 

 ஥ங்கூப எட்டின் Name ஧ண்புக்கூ஫ா஦து, ஆயணத்தின் உள்வ஭ இருக்கும் குறிப்பிடப்஧ட்ட 

஧குதிக்கு இளணப்ள஧ உருயாக்குகி஫து. 

 ஋.கா: 

<A href=#AP> Andhra Pradesh</A> 

<A Name=AP><B>AndhraPradesh</B></A> 

 

   2. பயளி இளணப்பு : 

 யள஬ ஆயணத்திற்கு பயளியில் உள்஭ யள஬ப்஧க்கங்களுடன் இளணப்புகள஭ 

஌ற்஧டுத்துயது பயளி இளணப்பு ஋஦ப்஧டும். 

 <A> எட்டினுள் உள்஭ HREF ஧ண்புக்கூறில் இளணப்பு ஌ற்஧டுத்த வயண்டின 

யள஬ப்஧க்கத்தின் URL முகயரிளனக் பகாடுத்து இளணப்ள஧ உருயாக்க஬ாம். 

 ஋.கா 1: 

<A href="http://www.tnschools.gov.in">school</A> 

 ஋.கா 2: 

  <A href=writer.htm>Open Office Writer</A> 

5. கீழ்காணும் அட்டயளணளன உருயாக்க HTML நிபல் ஋ழுதுக: 

 
     <html> 

<body> 

<table> 

<tr> 
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<td rowspan= 3 > A </td> 

<td> colspan= 4 > B </td> 

</tr> 

<tr> 

<td> C </td> 

<td> D </td> 

<td> E  </td> 

<td rowspan= 2 > G  </td> 

</tr> 

<tr> 

<td colspan=3 > F  </td> 

</tr> 

</table> 

</body> 

     </html> 

஧ாடம் - 12  HTML – ஧ல்லூடகக் கூறுகள் நற்றும் ஧டியங்கள் இளணத்தல் 

஧குதி -ஆ : குறுவி஦ா 

1. யமக்கிலுள்஭ நிமற்஧ட யடியங்கள஭ப் ஧ட்டினலிடு. 

 GIF (Graphical Interchange Format) 

 JPEG (Joint Photographic Experts Group) 

 PNG (Portable Network Graphics)  

 SVG (Scalable Vector Graphics) 

2. <marquee> எட்டியின் ப஧ாது யடியத்ளத ஋ழுது 

<marquee> Text or image to be scroll   </marquee> 

3. உள் எலி / எளிக்காட்சி ஋ன்஫ால் ஋ன்஦ ? 

 உள் எலி / எளிக்காட்சி ஋ன்஧து எலி / எளிக்காட்சிக் வகாப்புகள஭ இளணனப் ஧க்கத்தின் 

எரு ஧குதினாக யமங்குயளதக் குறிக்கி஫து. 

 உ஬வித்திளபயில் யள஬ப்஧க்கம் வதான்றும் வ஧ாது, இவ்யளக எலி / எளிக் காட்சி வகாப்புகள் 

இனங்கும். 

4. <input> எட்டின் ஧னன் னாது? 

 <input> ஏட்ளடப் ஧னன்஧டுத்தி ப஧ரும்஧ா஬ா஦ ஧டிய உறுப்புகள஭ உருயாக்க஬ாம்.  

 பயறுளந எட்டா஦ <input> ஧னன்஧டுத்தி உளபப்ப஧ட்டி, வபடிவனா ப஧ாத்தான்கள் வ஧ான்஫ 

஧ல்வயறு ஧டிய உறுப்புகள஭ உருயாக்க஬ாம். 

 <input> எட்டின் type ஧ண்புக்கூறு அதன் யடியளநப்஧ளநத் தீர்நானிக்கி஫து. 

5. கீழ்யரிப்஧ப்஧ட்டினல் ப஧ட்டியில் உறுப்புகளின் ஧ட்டினள஬க் குறிப்பிட ஋ந்த எட்டுப்  ஧னன்஧டுகி஫து? 

 <select> எட்ளடப் ஧னன்஧டுத்தி கீழ்விரிப்஧ட்டினல் ப஧ட்டிளன உருயாக்க஬ாம்.  

 <option> எட்ளடப் ஧னன்஧டுத்தி கீழ்விரிப்஧ட்டினல் ப஧ட்டியில் உறுப்புகளின் ஧ட்டினள஬க் 

குறிப்பிட஬ாம். 

 ஋.கா:  <select>  

<option value = 1> Chennai </option> 

<option value = 2> Madurai</option> 

<option value = 3> Trichy </option> 

 </select> 

6. <textarea> எட்டிற்கு ப஧ரும்஧ான்ளநனாகத் வதளயப்஧ந்தனயப்஧டும் ஧ண்புக் கூறுகள் னாளய ? 

1. Name - உறுப்புக்குப் ப஧னளப யளபனறுக்கப் ஧னன்஧டுகி஫து. 

2. Rows - உறுப்பில் யரிளெகளின் ஋ண்ணிக்ளகளனக் குறிப்பிடுகி஫து. 

3. Cols - textarea உறுப்பில் ப஥டுயரிளெகளின் ஋ண்ணிக்ளகளனக் குறிப்பிடுகி஫து. 

஋.கா : 

 <Textarea rows = 5 columns=20 name=Address> </Textarea> 
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஧குதி - இ : ப஧ருவி஦ா 

1. அதிக அ஭வில் ஧னன்஧டுத்தும் நிமற்஧ட யடியங்கள஭ப் ஧ற்றி சிறு குறிப்பு யளபக. 

   GIF (Graphical Interchange Format): 

 அளெவுப்஧டங்கள் உருயளநக்கும். ப஧ருந஭வில் ஧னன்஧ாட்டில் உள்஭து. 

 256 யண்ணங்கள஭ நட்டும் ஧னன்஧டுத்துயதால், புளகப்஧டங்கள஭க் ளகனாள்யதற்கு 

஌ற்஫தல்஬. 

 GIF முள஫ எலி நற்றும் திரும்஧ ஏடச் பெய்தள஬ ஆதரிக்காது. 

   JPEG (Joint Photographic Experts Group) : 

 JPEG ஋ல்஬ா உ஬விகளிலும் பெனல்஧டக்கூடின, மிகவும் புகழ்ப஧ற்஫ ஧டியநாகும்.  

 GIF முள஫ளன வ஧ான்஫ல்஬ாது.  

 JPEG முள஫யில் ஋ண்ணற்஫ யண்ணங்கள஭ப் ஧னன்஧டுத்த஬ாம். 

   PNG (Portable Network Graphics): 

 GIF முள஫க்கு நாற்஫ாக PNG முள஫ யடியளநக்கப்஧ட்டது.  

 ஋ல்஬ா உ஬விகளிலும் பெனல்஧டக் கூடினளய. 

   SVG (Scalable Vector Graphics): 

 இளணனத்திற்காக யடியளநக்கப்஧ட்ட யளபகள஬ யடியம் SVG.  

 W3C ஋ன்஫ அளநப்பி஦ால் அங்கீகரிக்கப்஧ட்டது.  

 ஥டப்பு இளணன உ஬விகள் அள஦த்திலும் SVG முள஫ பெனல்஧டுகி஫து. 

2. எரு HTML ஆயணத்தில், எரு உளபப் ஧குதிளன ஋வ்யாறு ஥கர்த்த஬ாம்? 

 எரு HTML ஆயணத்தில், உளப அல்஬து நிமற்஧டத்ளதக் கிளடநட்டநாகவயா, 

பெங்குத்தாகவயா <marquee எட்டிள஦ப் ஧னன்஧டுத்தி உரு஭ச் பெய்ன஬ாம்.  

 ப஧ாது யடியம் : 

  <marquee> Text or image to be scroll </marquee> 

 ஋.கா : 

  <marquee direction = right> Tamil Nadu </marquee> 

3. <form> எட்டுடன் ஧னன்஧டுத்தப்஧டும் முக்கின ஧ண்புக் கூறுகள஭ வியரி. 

    Method: 

 method ஧ண்புக்கூறு. ஧டிய உறுப்புகளின் ப஧னர்களும், நதிப்புகளும் வெளயனகத்திற்கு 

஋வ்யாறு அனுப்஧ப்஧டும் ஋ன்கி஫ யழிமுள஫ளனக் குறிப்பிடுகின்஫து.  

 get யழிமுள஫, ஧டிய உறுப்புகளின் ப஧னர்கள஭யும், நதிப்புகள஭யும் URL ன் பின் 

இளணக்கின்஫து. 

 post யழிமுள஫ ப஧னர்கள஭யும். நதிப்புகள஭யும் தகயல் ப஧ாட்ட஬ங்க஭ாக அனுப்பி 

ளயக்கின்஫து. 

   Action : 

 action ஧ண்புக்கூறு. ஧டிய வியபங்கள஭ச் பென஬ாக்கும். வெளயனகத்திலுள்஭ நிபல் அல்஬து 

உளபநிள஬ கண்டறிகி஫து. 

 ப஧ாது நுளமவி இளடமுக (Common Gateway Interface) நிபலின் ப஧னளப உணர்த்துகி஫து. 

    ஋.கா : 

<Form action= "s.html" method=post> 

4. <input> எட்டின் type ஧ண்புக்கூறின் ஧ல்வயறு நதிப்புகள஭ வி஭க்குக. 

   Text 

 உளபப்ப஧ட்டிளன உருயாக்குகி஫து. 

 இந்த யளக உறுப்பு, ப஧னர், முகயரி உளப உள்ளீடுகள஭த் திபட்ட உதவுகி஫து. 

   Password 

 இதுவும் உளபப்ப஧ட்டிளனப் வ஧ான்஫து.  

 ஆ஦ால் உளபளன உள்ளீடு பெய்யும் வ஧ாது எவ்பயாரு ஋ழுத்தும் ஥ட்ெத்திப குறியீடாகத் 

வதான்றும். 

   Check box  

 Check box ஋ன்஧து சிறு பெவ்யகப் ப஧ட்டினாகத் வதான்றும்.  

 ஧ன஦ர் அப்ப஧ட்டியில் பொடுக்கும் வ஧ாது சிறின ெரிகுறி அதனுள் வதான்றும்.  

 இந்த உறுப்ள஧க் பகாண்டு ஧஬த் வதர்வுகள஭த் வதர்ந்பதடுக்க஬ாம். 
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   Radio Button 

 ஧ட்டினலிலுள்஭ ஧஬ வதர்வுகளில் என்ள஫ நட்டும் வதர்ந்பதடுக்க வபடிவனா ப஧ாத்தான் 

உதவுகி஫து.  

 இது சிறின யட்ட யடிவில் இருக்கும். வதர்ந்பதடுக்கும் ப஧ாழுது யட்டத்தின் ளநனத்தில் எரு 

கரும்புள்ளி வதான்றும். 

   Reset 

 எரு ஧டியத்தில் உள்ளிட்ட ஧திவுகள஭ அழிக்கப் ஧னன்஧டும் எரு சி஫ப்பு ப஧ாத்தா஦ாகும். 

   Submit 

 எரு ஧டியத்தில் உள்ளிட்ட ஧திவுகள஭ வெளயனகத்தில் ெநர்ப்பிக்க ஧னன்஧டுகி஫து 

   Button 

 இவ்யளக யளபகள஬ ப஧ாத்தான் மீது கிளிக் பெய்யும் ப஧ாழுது அதனுடன் பதாடர்புளடன 

கட்டள஭ளன பெனல்஧டுத்துகி஫து. 

5. <select> நற்றும் <option> எட்டுகளின் ஧ண்புக் கூறுகள஭ வியரி. 

 Name  - வெளயனகத்துக்கு அனுப்஧ப்஧டும் உறுப்புக்குப் ப஧னளப அளிக்கி஫து. 

 Size -  கீழ்விரிப் ஧ட்டினல் ப஧ட்டியின் ஧ாணிளனத் தீர்நானிக்கி஫து.   

Size= 1  கீர்விரிப் ஧ட்டினல் ப஧ட்டி  

Size=2   ஧ட்டினல் ப஧ட்டி 

 Multiple - ஧ன஦ர் ஧஬ நதிப்புகள஭த் வதர்ந்பதடுக்க அனுநதிக்கும். 

 <option> ஏட்டின் ஧ண்புக்கூறுகள்: 

 Selected முன்னினல்஧ா஦ வதர்ந்பதடுத்தள஬ச் சுட்டிக் காட்டுகி஫து. 

 Value - வெளயனகத்துக்கு ெநர்ப்பிக்கப்஧ட வயண்டின நதிப்பு. 

 ஋.கா: 

<select name = area size =1> 

<option value = CHN>Chennai</option>  

<option value = MDU selected>Madurai</option> 

<optionvalue = TRY> Trichy </option> 

</select> 

஧ாடம்-13  CSS – பதாடரும் ஧ணி தாள்கள் 

஧குதி-ஆ : குறுவி஦ா  

1. <style> எட்டின் ஧னன் னாது? 

 யள஬ ஆயணத்தில் எரு குறிப்பிட்ட எட்டு ஋ங்பகல்஬ாம் இடம் ப஧ற்றுள்஭வதா 

அங்பகல்஬ாம் எட்டின் முன்னினல்஧ா஦ ஧ண்பினல்புகள஭ நாற்றி அளநக்கப் <style> ஧ாணி 

எட்டு ஧னன்஧டுகி஫து. 

2. CSS ஋ன்஫ால் ஋ன்஦ ? 

 பதாடரும் ஧ாணி தாள்கள் த஭஧பப்பு அல்஬து பயளிநிள஬ ஧ாணி தா஭ாகும்.  

 பதாடரும் ஧ாணி தாள்கள் ஋ன்஧து ஧ாணிதாள் பநாழினாகும்.  

 இது HTML -இல் ஏர் ஆயணத்தின் யடியளநப்ள஧ வியரிக்கி஫து. 

3. CSS-ளன HTML உடன் இளணக்கும் ப஧ாது யடியத்ளத ஋ழுதுக. 

 <link rel = "stylesheet" type="text/css" href=CSS-File-Name-with-Extension> 

4. உள்஭ளந ஧ாங்கு ஋ன்஫ால் ஋ன்஦ ? 

 எரு குறிப்பிட்ட எட்டின் ஧ாணிளன எரு HTML ஆயணத்தின் ஋ந்த எரு இடத்திலும் 

யளபனறுக்க முடியும். இதற்கு உள்஭ளந ஧ாணி ஋ன்று ப஧னர். 

5. CSS அறிவிப்பின் ப஧ாது யடியத்ளத ஋ழுதுக. 

 Html எட்டு { ஧ண்புகள் : நதிப்புகள்; } 

஧குதி-இ : ப஧ருவி஦ா  

1. CSS ஧னன்஧டுத்துயதன் ஥ன்ளநகள் னாளய ? 

 ஧பாநரிப்புத் தி஫ன் 

 நறு஧னன் தி஫ன் 

 புரிந்து பகாள்ளும் தி஫ன் 

2. CSS விதிமுள஫கள஭ சுருக்கநாக ஋ழுதுக. 

 CSS ஧ாணி யளபனறுப்பின் இபண்டு முதன்ளநப் ஧குதிகள்:  
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 வதர்வி நற்றும் அறிவித்தல் 

o வதர்வி (Selector) - ஧ாணிகள஭ இடுயதற்கா஦ HTML எட்டு 

o அறிவித்தல் (Declaration) - ஧ாணி யளபனறுப்ள஧க் பகாண்ட குறிமுள஫த் பதாகுதி 

 இது ப஥ளிவு அளடப்புக்குறிக்குள் { } பகாடுக்கப்஧டுகி஫து. 

 எரு வதர்விக்கு ஋த்தள஦ ஧ண்புகள஭ வயண்டுநா஦ாலும் வெர்க்க஬ாம். அளய 

அளபப்புள்ளினால் பிரிக்கப்஧டுகி஫து. 

 ஧ண்பின் ப஧னரும் அதன் நதிப்பும் முக்காற் புள்ளினால் (:) பிரிக்கப்஧டுகி஫து.  

 எவ்பயாரு யளபனறுப்பும் அளபப்புள்ளினால் (;) முடிக்கப்஧ட வயண்டும். 

3. <p> எட்டின் உளப நி஫ம் நற்றும் இளெவு யளப னறுப்பிற்கா஦ CSS வகாப்பிள஦ ஋ழுதுக. 

p 

{ 

   color: red; 

   text-align: center; 

} 

4. <h1> எட்டிற்கா஦ ஋ழுத்து யளக, ஧ாணி நற்றும் அ஭வு யளபனறுப்஧தற்கா஦ CSS வகாப்பிள஦  

    ஋ழுதுக. 

h1 

{ 

   Font-family: "Arial"; 

   Font-style: Italic; 

   Font-size: 24px ; 

} 

஧குதி-ஈ : ப஥டுவி஦ா  

1. கீழ்க்கண்ட ஧த்திளன பகாடுக்கப்஧ட்ட CSS வி஭க்கத்துடன் திளபயிட HTMLஆயணத்ளத ஋ழுதுக: 

• Font Name : Cooper Black 

• Style : Bold Italics 

• Color : Blue 

“The State Institute of Education (SIE) was established in 1965 to provide for systematic study of problems 

relating to School Education under the administration of Directorate of School Education.” 

விளட: 

<html> 

<head> <title> css document </title> 

<style> 

p 

{ 

font-family: "Cooper Black"; 

font-style: Italics; 

font-weight: Bold; 

color: Blue: 

} 

</style> 

</head> 

<body> 

<p> 

The State Institute of Education (SIE) was established in 1965 to provide for systematic study of 

problems relating to School Education under the administration of Directorate of School Education 

</p> 

</body> 

</html> 
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2. CSS-ல் உள்஭ ஋ழுத்து நற்றும் உளப உறுப்பு ஧ண்புகள஭ அதன் நதிப்புகவ஭ாடு ஧ட்டினலிட்டு 

வி஭க்கவும். 

 

 
 

஧ாடம் - 14  ஜாயாஸ்கிரிப்ட்டின் அறிமுகம் 

஧குதி -ஆ : குறுவி஦ா  

1. நாறிகளின் யளபபனல்ள஬ ஋ன்஫ால் ஋ன்஦ அதன் யளககள் னாது? 

 எரு நாறியின் யளபபனல்ள஬, அது ஋ந்த மூ஬க் குறிமுள஫யில் யளபனறுக்கப்஧ட்டுள்஭வதா 

அந்த குறிமுள஫யின் யாழ்஥ாள் யளப இருக்கும். 

 யளககள்  

o முழுத஭ாவின நாறி  

o உள்஭ளந நாறி 

2. ஜாயாஸ்கிரிப்ட்டில் இ஦நாற்஫ம் ஋ன்஫ால் ஋ன்஦ ? 

 எரு தபவி஦ யளகயிலிருந்து வயப஫ாரு தபவி஦ யளகனாக நாற்றினளநக்கும் பெனல்஧ாட்ளட 

இ஦நாற்஫ம் ஋ன்஧ர்.  

 யளககள்  

o உள்ளுள஫ இ஦நாற்஫ம் 

o பயளிப்஧ளட இ஦நாற்஫ம் 

3. ஜாயாஸ்கிரிப்ட்-ல் ஋த்தள஦ நிள஬யுறுக்கள் உள்஭஦ அயற்றின் யளககள஭ ஋ழுதுக. 

 ஜாயாஸ்கிரிப்டில் ஍ந்து யளகனா஦ நிள஬யுறுக்கள் உள்஭஦. அளய, 

o முழு ஋ண்  

o மிதப்பு புள்ளி 

o குறியுறு 

o ெபம் 

o பூலினன் 

4. நி஧ந்தள஦ச் பெனற்குறி ஋ன்஫ால் ஋ன்஦ ? தகுந்த ஋டுத்துக்காட்டு தருக. 

 நி஧ந்தள஦ பெனற்குறி மூன்று பெனவ஬ற்பிகள஭ ஌ற்கும். இது மும்ந பெனற்குறி ஋஦ப்஧டும். 

 பதாடரினல்:  var variable name = (condition) ? value1:value2;  

 ஋.கா:            var result = (10>15)?100:150; 
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5. ஜாயாஸ்கிரிப்ட்-ல் குறிப்புளபகள் ஋ன்஫ால் ஋ன்஦ ? 

 நிபள஬ உருயாக்கு஧யர்களுக்கும் நற்஫யர்களுக்கும் நிபள஬ புரிந்துபகாள்஭ உதவும். 

 நிபல் ப஧னர்ப்பி நிபலில் உள்஭ குறிப்புளபகள் நிபாகரித்துவிடும் 

 இபண்டு யளகனா஦ குறிப்புளபகள் உள்஭஦.  

o எரு யரி குறிப்புளபகள் - // ஋ன்஫ குறியுடன் பதாடங்கும் 

o ஧஬ யரி குறிப்புளபகள் - /* ல் பதாடங்கி */ல் முடியளடயும். 

6. பெனற்குறி யளககள் ஧ற்றி குறிப்பு யளபக. 

 ஋ண்கணித பெனற்குறி  

 எப்பீட்டு பெனற்குறி 

 தருக்க பெனற்குறி 

 நதிப்பிருத்து பெனற்குறி 

 ெபம் பெனற்குறி 

 மிகுப்பு/குள஫ப்பு பெனற்குறி  

 நி஧ந்தள஦ பெனற்குறி  

 எருந + நற்றும் எருந - பெனற்குறி 

 type of பெனற்குறி 

7. ஜாயாஸ்கிரிப்ட்டில் நாறியின் ஧ங்கு ஧ற்றி ஋ழுதுக. 

 நாறிகள் ஋ன்஧ளய நதிப்பு தாங்கியுள்஭ நிள஦யக இருப்பிடத்ளதக் குறிக்கும்.  

 நாறி ஋ன்஧து நதிப்பிற்கா஦ குறியீட்டு ப஧னர். 

 var ஋ன்஫ சி஫ப்பு பொல் ஧னன்஧டுத்தி ஜாயாஸ்கிரிட்டில் நாறிகள் அறிவிக்கப்஧டும். 

 எவ்பயாரு நாறிக்கும் எரு ப஧னரிடப்஧டும். அளத குறிப்ப஧னர் ஋ன்஧ர். 

8. Prompt உளபனாடல் ப஧ட்டியின் ஧னன்கள் னாது? 

 வநல்மீட்பு உளபப்ப஧ட்டி மூ஬ம் ஧ன஦ர் உள்ளீடு பெய்யதற்கா஦ தகயள஬க் Prompt 

உளபனாடல் ப஧ட்டி ஧னன்஧டுகி஫து. 

 கட்டள஭: 

  Prompt ("message","default value"); 

஧குதி -இ : ப஧ருவி஦ா 

1. ஜாயாஸ்கிரிப்ட்டில் உள்஭ அடிப்஧ளட தபவு யளககள் ஧ற்றி சிறுகுறிப்பு ஋ழுதுக.. 

 எரு ெபம் ஋ன்஧து குறியுருக்களின் யரிளெ ஆகும்.  இபட்ளட வநற்வகாளில் தபப்஧டும். 

 முழு ஋ண் அல்஬து மிதப்புப் புள்ளி ஋ண்களின் நதிப்ள஧ ஋ண்கள் தபவி஦ம் ஌ற்கும்.  

 பநய் அல்஬து ப஧ாய் ஋ன்஫ இபண்டில் ஌வதனும் எரு நதிப்ள஧ பூலினன் ஌ற்கும். 

2. ெபம் பெனற்குறி ஧ற்றி குறிப்பு யளபக. 

 ஜாயாஸ்கிரிப்ட்-ன் எரு உள்஭ளநந்த அம்ெநா஦து ெபங்கள஭ இளணப்஧து  

 + பெனற்குறி ஋ண்கள஭ கூட்டல் நட்டுநல்஬ாது ெபங்கள஭ இளணக்கவும் உதவும்.  

 பெனவ஬ற்பிகள் ெபங்கள் ஋னில் + பெனற்குறி ெபங்கள஭ இளணக்கும் பெனள஬ பெய்யும். 

3. <Script> எட்டு ஧ற்றி ஋ழுதுக. 

 <script> </script> எட்டுகள஭ப் ஧னன்஧டுத்தி ஜாயாஸ்கிரிப்ட்-ளட ஥ளடமுள஫ப் ஧டுத்த஬ாம். 

 <script> எட்ளட இளணனப் ஧க்கத்தில் ஋ங்கு வயண்டுநா஦ாலும் ப஧ாருத்த஬ாம். 

 <head> எட்டுகளில் உள்வ஭ பகாடுப்஧ளதவன ப஧ரும்஧ாலும் ஧ரிந்துளபக்கப்஧டுகி஫து. 

4. தருக்க பெனற்குறிகளின் ஧னன்கள் னாது? 

 தருக்க பெனற்குறிகள் தருக்க (பூலினன்) பெனல்஧ாடுகள஭ச் பெய்யும், தருக்க பெனற்குறிகள் 

தருக்க (பூலினன்) நதிப்புகள஭ இளணக்கும் அல்஬து தள஬கீமாக நாற்றும்.  

 தருக்க பெனற்குறிக஭ா஦ && (AND), | | (OR) நற்றும் ! (NOT) ஋ன்஫ தருக்க பெனற்குறிகள் 

எப்பீடு பெய்தபின் ஧஬ சிக்க஬ா஦ கட்டள஭கள஭ உருயாக்க஬ாம். 

5. மிகுப்பு நற்றும் குள஫ப்பு பெனற்குறிகளின் வித்தினாெத்ளத ஋ழுதுக. 

    மிகுப்பு ++ பெனற்குறி 

 எரு பெனவ஬ற்பியின் நதிப்ள஧ 1 மிகுக்கும். இந்த பெனற்குறி, பெனவ஬ற்பியின் நதிப்ள஧ 1 

மிகுத்து, அந்த நதிப்ள஧ பெனவ஬ற்பியில் நதிப்பிருத்தும். 

   குள஫ப்பு -- பெனற்குறி 

 எரு பெனவ஬ற்பியின் நதிப்ள஧க் 1 குள஫க்கும். இந்த பெனற்குறி, பெனவ஬ற்பியின் நதிப்ள஧ 1 

ஆக குள஫த்து,  அந்த நதிப்ள஧ பெனவ஬ற்பியில் நதிப்பிருத்தும். 
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஧குதி -ஈ : விரியா஦ விளட தருக  

1. ஜாயாஸ்கிரிப்ட்டில் உள்஭ வநல்மீட்பு உளபனாடல் ப஧ட்டிகள் ஧ற்றி விரியாக ஋ழுதுக. 

 ஜாயாஸ்கிரிப்டில் மூன்று முக்கின யளகயி஬ா஦ உளபனாடல் ப஧ட்டிகள஭ப் ஧னன்஧டுத்த 

ஆதரிக்கும். 

 உளபனாடல் ப஧ட்டிகள஭ வநல்மீட்பு ப஧ட்டிகள் ஋ன்றும் அளமக்க஬ாம். 

 ஜாயாஸ்கிரிப்டில் மூன்று யளகனா஦ வநல்மீட்பு ப஧ட்டிகள் உள்஭து. அளய, 

i. Alert உளபனாடல் ப஧ட்டி 

ii. Confirm உளபனாடல் ப஧ட்டி 

iii. Prompt உளபனாடல் ப஧ட்டி 

     i. Alert உளபனாடல் ப஧ட்டி 

 ஧ன஦ருக்கு ஋ச்ெரிக்ளக பெய்தி பகாடுப்஧தற்கு alert உளபனாடல் ப஧ட்டி ஧னன்஧டும்.  

 கட்டள஭ அளநப்பு: 

  alert ("Message"); (அல்஬து)  Window, alert ("message"); 

 ஋டுத்துக்காட்டு: 

  alert (Name is compulsory entry"); (அல்஬து)  Window alert ("name is compulsory entry"); 

    ii.Confirm உளபனாடல் ப஧ட்டி: 

 ஌வதனும் எரு விருப்஧த்திற்கு ஧ன஦ரின் எப்புதல் ப஧஫ confirm உளபனாடல் ப஧ட்டி 

உதவுகி஫து.  

 கட்டள஭ அளநப்பு: 

  confirm ("Message"); (அல்஬து)  Window. confirm ("message"); 

 ஋டுத்துக்காட்டு: 

  confirm ("Do you want to continue?"); (அல்஬து) Window.confirm ("Do you want to continue?"); 

    iii. Prompt உளபனாடல் ப஧ட்டி: 

 வநல்மீட்பு உளபனாடல் மூ஬ம் ஧ன஦ார் உள்ளீடு பெய்யதற்கா஦ தகயள஬க் பகாடுக்க 

Prompt உளபனாடல் ப஧ட்டி ஧னன்஧டுகி஫து. 

 கட்டள஭ அளநப்பு: 

  prompt ( "Message", default value"); (அல்஬து) Window. prompt (some text", "default tex:"); 

 ஋டுத்துக்காட்டு: 

  prompt ("enter your name:", "name"); (அல்஬து) Window.prompt ("enter your Name:", "name"); 

2. கணித பெனற்குறி ஧ற்றி தகுந்த ஋டுத்துக்காட்டுடன் விரியாக ஋ழுதுக. 

 
  ஋டுத்துக்காட்டு: 

<html> 

<body> 

<script language="javascript" type="text/javascript"> 

var v1 = 10, v2=3; 

document.write("sum: "+ (v1+v2)); 

document.write("difference:"+ (v1-v2)); 

document.write("product: "+ (v1 * v2)); 

document.write("division: "+ (v1/v2)); 

document.write("remainder: "+ (v1%v2)); 

</script> 

</body> 

 </html> 
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஧ாடம் - 15 ஜாயாஸ்கிரிப்ட்-ல் உள்஭ கட்டுப்஧ாட்டு கட்டளநப்பு 

஧குதி -ஆ : குறுவி஦ா  

1. ஜாயாஸ்கிரிப்ட்டில் உள்஭ ஧஬ யளகனா஦ கட்டுப்஧ாட்டு கூற்றுகள் னாது? 

 கட்டுப்஧ாட்டு கூற்றுகள் இருயளகப்஧டும். 

o கிள஭ப்பிரிவு  

o நடக்கு 

2. ஜாயாஸ்கிரிப்ட்டில் நி஧ந்தள஦ கூற்று ஋ன்஫ால் ஋ன்஦ ? 

 பகாடுக்கப்஧ட்டுள்஭ நி஧ந்தள஦ வகாளயயின் நதிப்ள஧ப் ப஧ாறுத்து என்வ஫ா அல்஬து 

என்றிற்கு வநற்஧ட்ட கூற்றுகள஭ இனக்கவயா அல்஬து தவிர்க்கவயா  ஧னன்஧டும் கூற்றுகள். 

3. ஜாயாஸ்கிரிப்ட்டில் உள்஭ ஧ல்வயறு கிள஭ப்பிரிப்பு கூற்றுகள் ஧ட்டினலிடுக. 

 if கூற்று  

 if... else கூற்று  

 else if கூற்று  

 switch கூற்று 

4. Switch கூற்றின் கட்டள஭ அளநப்ள஧ ஋ழுதுக. 

switch (expression) 

{ 

case label l: statements 1; break; 

case label 2: statements 2; break; 

... 

case label n: statements n; break; 

default: statements; 

 } 

5. break நற்றும் continue கூற்றுகளின் வயறு஧ாடுகள஭ ஋ழுதுக. 

break கூற்று continue கூற்று 

நடக்கிலிருந்து கட்டுப்஧ாட்ளட 

பயளிவனற்றும் 

இடம்ப஧றும் ஧குதிக்கு கீழ் உள்஭ நடக்கின் ஧குதிளன 

பெனல்஧டுத்தாநல் நடக்கின் அடுத்த பெனல்஧ாட்ளட இனக்கும் 

஧குதி -இ : ப஧ருவி஦ா 

1. if கூற்று ஋ன்஫ால் ஋ன்஦? அதன் யளககள஭ ஋ழுதுக. 

 ஜாயாஸ்கிரிப்ட்டில் if கூற்று ஋ன்஧து எரு அடிப்஧ளட கட்டுப்஧ாட்டு கூற்஫ாகும்.  

 இது கூற்றுகள஭ கட்டள஭யின் அடிப்஧ளடயில் இனக்க உதவும்.  

 இந்தக் கூற்று இரு யடியங்கள஭க் பகாண்டது. 

o if யடியம் 

o if... else யடியம் 

2. else-if கூற்றின் கட்டள஭ அளநப்ள஧ ஋ழுதுக. 

if (expression) 

{ 

 // Execute code block # 1 

} 

else if (expression) 

{ 

 //Execute code block; # 2 

} 

else 

{ 

 // if all else fails, execute block #3 

  } 

3. நடக்கு ஋ன்஫ால் ஋ன்஦? அதன் யளககள் னாது ? 

 நடக்குகள்  ஋ன்஧து நிபலின் எவப ஧குதிளன ஧஬ முள஫ ஧ல்வயறு நதிப்புகளின் அடிப்஧ளடயில் 

இனக்குயது. 



கணினி ஧னன்஧ாடுகள்                                                     41                                                                              முத஬ாம் ஆண்டு 

 

 யளககள்; 

o for நடக்கு 

o while ஧டக்கு 

o do... while நடக்கு 

4. while நற் றும் do.. while கூற்றுகளின் வயறு஧ாடுகள஭ ஋ழுதுக 

 while நடக்கு: 

o நிபல் ப஧னர்ப்பி முதலில் வகாளயளன இனக்கும். இதன் கூற்று பதாகுப்ள஧ 

வகாளயயின் நதிப்பு பநய்னாக இல்ள஬பனன்஫ால் நடக்கின் உடற்஧குதி இனக்கம் 

நிறுத்தப்஧டும். 

 do ... while நடக்கு:  

o do ... while நடக்கு while நடக்ளகப் வ஧ான்று இருக்கும். ஆ஦ால் நடக்கின் வகாளய, 

நடக்கின் இறுதியில் ெரி஧ார்க்கப்஧டும். 

o இத஦ால் ஧டக்கின் உடற்஧குதி எரு முள஫வனனும் ஋ப்வ஧ாதும் இனக்கப்஧டும். 

5. யனளத 20 ஋ன்று உள்ளீடு பெய்தால் கீவமயுள்஭ நிபல் ஧குதி ஋ன்஦ தகயள஬ பயளியீடும். 

if (age> = 18 ) 

{ 

 alert ("you are eligible to get Driving licence"} 

} 

else 

{ 

 alert ("you are not eligible to get driving licence"); 

} 

விளட: 

 You are eligible to get Driving license 

஧குதி -ஈ : விரியா஦ விளட தருக 

1. for நடக்ளக எரு ஋டுத்துக்காட்டுடன் வி஭க்குக. 

 for நடக்கு முன் யளபனறுக்கப்஧ட்ட ஋ண்ணிக்ளகயில் மீண்டும் இனங்கும். 

 கட்டள஭ அளநப்பு: 

for (initialization; condition; increment / decrement) 

{ 

Body of the loop; 

} 

 நடக்கின் முதல் ஧குதி நாறிக்கு பதாடக்க நதிப்பிருத்தும், அந்த நாறிளன கட்டுப்஧ாட்டு நாறி 

஋ன்஧ர்.  

 இபண்டாம் ஧குதி எரு நி஧ந்தள஦ கூற்஫ாகும். அது நடக்கு, ஋த்தள஦ முள஫ இனக்கப்஧டும் 

஋ன்று தீர்நானிக்கும்.  

 மூன்஫ாம் ஧குதி கட்டுப்஧ாட்டு நாறியின் நதிப்பு ஋வ்யாறு நாற்஫ப்஧டும் ஋ன்று தீர்நானிக்கும். 

஋டுத்துக்காட்டு: 

<html> 

<body> 

<script language="java script" type="text/javascript"> 

for (var x = 1; x <= 10; x++) 

{ 

 document.write (x + "<br>"); 

} 

</script> 

</body> 

 </html> 

2. switch case கூற்ள஫ ஋டுத்துக்கா ட்டுடன் வி஭க்குக. 

 if ... else சுட்டளநப்பிற்கு நாற்஫ாக switch கூற்ள஫ ஜாயாஸ்கிரிப்ட் அளிக்கி஫து. 

 வகாளயயில் உள்஭ ஋ல்஬ விள஭வுகள஭யும் ெரி஧ார்க்க switch கூற்று குறிப்஧ாக உதவும். 
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கட்டள஭ அளநப்பு: 

switch (expression) 

{ 

case label l: statements 1; break; 

case label 2: statements 2; break; 

... 

case label n: statements n; break; 

default: statements; 

} 

நிபல்: 

<html> 

<body> 

<script language="javascript" type="text/javascript">  

var x = 1; 

switch (x) 

{ 

case 1: document. write ("hi"); break; 

case 2: document.write("hello"); break; 

case 3: document.write("bye"); break; 

default: document.write("wrong choice"): 

} 

</script> 

</body> 

 </html> 

3. கீவமயுள்஭ நிபலின் பயளியீட்ளட ஋ழுதுக. 

<html> 

<body> 

<script language= "java script" type = "text / javascript") 

var no1= prompt ("please enter table you want:", "0" ); 

document write ("<h2> multiplication for your need </h2>") 

for (var no2= 0; no2<=10; no2++) 

{ 

document write (no1+ "x" + no2+ "=" + no1+no2+ "<br>); 

} 

</script> 

</body> 

</html> 
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4. 10 ஋ண்கள஭ பயளியீடு பெய்யதற்கா஦ ஜாயாஸ்கிரிப்ட் நிபள஬ ஋ழுதுக. 

<html> 

<body> 

<script language="Javascript" type="text/javascript">  

var n= 1;  

while (n<=10) 

{ 

document.write (n + "<br>"); 

n++; 

} 

</script> 

</body> 

</html> 

஧ாடம் - 16 ஜாயா ஋ழுத்துயடிய பெனற்கூறுகள் 

஧குதி -ஆ : குறுவி஦ா 

1. ஜாயாஸ்கிரிப்ட் பெனற்கூறு ஋ன்஫ால் ஋ன்஦ ? 

 பெனற்கூறு ஋ன்஧து ஜாயாஸ்கிரிப்ட் ஋ழுத்து யடிய பதாகுதினாகும்.  

 இது எருமுள஫ யளபனறுக்கப்஧ட்டு ஧஬முள஫ பெனல்஧டுத்தப்஧டுகி஫து. 

2. பெனற் கூறின் ஧னன்஧ாடு னாது? 

 எரு குறிப்பிட்ட பெனலுக்கா஦ குறிமுள஫ளன உள஫ப஧ாதினாக்கம் பெய்யதற்கு 

஧னன்஧டுகின்஫஦.  

 ப஧ாதுயாக இளய எரு குறிப்பிட்ட வயள஬க்கா஦ குறிமுள஫ளன எரு இடத்தில் ளயப்஧தன் 

மூ஬ம் நறு஧ன஦ாக்கமும், நிபல் பதளிவும் வநன்஧டுத்தப்஧டுகி஫து. 

3. குறிப்பு யளபக  – நூ஬க பெனற்கூறுகள். 

 முன் யளபனறுக்கப்஧ட்ட பெனற்கூறுகள் ஌ற்க஦வய ஜாயாஸ்கிரிப்ட் நூ஬கத்தில் 

யளபனறுக்கப்஧ட்டுள்஭து.  இளத நூ஬க பெனற்கூறுகள் ஋ன்றும் அளமக்க஬ாம்.  

 ஋.கா:. 

 alert(), isNan(), toUpperCase(), tolowercase(), length(), prompt(), write()  

4. குறிப்பு யளபக – ஧ன஦ர் யளபனறுக் கும் பெனற் கூறுகள். 

 ஧ன஦ர் யளபனறுக்கும் பெனற்கூறுகள் நிபள஬ சிறுகூறுக஭ாக்க நிப஬ருக்கு அனுநதி 

அளிக்கி஫து.  

 ப஧ரும்஧ா஬ா஦ கணினி நிபல்கள் நிகழ் உ஬க சிக்கல்கள஭ தீர்க்க வயண்டியிருப்஧தால் கணினி 

நிள஦யகத்தில் அதிக நிள஦யகத்ளத ஋டுத்துக்பகாள்யவதாடு பெனல்஧டுத்துயதற்கு அதிக 

வ஥பத்ளதயும் ஋டுத்துக்பகாள்கி஫து. 

5. பெனற்கூறின் கட்டள஭னளநப்பு ஋ழுதுக. 

  function பெனற்கூறுவின் ப஧னர் (அ஭புருக்கள்) 

   { 

       நாறிகள் அறிவிப்பு; 

       பெனல்஧டும் கூற்றுகள்; 

   } 

஧குதி -இ : ப஧ருவி஦ா 

1. எரு ஋ண்ணின் க஦ெதுபளதத்ளதக் கண்டறின பெனற்கூறிள஦ப் ஧னன்஧டுத்தி ஜாயாஸ்கிரிப்ட் 

யடிய நிபல் ஋ழுதுக. 

<html> 

<body> 

<script language="javascript" type="text/javascript">  

var s = cube (3); 

document. write ("cube:" + s );  

function cube (m) 

{ 

var s=m*m*m; 
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return s; 

} 

</script> 

</body> 

</html> 

2. 10 ஋ண்களின் கூட்டள஬ கண்டறின பெனற்கூறிள஦ப் ஧னன்஧டுத்தி ஜாயாஸ்கிரிப்ட் நிபல் ஋ழுதுக. 

<html> 

<body> 

<script language="java type="text/javascript"> 

var s = sum(10); 

document.writeln ("the sum of 10 numbers= " +s); 

function sum (x) 

{ 

var s = 0,i; 

for(i=1;i<=10;i++) 

{ 

 s=s+i; 

} 

return s; 

} 

</script> 

</body> 

</html> 

஧ாடம் - 17 கணிப்ப஧ாறி ஥ன்ப஦றி நற்றும் இளணனப் ஧ாதுகாப்பு 

஧குதி - ஆ : குறுவி஦ா 

1. ொர்யஸ்டிங் ஋ன்஫ால் ஋ன்஦ ? 

 ெட்ட விவபாதநாக அடுத்த ஧ன஦ரின், ஧ன஦ர் ப஧னர் நற்றும் கடவுச் பொல்ள஬ வெகரித்து 

஧ன஦ரின் கணக்குகளில் நுளமந்து ஧ன஦ளடதல் ொர்யஸ்டிங் ஋஦ப்஧டும். 

2. யார்ஸ் ஋ன்஫ால் ஋ன்஦ ? 

 ெட்ட விவபாதநாக ப஧ாது நக்களுக்கு கிளடக்கக்கூடின யணிக நிகழ்ச்சிகள் ப஧ரும்஧ாலும் 

யார்ஸ்கள். ஋ன்று அளமக்கப்஧டுகின்஫஦, 

3. வி஭ெல் (க்பாகிங்) ஧ற்றி சிறுகுறிப்பு. 

 வி஭ெல் ஋ன்஫ால் திருட்டு, ஊமல் அல்஬து ெட்டவிவபாதநாக தபளயப் ஧ார்க்க 

கணிப்ப஧ாறிகள஭ ஧னன்஧டுத்துதல் ஆகும். 

4. இபண்டு யளகனா஦ இளணனத஭ தாக்குதல் ஧ற்றி ஋ழுதுக. 

 ஥ச்சுநிபல்  

 யார்ம்ஸ் 

5. குக்கி ஋ன்஫ால் ஋ன்஦ ? 

 குக்கி ஋ன்஧து யள஬ த஭த்திலிருந்து அனுப்஧ப்஧ட்ட எரு சிறின துண்டு தபவு. 

 ஧ன஦ரின் இளணனநா஦து அளணத்து யள஬ த஭ங்களின் எரு இளணன த஭த்தில் இளணன 

த஭ அங்காடியில் வெர்க்கப்஧ட்ட ப஧ாருட்கள் வ஧ான்஫ளய ஆகும். 

஧குதி - இ : ப஧ருவி஦ா  

1. ள஧னர்யாலின் ஧ங்கு ஧ற்றி ஋ழுதுக? 

 ஃ஧னர்யால் நற்றும் ஧தி஬ாள் வெளயனகங்கள் ஋ன்஧து கணிப்ப஧ாறி யள஬னளநப்பு ஧ாதுகாப்பு 

அடிப்஧ளட அளநப்஧ாகும். 

 உள்யரும் நற்஫ம் பயளிச்பெல்லும் யள஬னளநப்பு வ஧ாக்குயபத்து வ஧ான்஫யற்ள஫ 

கண்காணித்து கட்டுப்஧டுத்தப்஧டுகி஫து. 

 ஃ஧னர்யால் ப஧ாதுயாக ஥ம்஧கநாக உள்஭ கணிப்ப஧ாறி யள஬த஭ம் நற்றும் யள஬ப்பின்஦லுக்கு 

பயளிவன எப்஧ளடக்கப்஧ட்ட கணிப்ப஧ாறிக்கும் இளடவன எரு பி஭ாக் அளநகி஫து. 

2. குறினாக்கம் நற்றும் நள஫னாக்கம் ஧ற்றி ஋ழுதுக. 

 குறினாக்கம் : ஋ளின உளபத் தபவுகள஭ சீபற்஫ தபவுக஭ாக நாற்றும் முள஫ ஆகும். 
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 நள஫குறினாக்கம் : சீபற்஫ தபவுகள஭ ஋ளின உளபக஭ாக நாற்றும் முள஫ ஆகும். 

3. கணினி ஧ன஦ர் பின்஧ற்றும் யழி காட்டுதல்கள் ஧ற்றி ஋ழுதுக? 

 வ஥ர்ளந: இளணனத்ளத ஧னன்஧டுத்தும் ஧ன஦ர் உண்ளநயுள்஭யபாக இருத்தல் 

 ஥ம்பிக்ளக: அங்கீகரிக்கப்஧டாதயர்களிடம் முக்கின தகயல்கள஭ ஧ரிநாற்஫ம் பெய்னாநலிருத்தல் 

 நரினாளத: நற்஫ ஧ன஦ருக்கு உள்஭ தனி உரிளநக்குரின நரினாளதளன பகாடுத்தல் 

 பதாழில்முள஫: எவ்பயாரு ஧ன஦ரும் பதாழில்முள஫ ஥டத்ளதயுடன் இருத்தல்  

 ெட்டத்திற்கு கீழ்஧டிதல்: இளணன ெட்டத்திற்கு கீழ்஧டிதல் 

 ப஧ாறுப்பு: ஧ன஦ர், எவ்பயாரு பெனலுக்கும் உளடளநனா஭பாக ப஧ாறுப்வ஧ற்றுக் பகாள்ளுதல் 

4. ப஥றிமுள஫ சிக்கல் ஋ன்஫ால் ஋ன்஦? ப஧னர்கள஭ ஋ழுதுக. 

 ஥ன்ப஦றி பிபச்சிள஦ ஋ன்஧து எரு பிபச்சிள஦ தனி நனிதனுக்வகா அல்஬து 

நிறுய஦த்திற்வகா ஌ற்஧டும் வ஧ாது ஋து ெரி அல்஬து தயறு இயற்றின் என்ள஫ வதர்வு பெய்யும் 

முள஫ ஆகும். 

o ளெ஧ர் குற்஫ம்  

o அங்கீகரிக்கப்஧டாத அணுகு஥ல் 

o கணிப்ப஧ாறிளன ஧னன்஧டுத்தி வநாெடி பெய்தல்  

o கணிப்ப஧ாறி மூ஬ம் தய஫ா஦ கூற்று உருயாக்குதல் 

o பநன்ப஧ாருள் உரிளநயில்஬ா ஥க஬ாக்கம்  

o வெக்கிங் 

o ஥ச்சுநிபல் மூ஬ம் ஥ாெவயள஬ 

஧குதி - ஈ : விரியா஦ விளட தருக  

1. கணிப்ப஧ாறி ஧னன்஧டுத்தும் வ஧ாது ஌ற்஧டும் ஧ல்வயறு குற்஫ங்கள் னாளய ? 

    தீம் ப஧ாருள் (Malware) 

 இளணனயழி பதாந்தபவு ஧ல்வயறு பெனல்க஭ா஦ திருடுதல், நள஫னாக்கம் அல்஬து 

முக்கினநா஦ தபவுகள஭ நீக்கம் பெய்தல், ஋ச்ெரிக்ளக அல்஬து கணிப்ப஧ாறி பெனல்஧ாடுகள஭ 

஥டத்துதல், பெனல்஧ாடுகள஭ அனுநதி இல்஬ாநல் கண்காணித்தல். 

    அபண் உளடத்தல் (Harvesting) 

 ெட்ட விவபாதநாக அடுத்த ஧ன஦ரின் ஧ன஦ர் ப஧னர் நற்றும் கடவுச் பொல்ள஬ வெகரித்து 

஧ன஦ரின் கணக்குகளில் நுளமந்து ஧ன஦ளடதல். 

    ஸ்வ஧ம் (Spam) 

 அறினப்஧டாத மூ஬த்திலிருந்து ப஧று஧யர் அறினப்஧ட்ட ஆதாபத்ளத அனுப்பி தீங்கிளமக்கும் 

஥ளடமுள஫னாகும். 

2. க஭யாடல் ஋ன்஫ால் ஋ன்஦ ? க஭யாடலின் யளககள் னாளய நற்றும் அளத ஋வ்யாறு தடுக்க஬ாம்? 

 பநன்ப஧ாருள் திருட்டு ஋ன்஧து எரு தனிப்஧ட்ட அல்஬து எரு நிறுய஦த்தின் மூ஬ம் 

உருயாக்கப்஧ட்ட பநன்ப஧ாருள஭ ஧திப்புரிளந ப஧஫ாநல், ெட்ட விவபாதநாக குறியீடுகள், 

தகயல்கள், நிபல்கள் நற்றும் பி஫ தகயல்கள஭ திருடுதல்.  

 அங்கீகாபம் இல்஬ாநல், ஥கல்களின் பிபதிகள஭ உருயாக்கி இந்த தபளய பொந்த ஥஬னுக்காக, 

அல்஬து யணிக இ஬ா஧த்திற்காக ஧னன்஧டுத்துயது ஆகும். 

 ஋ளிளநனா஦ பொற்களில் பநன்ப஧ாருள் திருட்டு ஋ன்஧து “பநன்ப஧ாருள் அங்கீகரிக்கப்஧டாத 

஥கல்” ஆகும். 
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3. இளணனத஭ தாக்குதலின் யளககள் னாளய ? 

    ஥ச்சு நிபல் 

 எரு ஥ச்சு நிபல் ஋ன்஧து கணிப் ப஧ாறி குறியீட்டின் எரு சிறின ஧குதி ஆகும்.  

 அது தன்ள஦ மீண்டும் மீண்டும் எரு கணிப்ப஧ாறியில் இருந்து நற்ப஫ாரு கணிப்ப஧ாறிக்கு 

வகாப்புடன் இளணக்கும் யளகயில் ஧பவுகி஫து.  

 ப஧ாதுயா஦ ஥ச்சு நிபல் ட்வபாஜன் ஆகும். 

    யார்ம்ஸ் 

 யார்ம்ஸ் ஋ன்஧து சுனநாக திரும்஧ திரும்஧ யந்து இளணத்துக் பகாள்ளும்.  

 யார்ம்ஸ் பதாடர்ந்து ஧ாதிப்புக்குள்஭ாகி ஧஬வீ஦ங்கள஭ கண்டுபிடித்து யார்ம்ஸின் 

நிப஬ா஬ருக்கு பதரிவிக்கி஫து. 

    ஸ்ள஧வயர் 

 கணிப்ப஧ாறியின் இளணப்புக்கள஭ தி஫க்கும் வ஧ாது தா஦ாகவய கணிப்ப஧ாறியில் 

நிறுயப்஧ட஬ாம்.  

 இளணப்புகளில் கிளிக் பெய்யும் வ஧ாதும் ஧ாதிக்கப்஧ட்ட பநன் ப஧ாருள஭ ஧திவி஫க்கம் 

பெய்யதன் மூ஬மும் ஸ்ள஧வயர் நிறுயப்஧ட஬ாம்.. 

    வபன்ெம்வயர் 

 எரு கணிப்ப஧ாறியில் இளணன தாக்குதல்கல்களில் பதாடங்குயதற்கு பி஫கு ஧ணம் வகாரி 

தீங்கு இளமக்கத் திட்டமிடுதல்.  

 இந்த தீம்ப஧ாருள் குற்஫யாளிகளுக்கிளடவன ப஧ருகின முள஫யில் பிப஧஬நளடந்து எவ்பயாரு 

யருடமும் நிறுய஦ங்களுக்கு மில்லினன் கணக்கா஦ பெ஬வுகள஭ ஌ற்஧டுத்துகி஫து. 

 

஧ாடம் - 18 கணிப்ப஧ாறியில் தமிழ் 

பின்யரும் வி஦ாக்களுக்கு விளடனளி 

1. தமிழில் வெளயகள஭ யமங்கி யரும் வதடு ப஧ாறிகள஭ ஧ட்டினலிடுக.  

 கூகுள் 

 பிங் 

2. ஆண்ட்பாய்டு ஧னன்஧ாடு விளெப்஧஬ளக ஋ன்஫ால் ஋ன்஦?  

 பெல்லி஦ம் நற்றும் ப஧ான்நடல் ஆகினளய தமிழ் விளெப்஧஬ளக பநன் ப஧ாருட்கள்  

 ஆண்ட்பாய்டு இனக்க அளநப்பின் ஸ்நார்ட் ளகப்வ஧சிகளில் ஆங்கி஬ எலியினல் முள஫யில் 

஧னன்஧டுத்தப்஧டும். 

3. தமிழ் நிப஬ாக்க பநாழி - சிறுகுறிப்பு யளபக  

 பநன்ப஧ாருட்கள஭ யடியளநக்கப் ஧னன்஧டும் நிப஬ாக்க பநாழிகள் இதுயளப ஆங்கி஬த்தில் 

நட்டுவந இருந்துயந்த நிள஬யில், தமிழிலும், நிப஬ாக்க பநாழி யடியளநக்கும் முனற்சிகள் 

஥ளடப஧ற்று யருகின்஫஦.  

 அத஦டிப்஧ளடயில், ள஧த்தான் நிப஬ாக்க பநாழிளன அடிப்஧ளடனாகக் பகாண்டு முதல் தமிழ் 

நிப஬ாக்க பநாழி "஋ழில்" யடியளநக்கப்஧ட்டுள்஭து.  

 இந்த நிப஬ாக்க பநாழிளன ஧னன்஧டுத்தி, சிறின அ஭வி஬ா஦ நிபல்கள஭ தமிழிவ஬வன ஋ழுத 

முடியும். 

4. TSCII ஋ன்஫ால் ஋ன்஦? 

 TSCII-Tamil Script Code for Information Interchange  

 எரு குறியீட்டு முள஫யில் ஥நது தமிழ் பநாழிளன ளகனா஭ உருயாக்கப்஧ட்ட முதல் குறியீட்டு 

முள஫ குறியீட்டு முள஫, IANA யில் ஧திவு பெய்னப்஧ட்டது. 

5. தமிழ் இளணனக் கல்விக்கமகம் சிறு குறிப்பு யளபக. 

 தமிளம உ஬பகங்கிலும் இளணனத்தின் யழிவன பகாண்டு வெர்க்கும் வ஥ாக்குடன், 2001ம் 

ஆண்டு பிப்பயரி நாதம் 17ம் ஥ாளில் தமிழ் இளணனப் ஧ல்கள஬க் கமகம், தமிமக அபொல் 

பதாடங்கப்஧ட்டது.  

 தற்வ஧ாது தமிழ் இளணனக் கல்விக் கமகம் ஋ன்஫ ப஧னரில் பெனல்஧ட்டு யரும் இந்நிறுய஦ம் 

இளணனத்தின் யழிளன தமிழ் பநாழி தமிமர் க஬ாச்ொபம், ஧ண்஧ாடு வ஧ான்஫ளய 

உ஬பகங்கிலும் யாழும் நக்களுக்கு யமங்குயதற்காக, நமள஬னர் கல்வி முதல் ஧ட்டப் ஧டிப்பு 

யளப ஧ல்வயறு கல்வித் திட்டங்கள஭ பெனல்஧டுத்தி யருகின்஫து. 


